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2 U S E R ’ S G U I D E

Introduction
Welcome to the Report Writer, the tool you can use to create and customize reports.
With the Report Writer, you can change the appearance of existing reports, make
global changes that affect all reports, or create your own new reports. If you have
the Modifier with Visual Basic® for Applications (VBA), you can use scripting to
further customize your reports.

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the
Report Writer to customize and create new reports in the accounting system.

• Part 1, Basics, describes how to get started with the Report Writer, and
describes the Report Writer interface.

• Part 2, Creating Reports, explains how to create the various elements that make
up a report.

• Part 3, Gathering Data, describes how data is stored in the accounting system
and how to assemble the data you need to create a report.

• Part 4, Modifying Reports, explains how to modify existing reports in the
accounting system.

• Part 5, Global Modifications, explains how to make modifications that affect
all reports in the application.

• Part 6, Printing and Mailing Reports, describes how to print reports, export
data from them, and mail them to other users.

• Part 7, Report Design, provides guidelines for creating reports and describes
common design elements of reports.

• Part 8, Storing and Accessing Reports, describes the Reports dictionary. It also
explains how to control access to reports you have modified with the Report
Writer. Packaging reports is also described.

• Part 9, Word Templates, explains how to produce report output in Microsoft
Word format.

You can also refer to the Report Writer online help for more information about using
the Report Writer.
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Symbols and conventions

To help you use the Report Writer documentation more effectively, we’ve used the
following symbols and conventions within the text to make specific types of
information stand out.

Product support

Technical support for the Report Writer can be accessed using the following
methods.

• Telephone support – Technical Support at (888) 477-7877 between 8:00 a.m. and
5:00 p.m. Central Time, Monday through Friday. International users can contact
Technical Support at (701) 281-0555.

• Internet – Report Writer Technical Support is also available online through Cus-
tomerSource or PartnerSource, and is accessible from www.microsoft.com/
Dynamics/GP.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts 
and suggestions.

Warnings indicate situations you should be aware of 
when using the Report Writer. 

Margin notes summarize 
important information.

Margin notes call attention to critical information, and 
direct you to other areas of the documentation where a 
topic is explained. 

Convention Description

Part 1, Basics Bold type indicates a part name.

Chapter 5, “Sorting” Quotation marks indicate a chapter name.

Applying drawing options Italicized type indicate a section name.

Software Development 
Kit (SDK)

Acronyms are spelled out the first time they’re used.

TAB or ALT+M Small capital letters indicate a key or a key sequence.
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Part 1: Basics
This portion of the documentation contains basic information you should know
before you begin using the Report Writer. The following information is discussed:

• Chapter 1, “Getting Started with the Report Writer,” describes the basic tasks
you can perform with the Report Writer, the terminology used to describe
reports, and how reports are stored. It also describes how to start the Report
Writer.

• Chapter 2, “The Report Writer Interface,” describes the interface for the Report
Writer.
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Chapter 1: Getting Started with the Report Writer
Before you begin working with the Report Writer, you should have a basic
understanding of the types of tasks you can perform, terminology used in the
Report Writer, and how reports are stored. Information is divided into the following
sections:

• Report Writer tasks
• Terminology
• Storing reports
• Starting the Report Writer

Report Writer tasks
You can use the Report Writer to perform three basic tasks: Modifying existing
reports, creating new reports, and making global changes for reports.

Modifying existing reports
With the Report Writer, you can change the appearance of individual reports in the
accounting system. This allows you to customize your system to meet your specific
needs. For instance, a common modification is changing the layout of an invoice to
match the invoice format you currently use.

Creating new reports
Though many predefined reports are included with the accounting system, a
specific report you need may not be available. You can use the Report Writer to
create new reports for the accounting system.

Making global report changes
The Report Writer also allows you to make changes that will be reflected in reports
throughout the accounting system. For example, most of the strings that are
displayed in reports can be modified. If you were to modify the string “ZIP Code”
and change it to be “Postal Code”, the change would be seen in every report in
which the string “ZIP Code” was used.

Terminology
To get the most benefit from the Report Writer, you need to understand some basic
terminology used to describe reports.

Original reports
An original report is one that was provided with the accounting system. Original
reports are stored in the main application dictionary.

Modified reports
A modified report is a copy of an original report that you have made changes to.
Modified reports are stored in the Reports dictionary. A modified report can be
substituted for an original report in the accounting system. When a user prints the
report, they’re actually using the modified report, rather than the original.

Custom reports
A custom report is one that was created using the Report Writer. You can start with a
blank report, or you can start by making a copy of a report that already exists in the
accounting system. Custom reports are stored in the Reports dictionary. You must
use a special procedure to print custom reports in the accounting system.
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Storing reports

All changes and additions you make using the Report Writer are stored in the
reports dictionary for the application. By storing the new and modified resources in
a separate dictionary, the integrity of the system can be maintained. For example,
the following illustration shows the dictionary for Microsoft Dynamics GP and its
associated reports dictionary.

You will learn more about the reports dictionary in Chapter 30, “Storing Reports.”

Starting the Report Writer

To begin using the Report Writer, log into the accounting system. If you’re using
Microsoft Dynamics GP in a multiuser environment, verify that no other users are
in the Report Writer and then perform the following steps:

1. Start the Report Writer.
From the main Dynamics GP window:
In the Microsoft Dynamics GP menu, choose Tools >> Customize >> Report
Writer.

From individual task windows:
In the Tools menu, choose Customize >> Report Writer.

If the Report Writer item is dimmed, you have not been granted access through system
security. Refer to Chapter 31, “Accessing Reports,” for more information about setting
access to the Report Writer.

2. Select the product to modify.
If you’re using additional products that integrate with Microsoft Dynamics GP,
the following window will appear when you start the Report Writer.

Select the product whose reports you want to access, then click OK. If Microsoft
Dynamics GP is the only product available, this window won’t appear.

Dynamics Reports.dic

New and modified 
resources are stored in 
the reports dictionary.

If you have integrating
products, use this window

to select the product
whose reports you want

to access.
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Chapter 2: The Report Writer Interface
This portion of the documentation describes the basic elements of the Report Writer
interface. It is divided into the following sections:

• The main window and toolbar
• Menus
• Windows
• Standard buttons

The main window and toolbar

When you start the Report Writer, the Report Writer’s main window and toolbar
appear. The toolbar appears across the top of the main window. Each button that
appears represents a fundamental resource that you can view or edit. The following
table describes each button.

Menus

The following items are available in the Report Writer menu bar.

File: Print Setup
This menu item opens the printer setup dialog box. This dialog box allows you to
configure the currently selected printer.

File: Generate Resource Reports
This menu item prints a resource report for the application. The resource report is a
text file that lists all resources in the current dictionary, their internal resource IDs
and any resources associated with the listed resource. When you choose Generate
Resource Reports, a dialog box will appear and allow you to name the report and
select its location.

File: Process Monitor
This menu option opens the Process Monitor window. This window displays
activity for tasks that you choose to process in the “background” within your
application.

File: <<Main Application Name>>
The name of this menu item changes based on the application being used. Choosing
the menu item allows you to exit the Report Writer and return to the main
application.

Button Description

Opens the Data Types window, where you can view or edit existing data 
types.

Opens the Fields window, where you can view a list of fields in the 
application.

Opens the Tables or Virtual Tables window, where you can view 
information about tables or virtual tables in the application.

Opens the Report Writer window, which allows you to create new or 
modified reports.
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File: Table/Field/Window Descriptions
These menu items open forms in the Resource Descriptions tool. This tool displays
information about all the tables, fields and windows used in the current dictionary.

File: Exit
This menu item allows you to exit the application.

Edit: Undo
This menu item will undo the last keyboard entry in an editable field. It will also
undo field movement and sizing in a layout window, but not the addition or
removal of fields, text or graphics from a layout window.

Edit: Cut/Copy/Paste
These menu items allow you to copy text or graphics to the Clipboard, then paste it
in a different location. You cannot cut, copy or paste fields.

Edit: Clear
This menu item allows you to remove text from an editable field, or remove selected
items from the layout area.

Edit: Select All
This menu item allows you to select the entire entry in a field, or all items in the
layout area for a report.

Macro: (all)
The items available from the Macro menu allow you to record and play macros.

Resources: (all)
The items in the Resources menu allow you to access the various resources in the
application. Resources available from this menu include all resources accessed from
the toolbar, as well as other resources (such as formats and strings).

Windows:
This menu displays a list of the windows currently open. Selecting a window from
this menu makes the window active.

Help: Lookup
This menu item opens any lookup window for the current field.

Help: Contents
This menu item displays the contents topic for the Report Writer online help.

Help: Search for Help On
This menu item displays the search window for the help system, allowing you to
search the Report Writer online help.

Help: Window Help
This menu item displays help for the current window in the Report Writer.

Help: About
This menu item displays the About window for the main application.
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Windows

The Report Writer uses several types of windows. Review the following
descriptions to learn how each is used.

Resource list windows
Resource list windows display a list of resource names for a given resource type. To
display a list window, click a button in the Report Writer toolbar or choose a
resource from the Resources menu. When the window appears, select a resource
name and click Open to display its definition window.

The following illustration shows the Formats resource list window.

Definition windows
Definition windows allow you to customize individual resources. For example, you
will use the Format Definition window to customize how data is displayed on
reports.
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Layout window
You will use the Layout window to specify the layout of reports in the application.
The Layout window uses a graphics metaphor you may already be familiar with: an
assortment of tools you can use for drawing and creating objects; a built-in grid that
allows easy alignment of objects; moveable objects in a layout like an object-
oriented drawing program; and standard cut-copy-and-paste techniques so you can
import graphics you create in other applications.

The Toolbox is available whenever the Layout window is open. It contains tools you
will use to add objects to the layout.

Standard buttons

The following buttons are used throughout the Report Writer:

Button Description

Saves changes and closes the current window. 

Closes the current window without saving the changes to 
the window. 

Creates a new resource. 

Opens the selected resource and displays its definition. 

Deletes the selected resource.

Allows you to insert items in a list, such as fields into a 
sorting definition. 

Allows you to remove items from a list, such as the fields 
in a sorting definition. 

The lookup button opens another window, allowing you 
to select a value to return to the current field. Typically, 
clicking the lookup button displays a list of resources. 
One of these resources can be selected and have its value 
returned to the current field.
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Part 2: Creating Reports
This portion of the documentation describes the various resources used to create
new reports. The following is a list of the topics discussed, along with a brief
explanation of each:

• Chapter 3, “Report Definition,” describes how to use the Report Definition
window to define a new report.

• Chapter 4, “Report Layout,” explains how to use the Report Layout window to
design the appearance of a report.

• Chapter 5, “Sorting,” explains how to sort the data in a report.

• Chapter 6, “Restrictions,” describes how to restrict what data appears in a
report.

• Chapter 7, “Calculated Fields,” explains how to create and use calculated fields
in a report.

• Chapter 8, “Additional Headers and Footers,” describes how to use additional
headers and footers to create groups for the report.

• Chapter 9, “Legends,” explains how legends are used in reports.

• Chapter 10, “Modifying Fields,” describes how to modify how fields appear in
a report.
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Chapter 3: Report Definition
Before you can work with the layout of a report, you must open an existing report
definition or create a new one. The report definition specifies important
characteristics of the report, such as its name. Many of these characteristics can be
adjusted after you begin designing the report layout. Information about the report
definition is divided into the following sections:

• Creating a new report definition
• Report options
• Printing a report definition

Creating a new report definition

Some of the items specified in the report definition include the name of the report,
whether any restrictions will be used to control the scope of the data included when
the report is generated, and which tables data presented in the report will come
from.

To create a new report definition, start the Report Writer. In the Report Writer, click
the Reports button on the toolbar to open the Report Writer window. Click the New
button to open the Report Definition window.

1. Name the report.
Enter a report name. Supply a name that accurately describes the purpose of the
report.

2. Select a report series.
Series assignments allow you to group related reports in the accounting system
using categories like Sales, Financial and Inventory. To ensure the consistent use
of series, it’s a good idea to use the series of the primary table as the report
series.

3. Select a main table for the report. 
The name of each table in the current dictionary is displayed in the list box
below the Main Table field. From this list, select the table you want to use as the
main table for the report. The main table is typically the table that contains the
majority of information used by the report. Refer to Chapter 11, “Data Storage,”
for information about how to determine which tables to use for your reports.



P A R T  2 C R E A T I N G  R E P O R T S

16 U S E R ’ S G U I D E

4. Add additional tables to the report (if necessary).
Data for the report may need to come from tables other than the main table. If
this is the case, you need to attach additional tables to the report. To do this,
click the Tables button to open the Report Table Relationships window. The
report’s main table will be the only table listed in this window. The number 01
will appear to the left of the table name, denoting its status as the report’s main
table.

Refer to Chapter 12, 
“Table Relationships,” 
for more information 
about creating table 
relationships.

Click New to add another table to the report. The Related Tables window will
open. This window contains a list of all tables that have a relationship with the
main table already defined using the Table Relationship Definition window. An
asterisk appearing next to the table name denotes a one-to-many relationship.
Select the desired table and click OK. Each table that is added to the report and
is directly linked to the main table will be listed below the main table in the
Report Table Relationships window, with a single dash to the left of the table
name.

To add a table that is linked to a table other than the main table, select the
secondary table’s name in the Report Table Relationships window and click
New. Select the name of the table to be added and click OK. This table will
appear in the Report Table Relationships window below the table that it is
linked to, and will have two dashes to the left of its name.

The following illustration of the Report Table Relationships window shows the
dashes that denote levels of linking.

You can have only one one-to-many relationship among the tables used for the
report. For example, if the Customer Master Address File table has a one-to-
many relationship with another table used in the report, all of the other
relationships must be one-to-one.

Once you have added all the necessary additional tables, click Close to close the
Report Table Relationships window.

5. Set the maximum number of records for the report.
Use the Max Records field to restrict the number of records that will be printed
on the report. The default value for this field is 0, which indicates that all
records will be printed.

If you enter the number 10 in the Max Records field, for example, only the first
10 records in the report will be printed, unless a restriction has been created to
specify another number. Any limit set using a restriction overrides the limit set
using the Max Records field.

Main table

The dashes indicate the level of
linking between the current table

and the main table. Two dashes
indicate that this table has a

relationship with the Customer
Master Summary table, which in
turn is related to the main table.
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You may want to enter a relatively small number while you’re creating the report, so
that test reports will be generated more quickly. Be sure to change the number to 0 or
another appropriate number when you are finished testing. 

What is an appropriate number depends upon the type of report and how it will
be used. For example, you could generate a report that lists all sales statistics by
salesperson. If the user will only want to view the top ten salespersons, you
could set the Max Records field to 10.

Report options
Several options are available to control characteristics of a report. Use the following
procedure to set options for the report.

1. Set the report format options.
These settings specify various characteristics of the report. The Format Options
are described in detail below.

Text Report Mark this option if you want to create a text report. Text reports
do not allow you to specify fonts or use graphical items in your report, such as
lines and pictures. However, text reports are less likely to be adversely affected
by different printer configurations.

We suggest you create graphics reports only when creating custom reports for specific
clients, where you can be sure of the type of printer the report will be printed to. If you
create graphics reports for general distribution, be sure to test the reports with a wide
variety of printers.

Skip Blank Records Mark this option to include only records for which
there is corresponding data in the main and related tables. If there isn’t a
corresponding record in each of the related tables, the entire record won’t be
included in the report.

Suppress Decimals Mark this option to round currency values to the
nearest whole currency unit. This option is primarily used for international
versions of applications where inflation makes the fractional portions of
currency amounts insignificant.

2. Set page orientation options.
You can specify the page orientation that will be used for the report.

Printer Setting Choose this option to use the page orientation as specified
for the printer currently selected.

Portrait Choose this option to have the report printed in portrait mode,
regardless of the current printer setting.

Landscape Choose this option to have the report printed in landscape mode,
regardless of the current printer setting.

3. Set text report options.
Refer to Chapter 4, 
“Report Layout,” for 
more information 
about the Report 
Layout window.

If you marked the Text Report option, you will activate the Text Report Options
portion of the Report Definition window. Marking this option also changes the
appearance of the Report Layout window, adding vertical guides at the 80 and
132 character marks. These marks allow you to count characters and more
precisely place your field if you are using a fixed text pitch. The text report
options are described in detail below.
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Best Text Fit Choose this option to have the report printed using the largest
printer font that will allow all of the information to be printed on the paper size
and paper orientation specified for the printer to which the report will be sent.

If you’re creating a report in a dictionary that will be distributed to multiple locations,
selecting Best Text Fit will help ensure that the report will print properly on the widest
variety of printers.

17 Characters/Inch Choose this option to have the report print in
compressed text format.

10 Characters/Inch Choose this option to have the report print in
uncompressed text format.

Variable Characters/Inch Choose this option to be able to specify the
characters per inch on a line-by-line basis for the report.

Six Lines/Inch Choose this option to ensure that six lines of the report will
print in each inch of report height, regardless of which other text option is
selected.

This option is most useful when Best Text Fit is selected. It will prevent the font from
becoming too small when the text is compressed. The font will shrink in width so that
the entire report can be printed on the available paper, but no more than six lines of text
will be printed per vertical inch.

4. Set printing options.
Four printing option are available:

To access the Report 
Section Options 
window, open the 
Report Layout window 
and select Report 
Section Options from 
the Tools menu.

First Page Header Choose this option if you want the page header to be
printed on the first page of the report. If you don’t want to print page headers
on any page of the report, use the Report Section Options window to inactivate
page headers. If page headers have been inactivated, the Page Header check
box will appear dimmed.

Last Page Footer Choose this option if you want the page footer to print on
the last page of the report. If you don’t want to print page footers on any page
of the report, use the Report Section Options window to inactivate page footers.
If page footers have been inactivated, the Page Footer check box will appear
dimmed.

Preprinted Form Select this option to remove the built-in margin from the
layout area when designing a text report. With this option selected, you can
place fields anywhere in the layout area. However, if you place fields outside of
the printer’s predefined margins, data outside of the margin will not print.

If Preprinted Form is not selected, a margin will appear in the report layout
area; the margin is drawn to show the default printer margins of the currently-
selected printer. The Report Writer will not allow you to place fields outside of
this margin.

If Preprinted Form is not selected and you lay out a report while you have one
printer selected, then save the report layout, select a different printer and
reopen the report layout, the margins may shift, depending on the default
margins of the new printer. If the margins shift, fields in the layout area will
shift with the left and top margins. This shift may force fields outside of the area
bounded by the right margin.
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The Preprinted Form selection isn’t available if the Best Text Fit option is
selected. The use of preprinted forms isn’t an option when Best Text Fit is
selected because the size and spacing of the font used for Best Text Fit reports
varies based on the data in the report. Therefore, you can never be certain that
text will appear in the appropriate position on a preprinted form.

Use RF for Last PF Mark this option to replace the last page footer on the
report with the report footer. The report footer will be printed in the area
designated for the page footer. If you mark this option, the page footer and
report footer must be the same size, and both sections must be active.

To access the Footer 
Options window, open 
the Report Layout 
window, select Report 
Options from the Tools 
menu, and click Add or 
Open in the Additional 
Footers section. 

Mark this option if the report will contain totals in the report footer. For
instance, an invoice report containing invoice numbers, invoice items and an
additional footer could have a Sum type field in the additional footer (which
breaks on the invoice number field) to display the sum of the invoice items. If
you wish to display an overall sum at the bottom of the report as well, you must
place it in the report footer, then mark Use RF For Last PF, as well as Suppress
Last Record’s Footer in the Footer Options window for the additional footer.

Printing a report definition

To keep track of the numerous options for a report, you may want to print the report
definition. To do this, select the report in the Modified Reports list of the Report
Writer window, and then click Print Definition. The Print Report Definition window
will appear.

Mark the options indicating what type of information you want included on the
report, and then click OK. The report will be generated.

Printing report definitions for existing reports is a good way to learn about the report.
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Chapter 4: Report Layout
Once you’ve planned and defined your report, you’re ready to design the report
layout. Use the information provided here to create a report layout using the Report
Layout window. Information about the report layout is divided into the following
sections:

• Creating a report layout
• Layout sections
• The Toolbox
• Adding fields to a report layout
• The Properties window
• Report properties
• Field properties
• Drawn object properties
• Report field characteristics
• Applying drawing options

Creating a report layout
Click the Layout button in the Report Definition window to access the Report
Layout window and its associated Toolbox. The Report Layout window and
Toolbox are shown in the following illustration.

The Report Layout window will be displayed differently depending on whether
you are creating a graphics or text report. Changes affect the tools shown in the
Toolbox and the width of layout area.

Toolbox
The type of report being created is displayed in the Toolbox, next to the arrow tool.
Also, several tools are available only when creating graphics reports, such as the
line and picture tools.

Layout area
For a text report, the layout area includes a left border, a right border, and two
intermediate vertical guides. These guides mark the positions 80 characters and 132
characters from the left margin. They can help you more precisely place fields in the
layout area and are especially useful if you’re using a preprinted form and have
specified a fixed-pitch text option. Then, regardless of the printer printed to, you are
assured of proper placement of fields.

For graphics reports, the layout area simply includes the left and right borders.

Make a selection from this
drop-down list to view

calculated fields, global
variables, legends, or table

fields in this fields list.

Drag fields from this
fields list to the layout.
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To make the various sections of the layout area easier to distinguish, you can mark
the Colorize Report Sections item in the Layout menu. This makes the various
sections of the report appear lightly shaded.

Layout sections

Before you can add fields and data to the report layout, you must decide where to
place that information in the layout area. The Report Layout window for a new
report contains four evenly-spaced blank sections, separated by border lines. Each
border has a handle in the left margin that is labeled using a one- or two-letter
abbreviation. Each section can be resized by dragging the handle up or down. Once
fields have been placed in a section, you can’t drag the lower border of a section
above the lowest field in the section.

Additional headers and 
additional footers are 
described in Chapter 8, 
“Additional Headers 
and Footers.”

Seven types of sections can appear in the Report Layout window, depending on
which options are selected in the Report Section Options window. Once the Report
Layout window has been opened, you can access the Report Section Options
window by choosing Report Section Options from the Tools menu. Each section is
described in the following table.

Section Use

Page Header
(PH)

Items in this section are placed at the top of every report page. Page number, date, and time fields are 
commonly placed in this section of a report. You can prevent the Page Header from being included on 
the first page of a report by unmarking the First Page Header option in the Report Definition window.

To exclude page headers from a report, unmark the Page Header option in the Report Section Options 
window.

Report Header
(RH)

Items in this section appear only on the first page of a report. The title of the report and introductory 
information are often included in this section. If a page header is also included on the first page, the 
report header will appear after the page header.

To exclude a report header from a report, unmark the Report Header option in the Report Section 
Options window.

Additional Headers
(H1, H2, H3...)

Additional headers and footers allow you to create groupings in your report. Each header will print 
when the data in the field it is based on changes. Therefore, the sorting order used will affect the 
order in which the headers appear on the report. For example, if the field related to header 2 is sorted 
before the field for header 1, header 2 will print before header 1.

Use the Report Section Options window to add additional headers. You can have up to 15 additional 
headers in a report. 

Body (B) The report body normally contains the bulk of the report. Depending on the number of additional 
headers and the sorting order used, there could be a body section for each additional header section. 

Additional Footers
(F1, F2, F3...)

Additional headers and footers allow you to create groupings in your report. Footers should 
correspond to headers and break on the same fields. They are often used to display summary data, 
such as a total of all records in the report’s body under the footer’s related header.

Use the Report Section Options window to add additional footers. You can have up to 15 additional 
footers in a report. 

Report Footer
(RF)

Items in this section appear only on the last page of a report. Summary information is often included 
in this section. If a page footer is also included on the last page, the report footer will appear before 
the page footer.

To exclude a report footer from a report, unmark the Report Footer option in the Report Section 
Options window.

Page Footer 
(PF)

Items in this section are placed at the bottom of every report page. This section often includes 
administrative information, such as the name of the person running the report. You can prevent this 
section from being included on the last page of a report by unmarking the Last Page Footer option in 
the Report Definition window.

To exclude page footers from a report, unmark the Page Footer option in the Report Section Options 
window.



U S E R ’ S G U I D E 23

C H A P T E R  4    R E P O R T  L A Y O U T

The Toolbox

Use the Toolbox to place the fields and other items in the report layout area. The
Toolbox window’s Layout and Arrange tabs let you toggle between two different
sets of tools. Tools in the Layout tab help you place information in the layout area,
while tools in the Arrange tab are used to arrange selected items in the layout area.

To activate the Toolbox window, simply move the pointer from the Layout window
to the Toolbox window. The following illustration shows the Toolbox for a graphical
report when the Layout tab is displayed and a field in the Layout area is selected.
Each of the Layout and Arrange tools, as well as the Pos and Size fields, are
described in the following sections.

The layout tools
To use a layout tool, click the tool’s icon, then click in the layout area.

Use the Layout tab to
display the layout tools.

The Pos field displays the
coordinates of the

selected field’s upper left
and lower right corners.

The name of the table the
selected field came from, or
the field type appears here.

The Size field displays the 
total width and height of 
the selected field.

The report type is 
displayed here.

Tool Name Description
Arrow tool Use the arrow tool to select objects in the layout area. When you 

select an object, handles will appear; dragging a handle allows you to 
resize the object. To select more than one object at once, hold down 
the SHIFT key as you select the object, or drag the arrow tool to draw a 
rectangle around the set of objects you want to select. You can also 
use the arrow tool to drag objects to a new position in the layout area.

Divider tool Use the divider tool to divide the report into columns, such as for 
printing labels. To mark a division on the report, click the divider tool, 
then click in the body of the report where you want to place the 
division. You must add the division to the right of any existing fields; 
the division won’t appear if there are fields or other objects to the 
right of where you’ve clicked. Once you’ve placed a division on the 
report, you can’t add any objects to the right of the division. You can 
reposition a division by dragging it with the arrow tool.

Text tool Use the text tool to place text in the layout area, such as a report title 
or column headings. You can enter up to 79 characters in a text field. 
You can’t use the ENTER key to make the text wrap; this can only be 
accomplished by resizing the text field.

Date tool Use the date tool to add fields that display the current date. The date 
is determined by the operating system setting.

Time tool Use the time tool to add fields that display the current time. The time 
is determined by the operating system setting.

Page number 
tool

Use the page number tool to add fields that display the current page 
number.
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The arrange tools
Clicking the Arrange tab in the Toolbox displays an additional set of tools used to
align, resize, or tile fields in the window. These tools are described in the following
table.

Picture tool The picture tool is available for use only with graphics reports. It 
allows you to add pictures from your application’s picture library to a 
report. To add a picture to the report, click the position in the layout 
area where the picture’s upper left corner should appear. The Pictures 
window will appear. Select a picture and click OK; the picture will 
appear in the layout area, where it can be moved or resized like any 
other object. Refer to Chapter 20 for more information about the 
picture library.
To add a picture to your application’s picture library, select Pictures 
from the Resources menu. Click New in the Pictures window, and 
paste the desired picture in the Picture field of the Picture Definition 
window. Name the picture and click OK to save it.

Line tool The line tool is available for use only with graphics reports. Use it to 
draw lines in the report layout.

Circle tool The circle tool is available for use only with graphics reports. Use it to 
draw circles in the report layout.

Rounded 
rectangle 
tool

The rounded rectangle tool is available for use only with graphics 
reports. Use it to draw rounded rectangles in the report layout.

Rectangle 
tool

The rectangle tool is available for use only with graphics reports. Use 
it to draw rectangles in the report layout.

Category Tool Name Description
Align Align to Top Aligns the selected objects with the top object in 

the group.

Align to Left Aligns the selected objects with the leftmost 
object in the group.

Align to Right Aligns the selected objects with the rightmost 
object in the group.

Align to Bottom Aligns the selected objects with the bottom 
object in the group.

Size Size to Shortest Shrinks the selected objects to the height of the 
shortest object in the group.

Size to Narrowest Shrinks the selected objects to the width of the 
narrowest object in the group.

Size to Widest Enlarges the selected objects to the width of the 
widest object in the group.

Size to Tallest Enlarges the selected objects to the height of the 
tallest object in the group.

Size to Default Resizes the selected text object or field. If the 
layout grid is active, resizes the object to the 
nearest horizontal and vertical grid lines. If the 
grid isn’t active, resizes the object to its default 
size based on the drawing options for the item.

Tool Name Description
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Arranging objects can’t be undone. Be sure to save your report layout before arranging
objects. If you aren’t satisfied with the result of an arrangement, you can close the window
without saving the changes.

The Pos and Size fields
These fields appear at the bottom of the Toolbox when a field is selected in the
layout area. The Pos field displays, in pixels, the coordinates of the selected field’s
upper-left and lower-right corners. The Size field displays the total width and
height, in pixels, of the selected field. These fields are automatically updated as you
resize the selected field in the layout area, allowing you to use the information
displayed to exactly size a field.

If a table field is selected, the name of the table from which the field was selected
will appear below the Size field. If the selected field is a global variable, calculated
field, or legend, the resource type (Global, Calculated Field, or Legend) will appear
below the Size field.

Adding fields to a report layout

For more information 
about legends, refer to 
Chapter 9, “Legends.”

When you open the Report Layout window, the name of the report’s main table will
appear under the layout tools in a drop-down list, and the name of each field in that
table will appear in the fields list. You can change which fields appear in the fields
list by selecting a different entry from the list. The choices in the drop-down list are
Globals, Calculated Fields, Legends, and the name of each table associated with the
report.

The arrow tool is selected by default when you open the window. Use it to select
each desired field from the fields list and drag it to the report layout area. If you
inadvertently drag the wrong field to the layout area, select the field using the
arrow key, then press DELETE or BACKSPACE. This will remove the field from the
layout area without affecting the field in the table.

Refer to Part 3, Gathering Data, for information about finding the data you want to
include in your report.

If you add an array field to the layout, the Report Field Options window will
appear, allowing you to specify the element of the field being placed on the report.
In the Array Index field, enter the number of the array element, and then click OK.
If necessary, you can use the Report Field Options window to change the array
index to a different element of the array.

Fields placed in the layout area will automatically appear sized according to the
maximum keyable length of the field. You can resize each field as you wish;
however, if you shorten a field, the information in that field may not be displayed in
its entirety when the report is printed. If you resize a field by vertically enlarging it,
the field’s text will be centered. If you reduce a field’s height, it will not display
properly.

Tile Tile Horizontally Tiles the selected objects horizontally. The value 
in the Space field specifies the space between 
objects.

Tile Vertically Tiles the selected objects vertically. The value in 
the Space field specifies the space between 
objects.

Category Tool Name Description
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You can click and drag with the Arrow tool to select multiple fields in the layout. By
default, the selection rectangle will be limited to the current group. Hold down the
CTRL key to allow the selection rectangle to expand beyond the current group.

In general, fields placed in the body of the report should be placed at the very top of
the body section, since any white space between the top of the body and the field
below it will be repeated for every record that’s printed. Similarly, once you’ve
finished placing fields in the report body, you should resize the body section so that
excess space is removed from the bottom of the section.

The Properties window

The Properties window is used to display and set several characteristics of a report
and the objects in the report. To display the properties for the report, select
Properties from the Layout menu. If it isn’t already open, the Properties window
will appear.

Select an object in the layout area and click the tab indicating which type of
property you want to view. Select Object or Visual. To set a property, select it in the
list and then change its value in the settings box.

Setting the property value involves choosing a value from a drop-down list, typing
a value, or using a lookup. Some properties listed can’t have their values changed.

Double-clicking a property in the properties list is a shortcut to setting its value. For
instance, double-clicking a property whose value is set with a drop-down list will set the
property to the next value in the list. 

Click a tab to display the
corresponding list of

properties.
To set the value of a

property, select it in the
list. Then set its value in

the settings box.

Settings box

Property type Description
Some properties are set using a drop-down list.

Some properties have the value entered directly.

Some properties use a lookup to retrieve values.

Some properties can’t be set.



U S E R ’ S G U I D E 27

C H A P T E R  4    R E P O R T  L A Y O U T

Report properties
To view report properties, be sure the Properties window is open. Select the arrow
tool from the Toolbox and click anywhere in the background of the layout area to
select the report. The following table lists the report properties.

Field properties

The following table lists the field properties.

Object property Description
DisplayName The name displayed for the report at runtime.
MainTable The primary table from which data will be read for the report. 
MainTableKey The key from the main table that will be used to determine the default 

sorting order for the report. An alternative sorting order can be defined 
using the Sorting Definition window.

MainTableName The display name for the main table selected for the report.
MaxRecords Specifies the number of records that will be printed on the report. For 

example, the value 10 indicates only the first 10 records will be printed. 
The default value is 0, which indicates that all records will be printed.

Name The name of the report.
Orientation Specifies the page orientation that will be used for the report. Printer 

Setting will use the orientation for the printer currently selected. Portrait 
will always use portrait orientation. Landscape will always use landscape 
orientation.

ReportID Lists the resource ID of the report.
Series Indicates the series the report is assigned to.
Type Indicates what type the report is. It can be one of the following: Graphics, 

Text, or Text (Variable CPI).

Object property Description
ArrayIndex Specifies which element of an array field or legend to display on the 

report.
DisplayType Specifies how the data in a field will be displayed on a report. Most fields 

on a report use the Data display type. Refer to Changing display types on 
page 64 for more information.

Field Indicates the table field or calculated field being used on the report, and 
allows you to view or edit the characteristics of the field definition.

FieldID Indicates the resource ID of the field.
FieldType Indicates whether the field is a table field, calculated field, global field, or 

a legend.
Format Displays the name of the format applied to the field.
FormatField Displays the name of the field that contains the integer value specifying 

the format to use. Refer to Specifying a format field on page 62 for more 
information.

FormatFieldSrc Indicates whether the format field is a table field or a calculated field. For 
table fields, the name of the table containing the field is displayed.

Section Indicates which section of the report the selected field is located in.
Table For table fields, displays the technical name of the table the selected field 

is part of.
TableName For table fields, displays the display name of the table the selected field is 

part of.
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Drawn object properties

The following table lists the drawn object properties.

Visual property Description
Alignment Specifies whether the item is left-, center-, or right-aligned.
BackColor Specifies the background color of the field.
Font Specifies the font to use for the field.
FontBold If set to true, the field text will be displayed in bold type.
FontColor Specifies the color of the text for the field.
FontItalic If set to true, the field text will be displayed in italic type.
FontSize Specifies the size of the text, in points, for the text displayed in the field.
FontUnderline If set to true, the field text will be underlined.
Pattern Specifies the pattern to apply to the background.
PatternColor Specifies the color of the pattern that is applied to the background.
Position-Left Indicates the position of the left edge of the field, measured in points from 

the left edge of the report.
Position-Top Indicates the position of the top edge of the field, measured in points from 

the top edge of the report.
Size-Height Indicates the field height, measured in points.
Size-Width Indicates the field width, measured in points.
Visibility Indicates conditions when the field will be printed on the report. It can be 

one of the following: Visible, Invisible, or Hide When Empty.

Object property Description
Section Indicates which section of the report the selected drawn object is located 

in.

Visual property Description
Alignment For static text, indicates whether the text is left, center, or right-aligned.
BackColor Specifies the background color of the object.
Font Specifies the font used for static text.
FontBold If set to true, static text will be displayed in bold type.
FontColor For static text, specifies the color of the text.
FontItalic If set to true, static text will be displayed in italic type.
FontSize For static text, specifies the size of the text, in points.
FontUnderline If set to true, static text will be underlined.
LineColor Specifies the color of the line used to draw the object.
LineSize Specifies the width of the line (in pixels) used to draw the object.
Pattern Specifies the pattern to apply to the background.
PatternColor Specifies the color of the pattern that is applied to the background.
Position-Left Indicates the position of the left edge of the object, measured in points 

from the left edge of the report.
Position-Top Indicates the position of the top edge of the object, measured in points 

from the top edge of the report.
Shape Specifies the shape of an item drawn with the shape tool.
Size-Height Indicates the object height, measured in points.
Size-Width Indicates the object width, measured in points.
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Report field characteristics
When printed on a report, most fields you add to a report layout simply display the
data values stored by them. However, some fields have special display
characteristics you need to be aware of when you use them in a report.

Booleans
When a boolean is added to a report, the string “Yes” is printed on the report if the
field contains the value true. The string “No” is printed on the report if the field
contains the value false.

Check boxes
When a check box is added to a report, an X is printed if the check box is marked.
Nothing is printed on the report if the check box is not marked.

Combo boxes
When a combo box field is added to a report, the text string selected or entered in
the field is printed on the report.

Dates
When a date field is added to a report, the short version of the date value is printed
on the report. The date value is formatted based on the regional settings for the
operating system.

Drop-down lists
When a drop-down list field is added to a report, the static text value corresponding
to the field’s value is printed on the report. If the drop-down list field doesn’t have
any static text items defined for its data type, no text is displayed on the report. In
this case, you must create a calculated field to display a value based on the value of
the drop-down list field.

List boxes
When a list box field is added to a report, the static text value corresponding to the
field’s value is printed on the report. If the list box field doesn’t have any static text
items defined for its data type, no text is printed on the report. In this case, you
must create a calculated field to display a value based on the value of the list box
field.

Multi-select list boxes
When a multi-select list field is added to a report, the static text values
corresponding to the items selected in the field are printed on the report. If the
multi-select list box field doesn’t have any static text items defined for its data type,
no text is printed on the report.

Pictures
Picture fields should not be added to the report layout.

Radio groups
When a radio group is added to a report, the integer value of the field is printed on
the report. If you want to display some other value in the report, you must create a
calculated field to display a value based on the value of the radio group field.

Text fields
When you add text fields to a report layout, you should be aware that they can
display no more than 10K of data, even though text fields can hold up to 32K of
data. Text fields should only be placed in the body of a report.
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Resizing a text field will have different results, depending on whether the report is a
graphics or text report. If you resize a text field in a graphics report, data will be
printed to fill the resized area. However, if the text field is larger than the amount of
data in that field for a given record, the unused space for that field will still be
included in the report. If you resize a text field in a text report, the field width you
specify will be used, but the field height will be adjusted automatically to
accommodate the text in the text field, up to the 10K limit.

For example, you could resize a text field to be two inches wide and tall enough to
include 18 rows of data. If the data in that field for a given record will fill only 12
rows, then only those 12 rows will be included if it’s a text report, while those 12
rows plus 6 blank rows will be included if it’s a graphics report. Similarly, if the data
in that same field for a different record contains 20K of data, up to 10K will be
included if it’s a text report, while only the first 18 rows will be included if it’s a
graphics report.

Times
When a time field is added to a report, the time value is printed on the report. The
time value is formatted based on the regional settings for the operating system.

Visual switches
If the visual switch field has static text values defined, the static text value
corresponding to the field’s value is printed on the report. If the visual switch field
has picture or native picture static values defined, the integer value of the field is
printed on the report. If the visual switch field has no static values defined, it can’t
be used on the report. Instead, you must create a calculated field to display a value
based on the value of the visual switch field.

Applying drawing options
Use the Drawing Options window to select a variety of fonts, font styles, colors and
fill patterns for items in graphics reports. To open the Drawing Options window,
select an item in the layout and choosing Report Drawing Options from the Tools
menu.

If several items are selected in the layout area when you open the Drawing Options
window, the options you specify will apply to all of them. If no items are selected
when you open this window, the options defined will be applied to all new objects
placed in the layout area.

For many objects, such as text, lines, and rectangles, you can open the Drawing Options
window by double-clicking the object.
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Fonts
Use items in the Font section to specify font characteristics for items in the report.
For graphics reports, you can choose any font installed on the current system.

Keep in mind that if the report is used on another system that doesn’t have the appropriate
fonts installed, the missing fonts will be substituted.

Three “generic” fonts are always available for every report. These are:

• Courier (generic)
• Helvetica (generic)
• Times (generic)

These fonts correspond to the fonts that were available in earlier versions of the
Report Writer. If you want your reports to be independent of the fonts installed on a
particular system, use these generic fonts.

If you are creating a text report and have marked the Variable Characters/Inch
option in the report definition, the Font section in the Drawing Options window
allows you to specify the characters per inch to use for each line. Simply select a
field in the line and display the Drawing Options window. You can choose 5, 6, 10,
12, or 17 characters per inch.

Once you set the characters per inch for a field on the report, any other field you
move to that line will also be printed in that size. To see how your text report will
appear when printed, be sure the Show Field Names item in the Layout menu is not
marked. The report will be displayed as it will appear when printed.

Patterns
Use the Patterns section to select the fill pattern for fields, text items or shapes in the
layout.

Color
Use the Color section to select the font/line, background and foreground colors of
items you’ve added to the layout. The line color is used for lines and field borders.
The font color is used for text. The foreground color is used to draw the pattern
selected in the Patterns section. The background color is used to fill in the remaining
area of the object. The line size specifies the size of the line used to draw lines,
rectangles, circles, and other shapes.

When specifying colors, you can select one of the predefined colors in the list. To
use a custom color, select User Defined as the color and then click More Colors to
display the Color dialog. Select a color and click OK. The color you selected will be
applied to the current color selection.

Alignment
Use the Alignment setting to specify the horizontal alignment of text in fields or of
text items you’ve added using the text tool.

If you mark the Variable
Characters/Inch option for a
text report, you can specify
the characters per inch for

each line of the report.
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Chapter 5: Sorting
There are two methods for specifying how the data in a report is sorted. In the first
method, the report is sorted based on a key you select for the main table used for the
report. In the second method, you create a sorting definition based on the fields in
the tables used for the report. Information about sorting is divided into the
following sections:

• Using a main table key
• Creating a sorting definition

Using a main table key

The primary method of sorting a report is to select a key from the main table for the
report. You specify the main table and a key from that table when you use the
Report Definition window to create the definition for a report. The data in the report
is sorted based on the key you select.

This is the preferred method for sorting the report, because an index already exists
for each table key. In effect, the order of the data is already known. The Report
Writer simply retrieves data from the primary table using the key you specified.

Creating a sorting definition

In some cases, there isn’t an appropriate key available to sort the report data the
way you would like. In this situation, you must create a sorting definition. A sorting
definition defines how you want to sort the report data. It is based on fields in the
tables associated with the report. Using a sorting definition is a less-efficient
method for sorting the report, because the Report Writer must read through each
table used by the report to find the appropriate records to use. For optimal
performance, you should use a sorting definition only when necessary.

To create a sorting definition, click the Sort button in the Report Definition window
to open the Sorting Definition window, shown in the following illustration. Use this
window to define a sorting order that includes fields from any of the tables
associated with the report.

The report data is sorted
based on this key selected

from the main table.

The report will be
sorted based on the

fields in this list.
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From the Report Table drop-down list, select the table containing the field you wish
to use to specify the sorting order. The name of each field in the selected table will
appear in the Table Fields list. Select the desired field, and click Insert. The field
name will be added to the Sort By list. Subsequently-added fields will be added to
the top of the Sort By list, unless an item in the list is selected. If an item is selected,
newly-added fields will be added below the selected item.

The sorting order will be based on the fields listed in the Sort By list. The data will
be sorted based on the first field, then, if a secondary sorting order is needed, the
second field, and so on. Be sure to include all fields necessary to fully define the
desired order.

For each field selected, you can specify whether you want the data to be sorted in
ascending or descending order (ascending is the default order) and whether to
ignore the case of any string fields used as sorting criteria. If you ignore case, the
strings will be sorted in strict alphabetical order. If you don’t ignore case and you
are sorting in ascending order, all strings beginning with lowercase letters will
appear in alphabetical order, followed by all strings beginning with uppercase
letters, also in alphabetical order. In descending order, all of the uppercase strings
will appear before the lowercase strings.

To select the Descending and/or Ignore Case options for a given field, select the
desired field in the Sort By list and check the appropriate sorting options. Once you
have specified all the sorting options, click OK to close the Sorting Definition
window.

If none of the fields used to define the sorting order are from a secondary table, the report
information drawn from that table will be sorted according to the key used to define that
secondary table’s relationship with the report’s main table.

Once you have created a sorting definition for a report, it will override the sort
order specified by the key selected for the report’s main table. To use the main
table’s key as the sorting method, you must remove all of the items from the Sort By
list in the Sorting Definition window.
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Chapter 6: Restrictions
Use restrictions to limit the amount and scope of data included in your report. For
example, you could create a report with a restriction based upon the State field, so
that the report will contain only sales data for a specific state.

Information about restrictions is divided into the following sections:

• Defining report restrictions
• Restriction functions

Defining report restrictions
To add restrictions to an existing report definition, use the following procedure. In
the Report Writer window, select the name of the desired report and click Open to
open the Report Definition window. Click the Restrictions button to open the
Report Restrictions window. Click New to open the Report Restriction Definition
window and define a new report restriction. The Report Restriction Definition
window is shown in the following illustration.

Before defining a restriction, it’s a good idea to plan the restriction and write it out
completely. Decide which fields, operators, constants and functions you’ll need to express
the restriction properly. Some restrictions may require that the steps defined below be
performed in a slightly different order. 

1. Name the restriction.
Enter a name in the Restriction Name field. The name can be up to 79 characters
long.

2. Select the appropriate function, if any.
If the restriction you are defining uses a system-defined function, the function
must be included in the expression before the field it is applied to. For example,
to restrict the Customer Order report so that it lists only customers that ordered
more than five items, you could use the following restriction on the
Item_Number field:

FREQUENCY (Item_Number) > 5

For a detailed description of each function available for use when defining a
restriction, refer to Restriction functions on page 36.
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3. Specify the field to restrict on.
From the Report Table drop-down list, select the table containing the field on
which you want to restrict the report. Once the appropriate table is selected,
select the desired field from the Table Fields drop-down list. Click Add Field to
add the selected field to the Restriction Expression.

4. Select the appropriate operator.
From the Operators section, select the appropriate operator. It will
automatically be added to the Restriction Expression field. These are the same
operators described in Operators on page 44 with the exception that the
concatenation operator is not available for use with restrictions.

5. Specify the constant to be used in the restriction.
From the Type drop-down list in the Constants section, select a control type for
the constant you are defining. The five supported control types for constants in
restriction expressions are integer, currency, string, date, and time. Once you’ve
selected the constant’s control type, enter the desired value in the Constant field
and click Add Constant.

6. Verify the restriction expression and save it.
Review the contents of the Restriction Expression field. If any part of the
expression is incorrect, highlight the incorrect value and click Remove. Replace
the removed value, if necessary. Once the restriction expression is correct, click
OK to save the restriction and close the Report Restrictions window.

Restriction functions

This section describes the functions available when defining a restriction for a
report. It includes a definition of each function, an example of how the function is
used in a restriction expression, and an explanation of how you can use such an
expression in a report. Also included is information about the storage types that can
be used with each function, since some functions can be used only in expressions
with fields of a certain storage type.

SUBSTRING and 
WILDCARD are the 
only functions that can 
be used with table 
fields from all report 
tables.

Most of these functions can be used only with fields from a report table that has a
one-to-many relationship with another report table, such as a secondary table with a
one-to-many relationship with the report’s main table. Records in secondary tables
with a one-to-many relationship with the main table are sometimes referred to as
detail records. Using one of these functions with any other fields will cause an error
at runtime. Only two functions can be use with fields from any of the report tables:
SUBSTRING and WILDCARD.

AVERAGE 
The AVERAGE function calculates the average of an expression for all detail
records. It can be used with expressions containing fields of all storage types except
strings.

Example
You can use the AVERAGE function to create a restriction on an invoice list so that it
will print only invoices for which the invoice’s items average a markup of at least
20% over cost.

AVERAGE ((Item Price) – (Item Cost) / (Item Cost)) > .2
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EXISTS
The EXISTS function ascertains whether at least one record in a group of detail
records makes the expression true. The expression the EXISTS function evaluates
should be a comparison as shown in the following example. This function can be
used with all boolean expressions.

You can use the NOT operator with this function to increase its scope and create
expressions restricting the information on your reports according to expressions
that aren’t true.

Example
You can use the EXISTS function to create a restriction on an order list to list
customers whose orders include at least one item over $100.

EXISTS (Item Price > 100)

Unlike other functions, EXISTS and FORALL must be used to evaluate an expression where
the comparison operator is inside parentheses, as shown. This causes the function to
evaluate the entire expression, rather than only the item following it.

FIRST
The FIRST function finds the first occurrence of an expression in a group of detail
records. It can be used with expressions containing fields of any storage type.

Restrictions are evaluated before the report is sorted, so the item designated by the
FIRST function may not be the same as the first item in a group on the report once
it’s been sorted and printed. The first item will be the first value in the table, sorted
by the key used to link the secondary table to the report’s main table.

For example, you could print a report that lists invoices and corresponding line
items, then create a restriction to print only invoices for which the first line item’s
price was more than $1,000. If you then sort the report in ascending order by line
item price, the line item that the FIRST function finds won’t necessarily be the line
item listed first on the report. It will be the first line item in the table, which depends
on the key used to create the table relationship. If the key is composed of the invoice
number and the line item number, the first line item will be the item with the
smallest (or largest, depending upon the key’s sorting method) line item number.

The following example shows an invoice and its line items as they’re sorted within
the tables, by invoice number and by item number.

PriceItemInvoice Number

5005

5005

5005

1201

1205

1211

$5,300.00

$3,900.00

$5,250.00

Records in the table are
sorted by the Invoice

Number and Item.
This is the record the FIRST

function will evaluate.
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Since the line items are sorted by item and not by price, the record identified by the
FIRST function is item 1201. If you sort the report by the price of each line item,
that’s how the information will appear on the report, but the FIRST function will
still identify item 1201 as the first item.

Example
The following example shows how to use the function to create the expression
explained in the previous paragraphs and illustrations.

FIRST (Item) > 1000

FORALL
The FORALL function prints only those records for which all of the detail records
meet the expression’s requirements. This function can be used with all boolean
expressions.

You can use the NOT operator with this function to increase its scope and create
expressions restricting the information on your reports according to expressions
that aren’t true.

Example
You can use the FORALL function to create a restriction on an invoice list to display
only invoices containing items that all cost more than $500.

FORALL ((Item Price) > 500)

Unlike other functions, EXISTS and FORALL must be used to evaluate an expression where
the comparison operator is inside parentheses, as shown. This causes the function to
evaluate the entire expression, rather than only the item following it.

FREQUENCY
The FREQUENCY function counts the number of detail records. The FREQUENCY
function can be used with expressions containing fields of any storage type.

Example
You can create a restriction on a customer order list to print only orders containing
more than five items.

FREQUENCY (Item Number) > 5

LAST
The LAST function finds the last occurrence of an expression in a group of detail
records. The LAST function can be used with expressions containing fields of any
storage type except string.

Restrictions are evaluated before the report is sorted, so the item designated by the
LAST function may not be the same as the last item in a group on the report once it’s
been sorted and printed. The last item will be the last value in the table, sorted by
the key used to link the secondary table to the report’s main table.

Invoice 5005

Item Price

1205

1211

1201

$3,900.00

$5,250.00

$5,300.00

Records on the report are
sorted by the Price.
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The LAST function 
performs much like the 
FIRST function. For 
more information, 
refer to the description 
of the FIRST function 
earlier in this section.

For example, you could print a report that lists Salesperson IDs and corresponding
line items containing dates upon which they’ve made sales and the total amount of
each sale. You could then create a restriction to print only the records for
salespeople whose most recent sale totaled more than $1,000. If you then sort the
report in ascending order by the amount of the sale, the record that the LAST
function finds won’t necessarily be the one listed last on the report. The last record
on the report will be the item with the largest total sale amount.

The following example shows the records for Salesperson ID 001 as they’re sorted
within the tables, by salesperson ID and sale date.

Since the salesperson records are sorted by sale date and not by sale total, the record
identified by the LAST function is the 4/12/97 sale. If you sort the report by the sale
total, that is how the information will appear on the report, but the LAST function
will still identify the 4/12/97 sale as the last item.

Example
The following example shows how to use the function to create the expression
explained in the previous paragraphs and illustrations.

LAST (Sale Total) > 1000

MAXIMUM
The MAXIMUM function finds the detail record with the highest value that satisfies
the given expression. The MAXIMUM function can be used with fields of any
storage type except strings.

Example
You could create a restriction on an invoice list that prints only invoices that include
items priced over $100.

MAXIMUM (Item Price) > 100

Sale TotalSale DateSalesperson ID

001

001

001

1/2/97

2/4/97

2/6/97

$1,200.00

$2,300.00

$1,400.00

Records in the table are
sorted by the Salesperson

ID and Sale Date.

This is the record the LAST
function will evaluate. 001 4/12/97 $1,000.01

Salesperson ID 001

Sale Date Sale Total

4/12/97

1/2/97

2/6/97

$1,000.01

$1,200.00

$1,400.00

Records on the report are
sorted by the Sale Total.

2/4/97 $2,300.00
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MINIMUM
The MINIMUM function finds the detail record with the lowest value that satisfies
the given expression. The MINIMUM function can be used with fields of any
storage type except strings.

Example
You could create a restriction on an invoice list that prints only invoices that include
items priced under $100.

MINIMUM (Item Price) < 100

SUBSTRING
The SUBSTRING function is used to search fields with a string storage type for a
match to a specified pattern. The SUBSTRING function will find a match if the
specified pattern appears anywhere within the specified field. It is case-sensitive.

Only the equality (=) and inequality (<>) operators can be used with the
SUBSTRING function. The data in the specified field either matches or doesn’t
match the pattern. No other operators can be used.

This function is used to restrict the data on the report to information that matches a
set of characters specified as the search pattern. Three special characters can be used
in the search pattern to indicate the type of match you’re searching for: the asterisk
(*), the question mark (?), and the backslash (\). 

These characters are described in the following table.

The SUBSTRING function implicitly adds an asterisk to the beginning and end of
the pattern you specify, so that a match will be found even if the pattern occurs
within the information in the field. For example, the SUBSTRING function would
find a match for the pattern P*L in the word APPLE, while the WILDCARD
function wouldn’t.

The backslash is used in front of special characters, such as quotation marks, that
have specific meaning in Report Writer. A quotation mark indicates the beginning
or end of a field. If you wish to search for fields containing, among other characters,
a quotation mark, you’ll need to place a backslash in front of it to indicate that the
quotation mark is simply a character, and not the sign for the end of the field. Most
symbols and non-alphanumeric characters are special characters and should be
used with backslashes.

Example
You could use this function to print a list of companies in a particular sales region
whose names contain the string John’s. The following example shows an expression
for which “John’s Fish Market” and “Mabel and John’s Deli” would both be valid
matches.

SUBSTRING ("John\'s") = Company_Name

Character Matching search results

* Any character
A group of characters
No characters

? Any single character

\ Used in front of special characters so they can be treated as part of the search 
pattern
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SUMMATION
The SUMMATION function calculates the sum of a specified expression for each
record in a set of detail records. The SUMMATION function can be used with fields
of any storage type except strings.

Example
You can use the SUMMATION function on a report listing invoices and the items on
each invoice to print only the invoices where the total of all item extended prices is
greater than $1,000. The extended price is the price of each item multiplied by the
number of items that were purchased. The SUMMATION function would first
calculate the extended price for each item on the invoice, then sum those extended
prices and compare the sum to the specified $1,000 value. The following expression
demonstrates how this restriction would be written.

SUMMATION (Quantity Ordered * Item Price) > 1,000

WILDCARD
The WILDCARD function is used to search fields with a string storage type for a
match to a specified pattern. The WILDCARD function will find a match only if the
specified pattern appears in the specified field exactly as stated. The asterisk,
question mark and backslash special characters, described in the explanation of the
SUBSTRING function, can also be used with this function.

By using these special characters, you can expand the scope of the search conducted
by the WILDCARD function. Without the special characters, the specified field
must contain exactly the specified pattern, and only the specified pattern, for a
match to occur. For example, the expression WILDCARD (Apple) = Snack Type
would not find a match if the value in the Snack Type field was Apples.

Only the equality (=) and inequality (<>) operators can be used with the
WILDCARD function. The data in the specified field either matches or doesn’t
match the pattern. No other operators can be used.

The WILDCARD function is case-sensitive.

Example
You could use this function to print a list of users whose IDs begin with the letter A.

WILDCARD ("A*") = User ID
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Chapter 7: Calculated Fields
Calculated fields are a powerful tool you can use to manipulate data in your report.
Calculated fields are defined using fields, constants and operators, as well as
system-defined or user-defined functions. The following illustration shows the
Calculated Field Definition window.

A calculated field is based on either a conditional expression or a calculated
expression. A conditional expression allows you to print one value or another,
depending on the result of a boolean expression. A calculated expression allows you
to print the result of an expression, such as the sum of several currency fields, or the
concatenation of several string fields.

The result of a calculated field must be an integer, currency, variable currency,
string, or date value. You can use time fields or constants in a conditional
expression, but the result printed based on that conditional expression must be an
integer, currency, string, or date. For example, you could compare the value of a
time field to a time constant to determine whether to print the string “Morning” or
the string “Afternoon.”

When defining an expression for a calculated field, the expression can’t be typed in
directly. Instead, the expression must be built by adding the elements to the
expression from the Fields, Constants, or Functions tabs and the Operators keypads.

Information about calculated fields is divided into the following sections:

• Creating a calculated field
• Operators
• Fields tab
• Constants tab
• Functions tab
• System-defined functions
• User-defined functions
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Creating a calculated field

Follow these steps to create a new calculated field for your report:

Click the Reports button on the toolbar. In the Report Writer window, select and
open a report definition. Click Layout in the Report Definition window. The Report
Layout and Toolbox window will open. From the Layout tab in the Toolbox window
select Calculated Fields from the drop-down list, then click New.

1. Name the calculated field.
The calculated field name can be up to 79 characters long.

2. Select the result type.
This is the storage type that will be used for the value the calculated field
produces. For example, if the calculated field is a calculated expression that
concatenates two string fields, the result type must be a string.

If the calculated field is based upon a conditional expression, both the True Case
and False Case values must be of the same storage type as the result type.

3. Select the type of expression.
Calculated is selected by default. If you select Conditional, nine additional
boolean operators will be enabled in the Operators section; the True Case and
False Case fields will also be enabled.

The options under 
each tab, and the 
usage for each opera-
tor are described in the 
following sections.

4. Define the expression.
Select each element to be included in the expression from the appropriate tab
(Fields, Constants, or Functions). Click Add to place the selected element in the
currently-highlighted position within the expression. Add the appropriate
operators to the expression as needed.

5. Define conditional values.
If this calculated field is based on a conditional expression, define the True Case
and False Case values. One of these values will be printed in the calculated field
on the report, depending on whether the expression defined is true or false.

6. Save your entry.
Click OK to save the calculated field and return to the Report Layout window.

Operators

Operators allow you to specify the relationships between the various components
of expressions. Some operators are only enabled if you are creating a conditional
expression.

Parentheses ()
Indicate the beginning and end of an expression that should be evaluated as a unit,
separate from the rest of the expression. In general, you should use parentheses to
enclose parts of the whole expression when you’re using two or more operators and
you wish to control the order of evaluation.

Parentheses are automatically added to an expression when you insert a function.
The item following it, usually a field, is automatically placed within the
parentheses.
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Addition (+)
Adds the value to the left of the addition operator to the value to the right of the
operator.

Subtraction (-)
Subtracts the value to the right of the operator from the value to the left of the
operator.

Multiplication (*)
Multiplies the value to the left of the operator by the value to the right of the
operator.

Division (/)
Divides the value to the left of the operator by the value to the right of the operator.

CAT
Joins the data in two fields with a string storage type into one string of characters.
CAT stands for “concatenate,” and is symbolized by the pound (#) sign when
displayed in an expression. You may want to use the CAT operator in conjunction
with the STRIP function so that only the data in each field is displayed, and not
empty blanks following the data.

The following operators are enabled only when you’re creating conditional
expressions.

Equality (=)
Indicates that if the two values to either side of the operator are equal, the
expression is true.

Inequality (<>)
Indicates that if the values to either side of the operator aren’t equal, the expression
is true.

AND
Joins a series of expressions within a conditional expression. All of the expressions
joined by an AND operator must be true for the entire expression to be true.

Greater than or equal to (>=)
Indicates that if the value to the left of the operator is greater than or equal to the
value to the right of the operator, the expression is true.

Greater than (>)
Indicates that if the value to the left of the operator is greater than the value to the
right of the operator, the expression is true.

OR
Joins a series of expressions within a whole condition or restriction. Only one of
these expressions must be true for the entire expression to be true.

Less than or equal to (<=)
Indicates that if the value to the left of the operator is less than or equal to the value
to the right of the operator, the expression is true.
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Less than (<)
Indicates that if the value to the left of the operator is less than the value to the right
of the operator, the expression is true.

NOT
Reverses the meaning of the expression following it. For example, the following
expressions are written differently but have the same result:

NOT(Account Balance < 5000)

Account Balance >= 5000

Fields tab

The Fields tab contains two drop-down lists: Resources and Field. Once a resource
is selected, the Field drop-down list is enabled, displaying all available choices of
the selected resource type. If there are no values for the selected resource type, the
Field drop-down list will remain disabled.

The Resources drop-down list always begins with four system entries: Report
Fields, Calculated Fields, RW Legends, and Globals. These are followed by the
name of each table associated with the current report. If a table name is selected,
each field in that table will be listed in the Field drop-down list. The following
describes each system entry, and what appears in the Field drop-down list if that
entry is selected.

Refer to Chapter 10, 
“Modifying Fields,” for 
information about 
using the Report Field 
Options window to 
change a field’s display 
type.

Report Fields
Report Fields fills the Field drop-down list with all fields on the report that have
modified display types (fields for which the Report Field Options window has been
used to change the field’s display type from Data to some other type, such as
Count). The display type, or an abbreviation of the type, is listed first, followed by
the name of the field to which it was applied. Use the Report Field Options window
to change a field’s display type.

Calculated Fields
Calculated Fields fills the Field drop-down list with all calculated fields the current
calculated field can reference. Under special circumstances, dependencies between
calculated fields can that prevent them from being used by the current calculated
field. If a calculated field can’t be used, it won’t be displayed in the list.

Refer to Chapter 9, 
“Legends,” for more 
information about 
using legends in 
reports.

RW Legends
RW Legends fills the Field drop-down list with one selection: Legend. Selecting this
value allows you to use one of the legend values passed into the report by the
application. When you click Add, a dialog box will appear, prompting you to enter
an index value indicating which legend value to use. The legend will be added to
the expression you’re creating.

A legend is passed into the calculated field as a string. If you need the legend value to have
some other storage type, you will need to use one of the system-defined functions to convert
the legend value. System-defined functions are described in System-defined functions on
page 48.

Often, legends are used in a calculated field to specify the array index of an array
field. The following procedure describes how to use a legend to specify the array
index in a calculated field.
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1. Add an array field to the expression.
Select an array field to add to the expression and click Add. A dialog box will
appear, prompting you to enter the array index. Enter any number, then click
OK.

2. Remove the array index.
Highlight the newly-entered index number in the expression, and then click
Remove.

3. Insert the appropriate conversion function.
Click the Functions tab, and select the STR_LNG system-defined function. Click
Add. This function will convert the legend (a string value) value into a long
integer so it can be used as the array index.

4. Add the legend.
Click the Fields tab. Select RW Legends from the Resources drop-down list, and
Legend from the Field drop-down list. Click Add; you will be prompted to
enter the array index. Enter the number corresponding to the position of the
desired legend value. For example, if four legend values are passed to the
report, enter an index of 1 to specify the first legend, 2 to specify the second, and
so on.

The value you passed to the first legend will specify which array element value to
display. If the value 1 is passed to the first legend, the first quarter’s bonus value is
displayed. If the value 2 is passed to the legend, the second quarter’s value is
displayed, and so on.

Globals
Globals populates the Field drop-down list with all of the fields declared as global
variables in the current dictionary.

Constants tab

Constants are values you set. Typically, they are used in the True Case and False
Case fields, or as a value against which fields are compared in the expression. This
tab contains two fields: the Type drop-down list and the Constant field.

The Type drop-down list contains five choices: Integer, Currency, String, Date, and
Time. The value you are allowed to enter in the Constant field depends on the
constant type selected. For example, if you select Integer as the constant type, you
will be able to enter only numeric values in the Constant field.

The following expression shows the use of two different constant types. The
12:00:00 PM value is a constant of the Time type, while the True Case and False Case
fields’ values of Morning and Afternoon are String type constants.
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Functions tab

Within the Functions tab, you must select the type of function you want to use,
either System-Defined or User-Defined. System-Defined is the default.

Depending on which type of function is selected, one or two drop-down lists will
appear below the radio group. If System-Defined is selected, the Function drop-
down list will appear, allowing you to choose one of the predefined functions. If
User-Defined is selected, two drop-down lists will appear, Core and Function. To
select a function you’ve created, you must first select the core with which the
function is associated. You can then select the desired user-defined function from
the Function drop-down list.

Many of the system-defined functions convert a field’s storage type. For example, the
CUR_STR function converts a currency control type field to a string control type field. The
conversion doesn’t affect the way the field is stored in the table, only how its data is
evaluated in the calculated or conditional expression.

System-defined functions

To use system-defined functions in expressions, select a function from the drop-
down list and click Add. Then, from the Fields tab, select the field you wish to use
with the function and click Add. The field will appear in the expression, enclosed in
parentheses.

You can’t apply one system-defined function to another, or “nest” one function
within another. For example, if you’re using the CUR_STR function to convert a
currency field to a string, you can’t use the STRIP function to remove extra spaces
from the same field. For example, the following is not permitted:

STRIP (CUR_STR ( Beginning Balance ) ) 

If the field you want to create requires using two system-defined functions, first
create a calculated field using the first function, then create another calculated field
that applies a second function to the first calculated field, as in the following
example:

Calculated field 1 CUR_STR ( Beginning Balance )

Calculated field 2 STRIP ( Calculated field 1 )

Each system-defined function takes only one parameter. The following briefly
explains each of these functions:

CUR_STR
Converts a field with a currency storage type to a string.

DAY
Takes a date value and returns the day portion of the date. The integer value
returned will range from 1 to the maximum number of days in the month.

DAY_NAME
Takes a date value and returns a string containing the name the day of the week for
the date value.
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DOW
Takes a date value and returns an integer representing the day of the week the
specified date falls on. The following table lists the integer values and the
corresponding day:

INT_STR
Converts a field with an integer storage type to a string type.

LFT_STR
Prints only the data that lies to the left of the caret (^) in a field with a string storage
type. If there is more than one caret in the field, the function will print only the
characters to the left of the leftmost caret. The caret must be part of the field, not
part of a format applied to the field’s data type. If there is no caret in the string, the
entire string will be printed, provided enough space is allocated in the layout area.

LNG_STR
Converts a field with an integer or long integer storage type to a string type.

MONTH
Takes a date value and returns the month portion of the date. The integer value
returned will range from 1 to 12.

MONTH_NAME
Takes a date value and returns a string containing the name of the month for the
date value.

POWER_10
Multiplies 10 to the power specified as this function’s parameter. For example, the
value of POWER_10(2) is 10 to the power 2, or 100. This function is useful for
dealing with currency fields and decimal placement.

RGT_STR
Prints only the data that lies to the right of the caret (^) in a field with a string
storage type. If there is more than one caret in the field, the function will print all the
characters to the right of the leftmost caret. The caret must be part of the field, not
part of a format applied to the field’s data type. If there is no caret in the string, no
data will be printed.

STR_DAT
Converts a field with a string storage type to a date. The string of characters you
convert to a date must be in MM/DD/YY format. If the year listed is 35 or less, the
year will be preceded by “20,” so that the year will be 2035, for example, instead of
1935.

Integer value Day

0 Sunday

1 Monday

2 Tuesday

3 Wednesday

4 Thursday

5 Friday

6 Saturday
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STR_CUR
Converts a field with a string storage type to a currency type. The current control
panel settings for the currency symbol, thousands separator, decimal symbol, and
negative currency format will be used as the basis for analyzing the string. If the
string cannot be properly interpreted based on the current control panel settings, it
will be interpreted using the following rules:

• No currency symbol
• The current control panel setting for the decimal separator
• No thousands separator
• A minus sign as the negative indicator at the beginning of the value

STR_LEN
Counts the number of characters, excluding blanks at the end of the string of
characters, in a field with a string storage type. Blanks within a string are counted.

STR_LNG
Converts a field with a string storage type to a long integer. This function can be
used to compare a string field to a long integer field. Since Report Writer can’t
compare two fields with different storage types, using the STR_LNG function to
convert the string field to a long integer field allows you to compare it to other long
integer fields.

STR_VCUR
Converts a field with a string storage type to a variable currency type. The string
will be interpreted using the following rules:

• No currency symbol
• The current control panel setting for the decimal separator
• No thousands separator
• A minus sign as the negative indicator at the beginning of the value

STRIP
Removes trailing blank spaces from fields with string storage types. The STRIP
function can be used with the CAT operator, but can’t be applied to an expression
containing the CAT operator.

For example, the following expression is valid: 

STRIP (Cust_Name) # " has this address: " # STRIP (Address)

The following expression is invalid:

STRIP (Customer Name # Address)

SUBSTRING
Searches fields of the string storage type for a match of the specified string pattern,
regardless of whether that match occurs at the beginning of or within the string
field. Searches are case-sensitive.



U S E R ’ S G U I D E 51

C H A P T E R  7    C A L C U L A T E D  F I E L D S

Three special characters can be used in the search pattern: the asterisk (*), the
question mark (?), and the backslash (\), as indicated in the following table.

The backslash is used in front of special characters that have specific meaning in
Report Writer, such as quotation marks that indicate the beginning or end of a field.
If you want to search for fields containing a quotation mark, you’ll need to place a
backslash in front of it to indicate that the quotation mark is simply a character, and
not the sign for the end of the field. Most symbols, such as the pound sign (#) or the
at sign (@), are special characters and should be preceded by backslashes if you
want them to be evaluated literally in an expression.

The difference between this function and the WILDCARD function is that this
function implicitly adds an asterisk to the beginning and end of the pattern you
specify. For example, the SUBSTRING function would find a match for the pattern
P*L in the word APPLE, while the WILDCARD function wouldn’t.

You must use the SUBSTRING and WILDCARD functions with the equality (=) and
inequality (<>) operators in conditional expressions, to ascertain whether the data
in the field matches or doesn’t match the pattern.

In an expression, the SUBSTRING and WILDCARD functions should always
precede the name of the field you want to match to the pattern. For example, the
following example would check whether the values for the Name field contains the
string Ann. Each of the following names would be considered matches: Anne Jones,
MaryAnn Magaldi, and Jose Annez.

SUBSTRING ("Ann") = Name

The following example checks the First_Name field for all names containing the
letter “t” separated from the letter “n” by one other character. Names that would
match this search include “Astin”, “Barton”, and “Antonette”.

SUBSTRING ("t?n") = First_Name

UCASE
Prints the alphabetic characters in the specified string field in uppercase. Numeric
characters won’t be affected.

WILDCARD
Searches fields of the string storage type for an exact match of the specified string
pattern. Searches are case-sensitive.

You can use the *, ?, or \ special characters to indicate the type of match you’re
searching for. These special characters have the same effect as they do with the
SUBSTRING function.

Character Matching search results

* Any character
Any group of characters
No characters

? Any single character

\ That the following special character is to be treated as part of the search pattern
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Unlike the SUBSTRING function, this function does not implicitly add an asterisk to
the beginning and end of the pattern you specify. Therefore, this function is useful
when you want to search for strings that begin with a certain character or set of
characters.

The following example checks the First_Name field for all names beginning with
the letters “To”. Names that would match this search include “Tony”, “Tonya”, and
“Tomas”.

WILDCARD ("To*") = First_Name

The following example checks the Local_Businesses field for all stores beginning
with the string “Tommy’s”. Note that this search uses both the \ and * special
characters. Business names that would match this search include “Tommy’s
Pizzeria” and “Tommy’s Bait and Tackle Shop”.

WILDCARD ("Tommy\'s*") = Local_Businesses

YEAR
Takes a date value and returns the year portion of the date. The integer value
returned will be a four-digit year, such as 2001.

User-defined functions

In addition to the system-defined functions, you can use functions that have
specifically been added to the application for use in calculated fields. The names of
user-defined functions intended for use in calculated fields begin with the letters
“RW” so they are recognized by the Report Writer.

A document with descriptions of the user-defined functions available for the Report Writer
is found in the Microsoft Dynamics GP SDK in the “Procedures and functions” category.
You can find the document by searching for “Report Writer”.

To add a user-defined function to an expression, select the core the function is part
of from the Core drop-down list. Once a core is selected, the Function drop-down
list will become active. You can then select the desired user-defined function from
the Function drop-down list. Click Add to add the function to the expression.

The Report Writer automatically adds the selected function to the expression
enclosed in parentheses and preceded by the system-defined function
FUNCTION_SCRIPT. This system-defined function is used only to process user-
defined functions. It is added to the expression by the Report Writer, and can’t be
added to the expression from the System-Defined Function drop-down list.

Once the user-defined function is added to the expression, add any needed
parameters using the fields and constants tabs. Table fields, calculated fields and
constants can be used as parameters for a user-defined function included in a
calculated field. Be sure the parameters are placed before the closing parenthesis.

Be sure to add the appropriate number and type of parameters for the selected function. The
Report Writer will not check the compatibility of the specified parameters until runtime.

To use a report field value as parameter for a user-defined function, create a calculated field
with that report field as the only element of the calculated expression. Then, use that
calculated field as the parameter for the user-defined function in another calculated field.
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When a user-defined function in a calculated field is evaluated depends on the
parameters that are passed to the function. If no parameters are passed to the user-
defined function, the function will be evaluated one time when the report is run. If a
table field or value based on a table field is passed as a parameter to the user-
defined function, the function will be evaluated each time a new record is read from
that table.

The RW_AccountNumber user-defined function is used to retrieve an account
number based on an account index stored in a table. The following is the expression
for the calculated field that uses this user-defined function is shown in the following
illustration. Notice that the Account Index field from the Year-To-Date Transaction
Open table is passed to the function.

FUNCTION_SCRIPT(RW_AccountNumber GL_YTD_TRX_OPEN.Account Index )

Using this user-defined function allows you to easily use an account number on a
report without having to attach the Account Master table to the report.
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Chapter 8: Additional Headers and Footers
Additional headers and footers are used primarily to create groups on your report,
grouping all records that contain the same value for a particular field. Information
about additional headers and footers is divided into the following sections:

• Overview of headers and footers
• The order of headers and footers
• Creating additional headers or footers

Overview of headers and footers

If your report includes a field that contains the same value for several records, and
that field is part of a key or a defined sorting order – for instance, the same invoice
number for several line items – you can use an additional header to print that field
once, then include its related fields from each record in the body of the report. When
all records related to the current value of the common field have been printed, the
next value of the common field will be printed, followed by its related fields, and so
on. If an additional footer is based on this same common field, the additional footer
will print before the next iteration of the additional header.

For instance, if you want to create a report listing each of your user classes and the
users in each class, you could use an additional header to print the name of each
class, followed by a list of the users in that class. Once all the records for the first
user class are printed, the additional footer will be printed. Next, the additional
header will be printed again, containing the name of the second user class, and so
on.

The following illustration displays an example report that uses additional headers
and footers.

USER CLASSES

User Class:

User Class:

User Class:

User IDAdministrator
Margaret
Tracy

Users in this class: 2

Users in this class: 4

Users in this class: 3

Data entry

Supervisor

Bill
Juanita
Julie
Kim

Rahul
Dan
Steve

User ID

User ID

Additional header

Additional footer

Report body

The additional header
breaks on the User Class

field, so all records that
contain the Data entry

value are printed together.
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The order of headers and footers

If you’re creating two or more additional headers, or two or more additional footers,
be sure to create them in the correct order. They will be evaluated in the order they
appear on the report layout. For example, if you create three additional footers, the
first will appear in the report layout toward the bottom, next to the report footer.
The second will appear above the first, and the third will appear between the
second additional footer and the report body, as shown in the following illustration.

You can specify where an additional header or footer should appear. In the Report
Section Options window, highlight the additional header or footer that should
appear directly above the one you’re adding, then create the section as usual.

If you aren’t satisfied with the order of your additional headers or footers, you must delete
the header or footer you want to move, then re-create it in the desired location.

Be sure to consider the report’s sorting order when determining the placement of
your additional headers and footers. Remember that an additional header or footer
prints when the data in the field it’s based on changes. For example, if the field that
Header 2 is based on changes before the field that Header 1 is based on, Header 2
will print first. Therefore, if you always want Header 1 to appear before Header 2,
be sure that the field you base Header 1 upon appears in the sorting order before the
field Header 2 is based on.

Creating additional headers or footers
To create an additional header or additional footer for a report, open the Report
Layout window for the report. Choose Report Section Options from the Tools menu
to open the Report Section Options window.

1. Open the appropriate window.
Click the New button next to the Additional Headers list or the Additional
Footers list, depending upon which you are adding. The Header Options or
Footer Options window will open. If an existing header or footer is highlighted
in the list, the one you add will appear after the selected one.

2. Name the resource.
Enter the header name or footer name. This name will appear in the appropriate
section in the Report Section Options window.

First additional header

First additional footer

The most recently created
additional header or

footer is placed next to
the report body.
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3. Limit the number of records in the report body.
If you are defining an additional footer and wish to limit the number of records
that appear in the body of the report before the additional footer is printed,
enter that number in the Records Per Report Body field. If you have multiple
additional footers, this field should be specified only in the first additional
footer.

Typically, this feature is used when the report is to be printed on a preprinted
form. For example, consider a preprinted form with a stub on top and a check
blank on the bottom. If the stub can list up to four separate invoices that are
being paid by the check, you should include the invoice number and invoice
amount fields in the body of the report, and the date, and payment amount
(both in numbers and in words), appropriately spaced in the additional footer.

4. Select the field the resource will be based upon. 
From the Report Table drop-down list, select the name of the table that contains
the field the additional header or additional footer should be based on. The
report’s main table will appear in this list by default.

If you haven’t created a sorting definition for the report, only fields that are part
of the key for the report table you’ve selected will be displayed in the Table
Field list. If you’ve created a sorting definition for the report, only fields from
the selected table that are part of that sorting definition will appear.

If an additional header or footer is based on a field used in a sorting definition, and that
sorting definition is later deleted, the additional header or footer must be deleted as well.

Refer to Chapter 7, 
“Calculated Fields,” for 
more information 
about calculated fields.

5. Specify the resource’s suppression option.
Select the Suppress When Field Is Empty option if you don’t want this
additional header or footer to be printed if a specific calculated field is empty.
Once this option is selected, the Calculated Field drop-down list will be
enabled. Select the name of the desired calculated field.

6. Set remaining additional footer options.
If you are defining an additional footer, several other options are available.
Select each option that is appropriate for the current additional footer:

Page Break Starts a new page after the additional footer is printed. You can
use this option even if you don’t display any data in this additional footer.

Reset Report Begins a new report each time this additional footer completes
printing. The page footer and report footer, if active, will print after this
additional footer, before the new report begins printing. Once the new report
begins, the page numbers will begin again at 1, and the report header, if active,
will be printed. 

Suppress Last Record’s Footer Suppresses the last occurrence of the
additional footer. If you mark this option, you may want to mark Reset Report
as well. If you don’t, only the last occurrence of the additional footer on the
entire report will be suppressed.

For example, you may want to mark this option if you’re creating a layout for
checks with a stub both on the top and bottom. The stubs would be placed in
the body, while the check would be placed in an additional footer. Since only
one check should be printed, the second additional footer should be
suppressed.



P A R T  2 C R E A T I N G  R E P O R T S

58 U S E R ’ S G U I D E

No Break At Record Count Mark this option if you have specified a
number in the Records Per Report Body field, but want the additional footer to
print only when the value in the field the footer is based on changes. If a value
is specified in the Records Per Report Body field and this option isn’t marked,
the footer will print even if the field the footer is based on hasn’t changed.

This option shouldn’t be marked if you’re printing checks on preprinted forms,
but you may want to mark it if you’re printing invoices on forms with more
than one page.

7. Save the resource.
Click OK to save the additional header or additional footer, and return to the
Report Section Options window.
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Chapter 9: Legends
Legends are fields you can add to your report to display information that is passed
to the report when it is printed. Typically, legends are used to display string values
representing the sorting and restriction options selected by the user running the
report. Legend values can also be used as elements in calculated fields.

Since legend values must be passed into the report by the application, they are
generally available only for modified reports. Any new reports you create won’t be
able to use legends, unless you have Visual Basic for Applications (VBA) and have
set up scripts that set the legend values.

Information about legends is divided into the following sections:

• Using legends
• Legends example

Using legends

To add legends to the Report Layout area, follow these steps:

1. Select Legends from the drop-down list in the Layout tab of the 
Toolbox.
The scrolling window below the list will be filled with the word Legend
followed by an array index (such as Legend[1] and Legend[2]).

2. Drag a legend to the layout area.
Add legends to the report layout area sequentially, beginning with Legend[1].
You can add the same legend to report multiple times if you want that legend’s
value to appear in multiple locations on the report.

If you don’t have specific information about the values passed into legends for a report,
you can find out how the legends are used. Add the legends to the report layout and
print the report. If legend values are passed into the report, they will be printed on the
report.

3. Add additional legends to the layout area.
You can add up to 255 legends the layout area. Add the first 30 legends by
selecting a legend from the scrolling window in the toolbox and dragging it to
the layout area.

To add additional legends, drag a legend from the toolbox to the layout area,
and double-click it to open the Report Field Options window. Use this window
to change the array index of the legend. To change the array index, change the
value of the Array Index field to appropriate index number, and click OK.

Be sure to resize each of your legends to accommodate the largest amount of information that
could be included in it. If legends aren’t sized properly, information will be truncated.
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Legends example

The following illustration shows the Item List report. This report uses legends to list
the ranges of items that are included in the report. It also uses a legend to indicate
how items are sorted. Two other legends are used to indicate whether discontinued
items and vendor information are included in the report.
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Chapter 10: Modifying Fields
Fields in the report layout can be modified in three ways: a format can be applied to
them, their visibility setting can be altered, and their display type can be changed.
Use the Report Field Options window, shown in the following illustration, to make
these modifications.

Information about modifying fields is divided into the following sections:

• Field visibility
• Specifying a format resource
• Specifying a format field
• Changing display types
• Display type summary

Field visibility

Fields in the report layout area can have their visibility set to one of three options:
visible, invisible, and hide when empty. Fields added to the layout area are
automatically set to visible.

Visible fields are always displayed on the report, even if the field is blank for a given
record. If a visible field is blank but has a format applied to it, the formatting will be
displayed on the report without any data. For example, a ZIP code field could be
formatted to include a dash between the fifth and sixth characters. If this field is
included on a report and is visible, and a given record has no ZIP code data, only a
dash will appear in the ZIP code field for that record on the report.

A hide when empty field will not be included on a report for a specific record if the
field is blank. For example, if a customer record doesn’t include a telephone
number, and the phone number field is marked as hide when empty, then for that
customer record, the empty phone number field and any related formatting won’t
be included on the report.

Selecting hide when empty prevents formatting from appearing on a report when the field
contains no data.
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An invisible field will never be shown on the report output. When a field is
invisible, it will appear in the report layout in gray with a dashed border, as shown
in the following illustration:

Commonly, fields are marked as invisible when their values are needed for use in
calculated fields, but are not needed for display on the report. For example, you
may want to display a field on the report showing the difference between the
highest and lowest values of specific field. To accomplish this, add the field to a
footer in the report layout twice. Change the display type of one instance to
Minimum, and the display type of the other to Maximum. Then, create a calculated
field that subtracts the minimum value from the maximum value. Since only the
calculated field needs to be displayed on the report, set the visibility of the
minimum value and maximum value fields to invisible.

Specifying a format resource

Applying a format to a field changes the way in which the data stored in the field is
displayed. For example, the phone number field may contain the value 7015551234.
By applying a format that adds parentheses around the first three digits and adds a
dash between the sixth and seventh digits, the value will be readily recognizable as
the telephone number (701) 555-1234.

Refer to Chapter 18, 
“Formats,” for more 
information about 
creating formats.

You can apply formats created with the Format Definition window to string,
currency, composite, and numeric fields that appear in the report layout. To apply a
format to a field, click the Format lookup button in the Report Field Options
window to display a list of formats that can be applied to the field. Select a format in
this list, or click New to create a new format. When you have finished, the name of
the format applied will appear in the Format field in the Report Field Options
window.

Specifying a format field

This is an advanced 
formatting feature. You 
may want to skip this 
section until you have 
a better understanding 
of the Report Writer.

The formatting displayed for certain string and currency fields in Microsoft
Dynamics GP is based on the value of an integer field called a format field. You
specify a format field to use by selecting a field in the Format Field list of the Report
Field Options window. The integer value contained in the selected format field
specifies how to format the report field.

Don’t apply a specific format to a report field and use the Report Field Options window to
specify a format field for the same report field; the format results will be unpredictable.

This field is invisible.
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Formatting currency fields
When you select a format field for a currency field, the possible formats for currency
fields and the integer value associated with them are shown in the following table.

The integer value used to indicate the format used can be stored in a table along
with the currency field being formatted. When the record is retrieved from the table,
the currency field will display as it did when the record was saved. The format field
can also be used for a report, allowing the currency field to appear in the report as it
did when it was saved in the table.

Microsoft Dynamics GP can define its own formats, in addition to those shown in the
previous table. This capability is used to define currency format information for
multicurrency support.

Formatting string fields
For string fields, the integer value indicating the format to use corresponds to the
position of the format string in the Format Definition window.

The following example describes a Part Number field that has three different format
strings. The user selects the format to apply by selecting the corresponding format
in a drop-down list linked to the Part Number field. The three format strings for the
Part Number field, entered in the Format Definition window, are shown in the
following illustration.

Integer Format Integer Format

0 Control panel defaults 10 $1,234.567

1 1,234 11 $1,234.5678

2 1,234.5 12 $1,234.56789

3 1,234.56 13 1,234%

4 1,234.567 14 1,234.5%

5 1,234.5678 15 1,234.56%

6 1,234.56789 16 1,234.567%

7 $1,234. 17 1,234.5678%

8 $1,234.5 18 1,234.56789%

9 $1,234.56

This format string is used when
the format field value is 0 or 1.

This format string is used when
the format field value is 3.

This format string is used when
the format field value is 2.
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Using format fields
The presence of a format field typically won’t affect modifications you make to
reports. You need to watch for fields that have a format field specified. If you make
modifications to these fields, be sure the format field remains unchanged so the data
in the field continues to display properly.

Another situation to be aware of occurs when Microsoft Dynamics GP uses a format
field to apply multicurrency formatting to currency fields for a report. All of the
currency fields in the report will use a format field typically named Currency Index.
The value of this field indicates what multicurrency formatting will be applied to all
of the currency fields linked to it. If you add currency fields to the report, be sure
those fields use the same format field that Microsoft Dynamics GP is using.

Changing display types

Fields for which the 
display type has been 
changed are referred to 
as report fields.

A field in the report layout can have its display type changed to alter the way in
which data is displayed in the field. For example, you can add the invoice_total
field to the body of a report, then add it again to the report’s footer. By changing the
display type of the invoice_total field located in the report footer to Sum, that field
will not display a specific invoice’s total. Instead, it will display the sum of all
instances of the invoice_total field displayed in the body.

To change a field’s display type, select the desired type from the Display Type list in
the Report Field Options window. The following describes each display type,
including information about the storage types each type can or can’t be used with:

Average
Prints the average value of the data printed in a group or on a report. This display
type should not be used with fields having string, date, or time storage types.

Control Count
Prints the number of times the additional footer immediately above the footer
containing the Control Count field is printed on a report. The Control Count display
type can be used only when you’re printing information in groups using additional
footers. This display type should not be used with fields having date or time storage
types.

Count
Prints the number of times a field is printed in a group or on a report. This display
type can be used with fields of all storage types. If you’re printing a report with
groups and counting categories, use the Control Count display type instead.

Data
Prints data without modifications, as it’s stored in the table. All fields in the body of
the report whose display types have not been modified have the display type Data.
Calculated fields placed in footers should have their display type changed from
Last Occurrence to Data, so that the calculations will perform properly. This display
type can be used with fields of all storage types.

The Report Writer allows you to assign the Data display type to fields other than calculated
fields in a footer; however, calculated fields are the only fields that should have the Data
display type in a footer. The Report Writer sets the default display type for fields placed in
footers to Last Occurrence. The Sum display type is another display type commonly used in
footers.
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First Item In Group
Prints the first value that was printed in a group or on a report. This display type
should not be used with fields having date or time storage types.

First Occurrence Only
Prints a value only the first time it occurs, instead of each time it occurs. You can use
the First Occurrence display type to organize your data in groups without the use of
additional headers and footers. This display type can be used with fields of all
storage types.

Last Occurrence
Prints the last value of the field that was printed in a group or on a report. It also can
be thought of as the current occurrence. All fields placed in footers are
automatically assigned a Last Occurrence display type. Calculated fields placed in
footers should have their display type changed from Last Occurrence to Data, so
that the calculations will perform properly. This display type should not be used
with fields having date, time, or text storage types.

Maximum
Prints the greatest value of the field that was printed in a group or on a report. This
display type should not be used with fields having string, date, or time storage
types.

Minimum
Prints the smallest value of the field that was printed in a group or on a report. This
display type should not be used with fields having string, date, or time storage
types.

Previous Occurrence
Prints the value of the field printed immediately before the last occurrence in a
group or on a report. This display type should not be used with fields having date
or time storage types.

Running Sum
Prints the total of the field’s values at the point where the field is placed within the
entire report. This display type should not be used with fields having string, date,
or time storage types.

Sum
Prints the sum within a group or on a report. This display type should not be used
with fields having string, date or time storage types.
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Display type summary

The following table indicates which display types can be used in the various
sections of a report.

You can use a First Occurrence Only display type in the body of a report if one of the
following conditions in true:

• The field is in the selected key for the main table of the report.

• If you use an alternate sorting definition for the report, the field must be one of
the segments in the sorting definition.

The value of any report fields you use in the page header or page footer, such as
Average or Sum, will be based on records used for the body of the report. They
won’t take into account records used for additional headers or additional footers.
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Average X X X X

Control Count X X

Count X X X X

Data X X X X X X X

First Item In Group X X

First Occurrence Only X*

Last Occurrence X X

Maximum X X

Minimum X X

Previous Occurrence X X

Running Sum X X X X

Sum X X X X

* Refer to notes in text
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Part 3: Gathering Data
This portion of the documentation describes the structure of data for Microsoft
Dynamics GP, and explains how to gather data from various tables for use in
reports. The following is a list of the topics discussed, along with a brief explanation
of each:

• Chapter 11, “Data Storage,” explains how data is stored in Microsoft Dynamics
GP.

• Chapter 12, “Table Relationships,” explains how to create and use table
relationships to gather data to use in a report.

• Chapter 13, “Virtual Tables,” describes virtual tables and how to use them for
reports.
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Chapter 11: Data Storage
This portion of the documentation describes how data is stored in Microsoft
Dynamics GP. It also describes how to determine which tables you need to use to
gather the data for your report. Information is divided into the following sections:

• Terminology
• Table names
• Table types
• Table groups

Terminology

The following terms describe the basic parts of a database. You should become
familiar with these terms to better understand how the accounting system stores
data.

Fields A field represents one category of information that can be stored in a table,
such as a customer name or a customer address. For instance, if you were to track
customer names and addresses, you could use the following fields:

Records A record is made up of one instance of each field in a table. All of the
records in a table contain the same fields (categories of data). For keeping track of
customer names and addresses, think of a record as one row in a table containing
the information. Each row (record) contains the information for one customer.

Customer ID Customer
Name

Address City State

Fields

Customer ID Customer
Name

Address City State

Record

C1002

C1392

C4432

C4499

Jean
Thompson

P.O. Box 8392
82 101 Ave.

Kansas
City

MO

Serge
Lemieux

11 Ash Lane Edmonton AB

ND

IL

Fargo

Springfield

239 Hampton
Village

Dan Smith

Cheryl Miner 9800 Woodland
Drive
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Tables A table is a collection of records, such as your business’ customer records.
Tables group related records the same way the table in the following illustration
groups customer records.

Keys A key is a field or combination of fields within a record that is used as a
basis by which to store, retrieve, and sort records. Typically, the value of the key
field is unique for each record so a particular record can be located quickly.

For instance, to locate a particular customer in the customer name and address
table, you could search the table alphabetically using the customer name column. In
this case, the customer name field is used as the key.

The following example shows how a database application could store information
for customer records in a table:

Customer ID Customer
Name

Address City State

Table

C1002

C1392

C4432

C4499

Jean
Thompson

P.O. Box 8392
82 101 Ave.

Kansas
City

MO

Serge
Lemieux

11 Ash Lane Edmonton AB

ND

IL

Fargo

Springfield

239 Hampton
Village

Dan Smith

Cheryl Miner 9800 Woodland
Drive

Customer ID Customer
Name

Address City State

Key

Customer ID Customer
Name

Address City State

Table

C1002

C1392

C4432

C4499

Jean
Thompson

P.O. Box 8392
82 101 Ave.

Kansas
City

MO

Serge
Lemieux

11 Ash Lane Edmonton AB

ND

IL

Fargo

Springfield

239 Hampton
Village

Dan Smith

Cheryl Miner 9800 Woodland
Drive

Record

Customer

Fields

Key 1

Key 2
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This table has five fields: Customer ID, Customer Name, Address, City, and State. It
also has four records, each containing one Customer ID, Customer Name, Address,
City, and State field. The table has two keys. The first key is composed of the
Customer ID field. Because no two customers can have the same Customer ID, this
key ensures each customer is uniquely identified. The second key is composed of
the Customer Name field. This key allows a customer record to be easily located,
based upon the customer’s name.

Table Groups A table group is a group of logically-related tables. For example, a
customer master table, a customer address table, and a customer history table all
compose a table group. Every table in Microsoft Dynamics GP is part of a table
group.

Table names

You can use the Table 
Descriptions window 
to find the names of 
tables.

Each table has three names: a display name, a technical name, and a physical name.

Display name The display name is the name you see in a window, such as
Rebuild or Pathnames. 

Technical name The technical name is used internally to refer to the table.

Physical name The physical name is the name under which the table is stored
by the operating system or database. 

The following table lists three names for one of the tables that stores account
category information.

Table types

To work with the Microsoft Dynamics GP database, you need to know some specific
information about tables in the database. Most of the information you’ll need to
access when creating reports will be stored in one of the following types of tables.
Knowing which type of table contains the information you want will help you find
the data you need.

Setup tables contain all the default settings and module options you’ve specified
in the setup windows for each series.

Master tables contain all the permanent data about your business. These may
include information about accounts, vendors, customers, items, and so on.

Work tables contain unposted batches of transactions entered using transaction
windows in the system. These transactions are temporary and can be changed or
deleted until they are posted to an open table.

Open tables contain posted transactions for the current year, of which some may
be unpaid. Information in open tables is moved to history tables when the
transactions are paid.

History tables contain paid transactions, or transactions from a previous year.

Display name: Account Category Master

Technical name: GL_Account_Category_MSTR

Physical name: GL00102
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Table groups

To create a report, you need to decide which tables data will come from. If all the
data for your report is stored in a single table, you can select the table as the main
table for the report and begin creating your report.

If a single table doesn’t contain all the data you need for your report, you must
choose one table as the primary table, and then link additional tables to it. You can
select either the table that contains the majority of the fields for your report or the
table that contains the most general information as your main table. Once you’ve
selected a main table, link other tables to that table as needed.

A table group is a group of logically-related tables. For example, a customer master
table, a customer address table, and a customer history table all compose a table
group. Every table in Microsoft Dynamics GP is part of a table group. Often, the
data for a report will come from the tables in a table group.

The table types described in Table types on page 71 – setup, master, work, open and
history – are actually table groups. These table groups are actually composed of
information stored in several separate tables. For example, the General Ledger
Transaction Work Table is a table group, made up of the following tables: 

• Transaction Work (GL_TRX_HDR_WORK)
• Transaction Amounts Work (GL_TRX_LINE_WORK) 
• Transaction Clearing Amounts Work (GL_TRX_Clearing_WORK)
• Audit Trail Code Temporary (GL_Audit_Trail_WORK)

Technical table names are shown above in parentheses. General information about
each transaction, such as the audit trail code and date, are stored in the Transaction
Work (GL_TRX_HDR_WORK) table, and transaction amounts are stored in the
Transaction Amounts Work (GL_TRX_LINE_WORK) or Transaction Clearing
Amounts Work (GL_TRX_Clearing_WORK) table, depending upon whether you’ve
entered a standard transaction or a clearing transaction.

In some cases, a table group will contain only one table. For many system tables, the
table group is made up of a single table with the same name as the table group.

You can use the Software Development Kit (SDK) to find additional information about
tables in Microsoft Dynamics GP.

Transaction
Work
table

Transaction
Amounts

Work
table

Transaction
Clearing
Amounts

Work
table

Transaction Work table group

Audit
Trail

Code
Temporary

table
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Chapter 12: Table Relationships
Table relationships allow the Report Writer to gather data from related tables and
use the data in a single report. Information about table relationships is divided into
the following sections:

• Table relationship overview
• Types of table relationships
• Defining a table relationship

Table relationship overview

You can define a relationship between two tables if any of the fields in one of the
secondary table’s keys are also present in the primary table. The fields the
relationship can be based on don’t need to be part of a key in the primary table, nor
do they have to use the same global field. However, they must be based on
compatible data types.

For example, a relationship could be defined between the Sales table and the
Customer List table, based upon the Buyer Name field in the Sales table and the
Customer Name field in the Customer List table.

If a report you’re creating needs information from multiple tables, table
relationships must exist that indicate how the data in each table relates to data in the
other tables. The most-common table relationships have already been set up in
Microsoft Dynamics GP. If a table relationship hasn’t been defined for the table you
need to access, you will need to create one using the information provided here.

Types of table relationships

Table relationships can be categorized as one-to-one or one-to-many relationships. A
one-to-one relationship means that for every record in the primary table, there is at
most one and only one corresponding record in the secondary table. A one-to-many
relationship means that for every record in the primary table, there can be any
number of records in the secondary table.

The following illustration shows the differences between one-to-one and one-to-
many relationships.

StateCityCust_ID

0001

0002

0003

Valhalla

Indianapolis

Phoenix

NY

IN

AZ

NameCust_ID

0001

0002

0003

Greg Wilson

Pam Anderson

Jose Martin

NameCust_ID

0001

0002

0003

Greg Wilson

Pam Anderson

Jose Martin

Invoice_TotalCust_IDInvoice_ID

31-1964

65-1296

77-4538

0001

0003

0001

223.75

658.20

439.50

Customer_Master Customer_Info

Customer_Master Invoice_Data

one-to-one
relationship

one-to-many
relationship
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The Customer_Master table is the primary table in both examples. In the one-to-one
relationship, there can be only one record in both the Customer_Master and
Customer_Info tables with the Cust_ID 0001. In the one-to-many relationship, there
can be only one record in the Customer_Master table with the Cust_ID 0001, but
there can be multiple invoices associated with that Cust_ID in the Invoice_Data
table.

You do not need to specify the type of relationship when you use the Table
Relationship Definition window to define a relationship between two tables. The
Report Writer automatically chooses the appropriate type of relationship based
upon the fields you use to link the tables. It is still important to understand
relationship types because the type of relationship between tables will affect the
type and quantity of data that you can use in your report.

Defining a table relationship

To access the Table Definition window, choose Tables from the Tables button on the
toolbar. The Tables window will open. Select the name of the table you wish to use
as the primary table, and then click Open. The Table Definition window for the
desired table will open.

Use the following procedure to access the Table Relationship Definition window
and define a new relationship. As an example, a table relationship will be created
between the Sales Transaction Work (SOP_HDR_WORK) table and the Record
Notes Master table. This table relationship allows the record-level note for an
invoice to be printed on the invoice.

1. Open the Table Relationship window.
From the table definition of the table you wish to use as the primary table, click
the Relationships button.

2. Create a new table relationship.
Click New to define a new relationship. The Table Relationship Definition
window will open, and the name of the current table will appear in the Primary
Table field.
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3. Select a secondary table.
Click the Secondary Table lookup button to open the Relationship Table Lookup
window. Select the name of the table you want to use as the secondary table. In
this example, this is the Record Notes Master table. Click OK. That table’s name
will appear at the top of the Secondary Table portion of the Relationship
scrolling window.

4. Select a secondary table key.
Choose a key containing the field or fields that you want this table relationship
to be based on from the Secondary Table Key drop-down list. Once the key is
selected, each of its key segments is listed in the Secondary Table portion of the
Relationship scrolling window.

If you are defining a one-to-many relationship, selecting a key that places records from
the secondary table in the desired order will optimize performance. 

5. Select related fields.
For at least the first of the secondary table’s key segments, select a related field
from the corresponding drop-down list in the Primary Table portion of the
Relationships scrolling window. The drop-down list contains only fields from
the primary table that have a data type compatible with the corresponding key
segment in the secondary table. For example, if the key segment is a STR30 data
type, only fields in the primary table that are compatible with the STR30 data
type will appear in the drop-down list.

Click this lookup button
to select the secondary

table.

The primary table name
automatically appears.

All fields that have a data
type compatible with the

Note Index field are
included in this list.

The Clear button removes
all selections from the
primary table section.
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If the key contains multiple segments, you don’t need to select a corresponding
primary table field for each key segment. However, the key segments for which
you do select corresponding fields must be consecutive key segments. For
example, if a key has four segments, you could select corresponding fields for
the first two segments, but not for the first and third segments only.

If the secondary table’s key upon which this relationship is based allows
duplicates, the relationship will be one-to-many, and Multiple Records will
appear in the Relationship Type field.

If the selected secondary table’s key doesn’t allow duplicates, and you select a
corresponding field for each key segment, the relationship type will be one-to-
one, and One Record will appear in the Relationship Type field. If you select a
corresponding field for only some of the key segments, the relationship type
will be one-to-many, and Multiple Records will appear in the Relationship Type
field.

To change the primary table field you’ve selected, simply choose a different
field from the drop-down list. To deselect fields you’ve selected and not replace
them with different selections, click Clear.

Clicking Clear removes all primary table field selections. 

6. Save the relationship.
When you’ve finished defining the relationship, click OK; you will be returned
to the Table Relationship window. You can define another new relationship or
edit an existing relationship. To edit an existing relationship, select the name of
the secondary table from the Table Relationships list and click Open.
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Chapter 13: Virtual Tables
Virtual tables are special types of tables that allow data stored in separate tables to
be read as if it had been stored in a single table. Information about virtual tables is
divided into the following sections:

• Virtual table overview
• Viewing virtual table information
• Using virtual tables with reports

Virtual table overview

Most reports require data to be retrieved from multiple tables. Typically, this
involves setting up table relationships between the tables and then creating the
appropriate table links for the report. For complex reports, this can be a difficult
task.

A virtual table is composed of member tables, member fields, and member keys. A
virtual table simplifies gathering data from the member tables, because it contains
the information about how the tables are linked together. The fields in the virtual
table are selected from the member tables, and typically are a subset of all the fields
available in those tables. The keys for the virtual table are selected from the primary
table’s keys.

You can’t create virtual tables with the Report Writer. They must be created by the
application developer.

Viewing virtual table information
You can use the Report Writer to view information about virtual tables in the
current dictionary. Use the following procedure to do so.

1. Open the virtual table definition.
On the Report Writer toolbar, choose Virtual Tables from the Tables menu. The
Virtual Tables window will open. Select a virtual table and click open.

2. View the list of member tables.
Select the Tables tab in the Virtual Table Definition window to view the list of
standard tables from which the virtual table is accessing data. You may find it
useful to examine virtual tables to find out where various types of information
are stored in the database.

3. View the virtual table fields.
Select the Tables tab to display a list of the fields that are included in the virtual
table. These are typically a subset of the fields in the member tables, and are the
only fields you can use from the virtual table.

4. View the virtual table keys.
Select the Keys tab to display the keys available for accessing information from
the virtual table. Only keys from the primary table can be used. Often, only a
subset of keys is made available for the virtual table.

5. View the member table relationships (optional).
Select the Relationships tab to view information about how the member tables
are related to each other. You may find this information useful if you need to
create table relationships for other tables in the application.
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Using virtual tables with reports

Creating a report can be much simpler when the main table for the report is a virtual
table. Because all of the data from the member tables is managed by the virtual
table, you don’t need to create the relationships in the Report Writer.

When you specify the primary table for a report, any virtual tables that exist for the
application will be included in the list of available tables. They are indistinguishable
from standard tables, so you can use them the same way you would use standard
tables. If necessary, you can create a table relationship that links an existing
standard table to a virtual table defined in the dictionary.
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Part 4: Modifying Reports
This portion of the documentation contains information about how to make
modifications to existing reports in the accounting system. The following topics are
discussed:

• Chapter 14, “Selecting a Report to Modify,” explains how to select and create a
modified report.

• Chapter 15, “Viewing a Modified Report,” describes how to view a report after
you have made modifications to it.

• Chapter 16, “Common Modifications,” describes modifications that are com-
monly made to reports. It also describes the Reports Library, where you can
download reports that have already had common modifications applied.
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Chapter 14: Selecting a Report to Modify
Much of the work you do with the Report Writer will be modifying existing reports
in the accounting system to better meet the needs of your business. Before you can
make modifications, you must first locate the report you want to modify.
Information about selecting reports to modify is divided into the following sections:

• Finding a report name
• Creating a modified report
• Modifying the current report

Finding a report name

To modify a report, you need to know its name. When you print a report to the
screen, the name of the report appears in the Screen Output window, as shown in
the following illustration.

In this example, the report name is “SOP Blank Back Order Form”.

Creating a modified report

Once you know the name of the report you want to modify, start the Report Writer.
Perform the following steps to create a modified version of the report.

1. Open the Report Writer window.
Click the Reports button on the toolbar to open the Report Writer window.

2. Locate the name of the report to modify.
In the Original Reports list, locate the name of the report you want to modify.
Select the name in the list.

3. Create the modified report.
Click Insert. The report will be added to the list of modified reports. You can
then begin making modifications.

A copy of the report you selected to modify was added to the Reports dictionary,
allowing you to make modifications to it. In Part 8, Storing and Accessing Reports,
you will learn more about how modified reports are stored and accessed.

Note the window title.
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Modifying the current report

If you are viewing the Screen Output window for the report you want to modify,
you can point to Customize in the Tools menu and choose Modify Current Report.
The Report Writer will start, the report will be added to the list of modified reports,
and the layout for the report will be displayed.

You can also click the Modify button to open the current report in the Report Writer.

Choose Modify Current
Report to create a

modified version of the
report being displayed.

Click the Modify button
to open the report in the
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Chapter 15: Viewing a Modified Report
After you have made modifications to a report, you will want to print the report to
verify its appearance. How the data for the report is generated determines how you
can display the report. Most reports read data directly from tables in the database
for the accounting system. However, some reports retrieve their data from special
“temporary” tables that are created by the accounting system. Reports that read
data directly from tables in the database can be viewed and printed from within the
Report Writer. Reports that use temporary tables cannot, because the Report Writer
has no way to add data to temporary tables.

Information is divided into the following sections:

• Viewing from the Report Writer
• Viewing from the application

Viewing from the Report Writer

If the report you modified doesn’t use any temporary tables, you can view it from
within the Report Writer. Use the following procedure to view the report.

1. Select the report.
In the Report Writer window, select the modified report in the Modified Reports
list.

2. Print the report.
Click Print in the Report Writer window to print the selected report. You will be
asked whether to print the report to the screen or to a printer. Make a selection
and click OK.

If you have selected the modified report, but the Print button is disabled, the report
uses temporary tables. This means you can’t print the report from within the Report
Writer, and must return to the accounting system to print the report. This is
described in Viewing from the application.

Select a modified report, and then click
Print. If the Print button is disabled, the

report cannot be printed from within
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Reports printed from within the Report Writer may not have exactly the same
appearance they would printed from the accounting system. Some of the
differences when reports are printed from the Report Writer include:

• No legend values will be included on the report, because these must be passed
in by the application.

• No additional restrictions will be applied to the report.

• Records included on the report may be sorted in a different order.

Viewing from the application

If you want to view a modified report from within the application, you must use the
Alternate/Modified Forms and Reports window in Microsoft Dynamics GP to grant
access. To open this window, choose Microsoft Dynamics GP menu >> Tools >>
Setup >> System >> Alternate/Modified Forms and Reports.

Complete the following procedure to specify that a modified report should be used.

1. Specify the ID.
Select the ID for the set of forms and report you are modifying. The users that
you want to view the modified version of the report must be assigned to use the
set of modified/alternate forms and reports you selected. The User Security
Setup window is used to specify the set of modified/alternate forms and
reports for each user.

2. Select the product containing the modified the report.
This is the product in which the report was originally defined.

3. Choose to display reports.
Choose Reports as the type of resource to display. The tree view will be filled
with the modified reports available.

Mark the item to use
the modified version

of the report.
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4. Locate the modified report.
Expand the nodes in the tree view to locate the report that you modified. The
reports are organized by series.

5. Choose to use the modified report.
The original and modified versions of the report will be listed. Mark the
modified version. 

If you later wanted to use the original version of the report, you would mark the original
report instead.

6. Save the changes.
Click Save to save the changes.

After you have set access to the modified report, print it as you typically would. Be
sure the user printing the report is assigned to the appropriate set of modified/
alternate forms and reports. For more information about printing reports, refer to
Part 6, Printing and Mailing Reports.
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Chapter 16: Common Modifications
Modifying existing reports is the most common task performed with the Report
Writer. This portion of the documentation describes some of the common
modifications, provides information about how to perform them, and describes
where you can access reports that have already been modified. Information is
divided into the following sections:

• Modifying the layout
• Changing the page orientation
• Adding or removing fields
• Using VBA with reports
• Reports Library

Modifying the layout

Modifying a report’s layout is the most common modification made with the Report
Writer. Report layouts are often changed to match a company standard, or to have
information print properly on preprinted forms.

You can make most layout modifications using the tools in the Toolbox and the
display options in the Drawing Options window. Both are described in Chapter 4,
“Report Layout.” 

Some reports that are included with Microsoft Dynamics GP are text reports, so
fewer tools and drawing options will be available. You can change a report to be a
graphics report, and all of the tools and drawing options will be available to modify
the layout.

Graphics reports can take longer to print than text reports, so if a report is used to print
large quantities of information, you may want to continue using a text report.

Changing the page orientation

Many reports in Microsoft Dynamics GP are designed to be printed in the landscape
orientation. However, most users choose to have their printer set to print pages in
the portrait orientation. You can modify a report definition to always use a specific
page orientation, regardless of the setting on the workstation from which the report
is being printed.

Adding or removing fields

The reports provided with Microsoft Dynamics GP contain the fields that are
required for a typical user. However, some reports may contain fields that aren’t
required by a specific user. Still other reports may not include information that
would be beneficial for your organization.

You can specify the page
orientation for a report in

the Report Definition
window
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Adding fields
If the tables that contain the necessary fields are already part of the report, adding
fields to the report layout is as simple as dragging them from the Toolbox to the
Layout window. Just select the appropriate table in the Toolbox and drag the fields
to the appropriate section of the report layout.

If the necessary tables aren’t linked to the tables already used for report, you will
need to link them. Linking tables is described in Creating a new report definition on
page 15. If the appropriate table relationships aren’t set up between the tables you
need to link to your report, you will need to create the relationships. This is
described in Chapter 12, “Table Relationships.”

The Knowledge Base at https://mbs.microsoft.com/CustomerSource contains several
entries that describe how to add specific fields to common reports.

Removing fields
If a report contains fields you don’t need, you may want to remove them from the
report layout. To ensure that the report continues to work properly, we recommend
that you don’t remove fields from the report. Rather, we suggest that you set the
Field Options for the report to make the field invisible.

Using VBA with reports

If you have installed the Modifier with VBA (Visual Basic for Applications), you can
add VBA code to reports to further customize them. Common customizations
include:

• Performing special calculations on report data

• Applying additional restrictions for the report

• Exporting data from the accounting system to external data sources

Refer to the VBA Developer’s Guide for complete information about using VBA
with the Report Writer.

Rather than remove a
report field, set the option
to make the field invisible.

https://mbs.microsoft.com/CustomerSource
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Reports Library

The Reports Library is a special area of the Microsoft Dynamics web site that
contains reports which have already had common modifications made to them.
Most of the reports available are graphic reports. You can access the Reports Library
at the following address:

https://mbs.microsoft.com/customersource/support/downloads/reportslibrary/

Browse the Reports library and download the reports you want. Most of the reports
in the Reports Library are modified versions of existing reports. To install a report
from a package file, follow the procedure described in Importing a package file on
page 148. After you have used the Customization Maintenance window to install
the reports, use the Alternate/Modified Forms and Reports window to provide
access to them. Setting security for modified reports is described in Chapter 31,
“Accessing Reports.” 

https://mbs.microsoft.com/customersource/support/downloads/reportslibrary/


90 U S E R ’ S G U I D E



P
A

R
T

 5
: G

LO
B

A
L M

O
D

IFIC
A

T
IO

N
S



92 U S E R ’ S G U I D E

Part 5: Global Modifications
The Report Writer also allows you to make changes that will affect all of the reports
in an application. This portion of the documentation provides detailed information
about the various global resources you can modify in Microsoft Dynamics GP. The
following topics are discussed:

• Chapter 17, “Data Types,” describes data types and how they control character-
istics of fields.

• Chapter 18, “Formats,” describes how formats are used to control how data
appears when printed on reports.

• Chapter 19, “Global Fields,” explains how to examine global fields in the
accounting system.

• Chapter 20, “Pictures,” describes how to use pictures on reports.

• Chapter 21, “Strings,” explains how to modify string resources in Microsoft
Dynamics GP.

• Chapter 22, “Tables,” describes how to view information about tables in the
application.
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Chapter 17: Data Types
Data type resources specify the characteristics of all fields used in an application. If
you want to change the characteristics of a field, you need to change its
corresponding data type. Keep in mind that a single data type can be used by
multiple fields. When you change the data type, you change the characteristics of all
the fields that use it. Information about data types is divided into the following
sections:

• Opening a data type
• Keyable length
• Static values
• Format

Opening a data type
To open a list of data types, click the Data Types button on the toolbar or choose
Data Types from the Resources menu. In the Data Types window, select a data type
and click Open. The Data Type Definition window will appear, as shown in the
following illustration.

The data type’s name appears at the top of the window. The Control Type field
specifies the function of the data type, indicating how it will display and store data.
The other fields in the window specify the additional characteristics of the data
type. The following sections describe the data type characteristics you can change
with the Report Writer.

Keyable length
The keyable length is the number of characters that can be displayed in a field that
uses this data type. Control types such as currency, integer, and string have a
keyable length. You can use the Report Writer to change the keyable length. For
example, you may want to increase the keyable length for the STR10_Phone data
type to allow the user to enter more digits. The following table lists control types for
which you can set the keyable length.

The control type is the
main characteristic of the

data type.

Control type Maximum keyable length

Combo box Storage Size - 1

Currency 19

Integer 5

Long integer 10

String Storage Size - 1

Text 32,000
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Static values

Certain control types allow you to specify static values for the data type. Static
values are any text or pictures associated with a data type that are displayed by a
field using that data type. For example, the text on a push button and the items in a
list box are static values. To view the static values for a data type, click the Static
Values lookup button.

The following table lists the control types that use static text values which can
appear on reports.

The Static Text Values window is used to specify the static text for drop-down lists,
list boxes, and visual switches.

To edit a static text value, select it in the Static Text Values list. Make the appropriate
changes in the New Value field, then click Replace.

Format

A format contains extra characters, spacing, and attributes that can be applied to a
data type when data is printed on a report. Refer to Chapter 18, “Formats,” for more
information.

Click this lookup button to
view the static items for

the data type.

Control type Static text used to:

Drop-down list Indicate the selections in the drop-down list.

List box Indicate the selections in the list box.

Visual switch Display two or more text values that will be displayed in 
sequence as the user clicks the visual switch.
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Chapter 18: Formats
Formats are the extra characters, spacing and attributes that can be applied to a data
type to format data when it is displayed or printed on a report. For example, a
string data type for a phone number can have a format applied to it so a field using
the data type will print a phone number as (555) 123-4567 instead of 5551234567.

Formats are stored as separate resources, but are applied to data types to help
define how information is displayed. A single format resource can be used by
several data types. Perhaps the easiest way to understand what formats are is to
view them as data “masks” that simply change the look of the information in a field
without changing the actual information itself. Information about formats is
divided into the following sections:

• Opening a format
• Formatting options
• Format string

Opening a format

To open a list of formats, choose Formats from the Resources menu. The Formats
window will appear. To create a new format, click New. To open an existing format,
select one in the list and click Open. The Format Definition window will appear, as
shown in the following illustration.

Each format has a name. Typically, the name indicates the data type the format is
applied to. For instance, the name STR_Employer_ID_Number indicates a format
that will be applied to a data type used for an Employer ID number.

Formatting options

You can use several formatting options to change how specific types of data will
appear. You can use them to specify the following characteristics:

• Align information to the left, right, or center of a field.
• Determine what characters will appear in unused parts of a field.
• Specify how you want currency fields to appear.
• Specify how numeric fields display information.

The format name is
entered here.

Options for the format are
chosen here.

Format strings are
entered here.
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The following tables describe the various formatting options:

Format string

The Format Definition window allows you to specify a format string for string and
composite data types.

String formats
Format strings are used with string data types to add static elements to a field, such
as parentheses or static text. The Report Writer uses the capital X as a placeholder to
represent alphanumeric characters that will appear in the field. All other characters
will be displayed as you type them.

Numeric formats

Decimal Digits Number of decimal places (0 to 5).

Negative Symbol The operating system setting, a minus sign, the letters CR, or 
parentheses.

Alignment Number is left-, center-, or right-aligned.

Fill Unused spaces are filled with asterisks, zeros, or spaces.

Unsigned If marked, the negative symbol won’t be displayed.

Show Thousands 
Separator

If marked, the field will show thousands separators in the number.

Show Percent Sign If marked, the field will show the percent sign.

Currency formats

Decimal Digits Number of decimal places (0 to 5).

Negative Symbol The operating system setting, a minus sign, the letters CR, or 
parentheses.

Alignment Number is left-, center-, or right-aligned.

Fill Unused spaces are filled with asterisks, zeros, or spaces.

Unsigned If marked, the negative symbol won’t be displayed.

Show Thousands 
Separator

If marked, the field will show thousands separators in the number.

Relative Decimal 
Position

If marked, the number of decimal digits selected is added to the number 
in the operating system setting. The total can be up to 5 decimal digits.

Show Currency 
Symbol

If marked, the currency symbol specified in the operating system settings 
is displayed.

String and composite formats

Alignment String is left-, center-, or right-aligned.

Fill Unused characters are filled with asterisks, zeros or spaces.

Trailing Blanks If marked, any spaces that follow the contents of the field will be saved in 
the table. If the option isn’t marked, any spaces following the item in the 
field won’t be saved. Leave unmarked to ensure that the same entry 
made with or without trailing blanks will be stored with the same value.

Leading Blanks If marked, spaces can be entered as the first characters in the field. These 
spaces will be saved in a table.

Numeric Only If marked, only numbers can be entered in the field.

Alphanumeric Only If marked, only letters and numbers can be entered in the field.

Uppercase Only If marked, all alphabetic characters will be displayed in uppercase.
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Example 1
For instance, suppose you’re using a specific data type to store information entered
in phone number fields. This Phone_Number data type uses a format and a format
string to determine how phone numbers will appear on a report:

The Xs are placeholders indicating where the digits will be displayed, while the
parentheses and dash are displayed just as you typed them. Also note that a
lowercase x is used in the “ext.” abbreviation in the second format string. Only
uppercase Xs are treated as placeholders, so the lowercase x is displayed in the field,
instead of being replaced when data is entered.

Static characters in a format string aren’t actually stored with the data in the table. This
allows you to change the format string without affecting how data is stored.

Composite formats
A format string is used with a composite data type to indicate the size and order of
the components of the composite, and to add static elements, such as parentheses or
static text. The numeric characters 1 through 9 are used to represent the characters
of each component of the composite. All other characters will be displayed just as
you type them.

Not all composites use a format string. Some composite fields, such as the Microsoft
Dynamics GP Account Number, have their format defined through program code.

Example 2
The following example shows the use of a format for a standard composite. A
composite must have a format and a format string. This composite contains three
parts, as indicated by the format string.

Note that the 1s, 2s, and 3s are used as placeholders.

Format string Data entered Data displayed

(XXX) XXX-XXXX 7015550100 (701) 555-0100

ext. XXXX 6590 ext. 6590

Format string Data entered Data displayed

1111-22-3333 1000ND5050 1000-ND-5050
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Chapter 19: Global Fields
Fields represent the individual pieces of information in an application. They can
appear in windows, be stored in tables, and appear on reports. Each field uses a
data type to specify its characteristics. Information about global fields is divided
into the following sections:

• Opening a global field
• Opening a field’s data type

Opening a global field

To open a list of global fields, click the Fields button on the toolbar or choose Fields
from the Resources menu. In the Fields window, select a global field and click Open.
The Field Definition window will appear, as shown in the following illustration.

You can also open the Global Field Definition window from the Layout window.
Choose the name of a table in the Toolbox to display the fields from that table. Select
a field name in the list and click Open.

Opening a field’s data type

When the Field Definition window is open, you can easily drill down to the data
type definition used for that field. To open the Data Type Definition window, click
Open.

Click Open to open the
data type for the global

field.



100 U S E R ’ S G U I D E



U S E R ’ S G U I D E 101

Chapter 20: Pictures
Pictures are typically used to display large graphics and logos in reports. The
Report Writer can convert Windows metafiles to a form that can be stored in the
picture library. Pictures up to 32K in size can be stored. Pictures are stored only once,
but can be placed in several reports by using the picture tool from the Toolbox in the
Layout window.

Information about pictures is divided into the following sections:

• Adding a picture to the picture library
• Using a picture from the picture library
• Guidelines for using logos

Adding a picture to the picture library
Choose Pictures from the Resources menu; the Pictures window will appear.

1. Create a new picture or edit an existing one.
Click new to create a new picture or select a picture and click Open to edit it.
The Picture Definition window will appear, as shown in the following
illustration.

2. Name the picture.
In the Picture Definition window, name the picture.

3. Add the picture.
Be sure the picture you want to add is in the Clipboard. Click in the area below
the Picture Name field to select it, and then choose Paste from the Edit menu to
paste the picture into that area.

4. Click OK to add the picture to the library.

Using a picture from the picture library
Open the layout of the report where you want to paste a picture.

1. Select the picture tool.

2. Click in the layout area where you want the picture to appear.
After you click in the layout area, the Pictures window will appear, allowing
you to select a picture to paste into the layout.

3. Select the picture to paste.
From the Pictures window, select the name of the picture to paste into the
window and click OK.

Enter the name of the
picture here.

To add a picture, click in
this area to select it, and
then choose Paste from

the Edit menu.
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4. Position and resize the picture if necessary.
Drag the picture to the appropriate location and use the resize handles to make
it the appropriate size.

You can paste a picture directly into the report layout, bypassing the step of adding
the picture to the picture library. Simply copy the picture to the Clipboard and
choose Paste from the Edit menu to paste it into a report layout. You’ll be asked to
name the picture. The picture will appear in the layout and will be added to the
picture library automatically.

Guidelines for using logos

A company logo is a common picture used on reports. Use the following guidelines
to ensure a logo has the best appearance on a report.

• In the Report Writer, the graphic will become a bitmap. To find out how the
graphic will appear when printed, try printing it from a “paint” application
such as Windows Paint.

• If you will be using a non-PostScript printer, use a black and white image. On
these printers, any non-white pixels will be printed as black.

• Make the graphic as large as possible, staying within the 32k limit. This allows
the graphic to contain maximum detail. When you add the graphic to a report,
it will be very large. Scale the graphic down to the desired size.

For example, the following illustration shows the Microsoft logo that was
added to a report in the Report Writer. The logo is black and white, and is 1580
pixels wide and 267 pixels tall. After adding the logo, it appeared at full size.

After the logo was added to the report, the resize handles on the graphic were
used to reduce the size of the illustration to 2 inches wide, or 144 pixels. This is
shown in the following illustration.

You can use the horizontal and vertical size indication in the Toolbox to
maintain the aspect ratio of the logo when you reduce its size. For example,
when the Microsoft Business Solutions logo was reduced from 1580 to 144
pixels wide, the corresponding height was reduced from 267 to 25 pixels.
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Chapter 21: Strings
A string is a sequence of up to 79 characters that doesn’t contain carriage returns.
Strings are used throughout the accounting system for window names, field
prompts, static text values, and text that appears in reports. Information about
strings is divided into the following sections:

• Using strings
• Modifying a string

Using strings

The strings resource allows you to update all occurrences of a string in one step
instead of changing the same string in each place it occurs.

For example, to change all occurrences of the words “Customer Name” to “Client
Name,” you could select the Customer Name string and change it to Client Name
instead of changing each individual text value.

Note that changing a string with the Report Writer will change it only for reports. The
string won’t be changed in any windows in the accounting system. To change strings in
windows, you must use the Modifier.

Modifying a string

Choose Strings from the Resources menu. The Strings window will open, allowing
you to select the string to edit.

The Microsoft Dynamics GP dictionary contains several thousand strings. The Strings
window may take a few moments to open.

1. Select the appropriate dictionary core.
String resources are divided into several cores, which are special divisions in
the dictionary. Microsoft Dynamics GP has a core for each major module
category. When locating a string, begin by choosing the core that the string is
most likely contained in. For example, the string “Customer” is likely part of
the Sales core, so begin looking there. If you don’t find a string in a particular
core, look in the other available cores.

2. Select the string to edit.
After you have located the string, select it in the list and click Open. The String
Definition window will appear, as shown in the following illustration.

3. Edit the string.
Edit the string in the String Definition window and click OK to save the
modified string.

Edit the string and then
click OK to save the

changes.
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Chapter 22: Tables
Tables store data generated and used by applications. Tables use several elements to
store and access information properly, such as fields, keys and table relationships.
Information about tables is divided into the following sections:

• Table elements
• Keys
• Key segments
• Key options
• Segment options

Table elements

Each table has several names, a series, database type, table fields, keys, key options,
segment options, and table relationships. Use the Table Definition window to view
information about tables.

You can also use the Resource Descriptions tool to view information about tables.

Names
Three names are required for each table. The table name is the name that is used in
scripts to refer to the table.

The display name is the name that appears when the name of the table is displayed
on the screen in an application. 

The physical name is the name under which the table is stored by the operating
system or database. The appropriate extension, if required, is added automatically.

Table series
The table series groups related tables in the application together using series
categories like Sales, Financial, and System.

Database type
Tables can use the following database types: c-tree Plus, Pervasive.SQL, and
Microsoft SQL Server. If the setting Default is used, the application will determine
which database type to use at runtime, based upon several system settings

Table fields
These are the fields that are stored in the table. The Record Size field in the Table
Definition window contains the total size of each record in the table.

Table relationships
Table relationships link related tables that share common information. Table
relationships are required to allow the Report Writer to access information from
multiple tables for a single report. Refer to Chapter 12, “Table Relationships,” for
more information about creating and using table relationships.

Keys
A key is a field or combination of fields in a table used to sort and locate specific
records in the table. Typically, the value of the key field or fields is unique for each
record in a table so a specific record can be located. You will use the keys for a table
when you specify how report information is sorted. You will also use keys when
you create table relationships to link related tables together.
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Key segments

The Key Definition window shows the fields that make up the keys used to sort,
store, and retrieve records in each table. Each field in a key is referred to as a key
segment. Each table can have multiple keys, and each key can have multiple
segments.

For example, a customer table typically would have two keys defined for it. One
key could contain the Customer Name field, because this is the field a user would
most likely use to search for a record. However, a customer name may not be
unique. For instance, there may be more than one “John Smith”. To avoid this
problem, each customer could be assigned a unique customer ID. A second key
composed of the Customer ID field could be added to the table. This key would
uniquely identify customers, even if they have the same name.

The Key Segments list displays the list of fields that will be used as segments in the
key. Records will be sorted primarily according to the first key segment. Records
that are identical for the first key segment will be sorted again by the second key
segment. For example, if the Key Segments list contains two segments:
[last_name, first_name], in that order, records will be sorted primarily by the
last name, and records with the same last name entry would be sorted again by the
first name.

Key options

The database type specified for a table determines which sets of key options are
available for each key. The following key options are important to understand in the
Report Writer:

Duplicates Specifies whether multiple records in the table can have the same key
value. If this option is marked, new records that have the same key values as
records already in the table can be saved. If the option isn’t marked, new records
with the same key values as existing records won’t be saved.

When you create a table relationship based a key that allows duplicate records, you are
creating a one-to-many relationship.

Create Index If this option for SQL tables is marked, an index in the SQL
database will be created for the table based upon this key definition. The index
contains a copy of the data in the key’s key segments and pointers to the associated
records in the table. An index allows data to be retrieved from the table more
quickly.

If Create Index is marked, the following options are available:

• Unique Marking this option ensures that the records in this table will have
unique values for this key.

• Clustered Marking this option sorts and physically stores the data in the
table according to the order defined by this key. For example, the Customer
table has a key based upon the Customer Name field. If this key was based on
the Customer Name field, and the Clustered option were marked for the key,
the data in the Customer table would be physically stored in the order indicated
by the key. Only one key per table can have the Clustered option marked. 
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Segment options

The segment options specify how the key will handle the contents of the selected
key segment.

Descending This option specifies the order in which the records will be sorted. If
the option is marked, records will be sorted in order of highest value to lowest (3, 2,
1 or c, b, a). If the option isn’t marked, records will be sorted lowest to highest (1, 2,
3 or a, b, c).

Ignore Case This option is available only if the selected segment is a string field.
The Ignore Case option specifies whether case determines how the table will be
sorted. If the option is marked, the case of the data in the key segment won’t affect
the sorting process. If the option isn’t marked, uppercase characters will have a
lower value than lowercase characters for sorting purposes. This option does not
apply for tables that use the SQL database type.

The following table shows how a set of last names would be sorted, depending
upon how the Ignore Case option is marked.

Ignore Case marked Ignore Case not marked

adams Beaulieu

Beaulieu JOHNSON

douglas Jones

hagelle Simpson

JOHNSON adams

Jones douglas

Simpson hagelle
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Part 6: Printing and Mailing Reports
Once you have created or modified reports, you can print them or mail them to
other users. The following topics are discussed:

• Chapter 23, “Printing Reports,” describes how to print modified and custom
reports.

• Chapter 24, “Mailing Reports,” describes how to mail reports you have created
to other users.

• Chapter 25, “Exporting Data,” explains how to use reports to export data to
external files for use in other applications.
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Chapter 23: Printing Reports
After you have created or modified a report, you will want to print and use the
report output. Information about printing reports is divided into the following
sections:

• Printing modified reports
• Printing custom reports
• Printing in the Report Writer

Printing modified reports

To print modified reports from the accounting system, you need to set appropriate
access to them with system security. This is described in Accessing modified reports on
page 142. After you have set appropriate access to the report, complete the
following procedure to print the report:

1. Open a Reports window.
Most reports are accessed from the Reports menu, that appears in the Microsoft
Dynamics GP main menu. These same reports can also be accessed from the
Reports section of each Area page. Choose a report from the menu or from an
Area page. The Sales Setup Reports window is shown in the following
illustration.

Refer to the documentation for each module for detailed information about printing
specific reports.

2. Select the report to print.
In the Reports window, select report you want to print from the drop-down list.

3. Specify the report option to use.
Choose an existing report option in the Options list, or click New to create a
new report option. The report option specifies characteristics of how the report
will be printed, such as sorting and restrictions.

4. Set the characteristics of the report option (optional).
If you want to change the characteristics of how the report is printed, such as
sorting, restrictions, and output destination, click Modify to modify the report
options.

Refer to the online help for each report options window for more information about
setting options for a specific report.



P A R T  6 P R I N T I N G  A N D  M A I L I N G  R E P O R T S

112 U S E R ’ S G U I D E

5. Add the report to the list of reports to print.
With the report option selected, click Insert to add the report to the Print List.

6. Print the report.
Click Print to print the reports in the Print List.

Printing custom reports

Custom reports are those that you created from scratch in the Report Writer, or
those that you created based on a copy of an existing report. To print custom reports
from the accounting system, you need to set appropriate access to them with system
security. This is described in Accessing custom reports on page 143.

You can print custom reports from two places within Microsoft Dynamics GP. The
first is the Custom Report List, which is accessed from the Administration group in
the Navigation Pane. This report list will contain all of the custom reports the
current user has been granted access to. The second location is the Custom Reports
window. To print custom reports through this window, complete the following
procedure.

1. Open the Custom Reports window.
In Microsoft Dynamics GP, choose Administration >> Reports >> Customized.

The Custom Reports window will be displayed.

2. Select a product and series.
Select the product and series that contain the reports you want to print. The
custom reports in the specified product and series will appear in the Custom
Reports list.

3. Select the reports to print.
In the Custom Reports list, select the reports you want to print and click Insert
to add the report to the Print List. If you want to print reports from another
series, select the series and add additional reports.

4. Specify a destination for each report.
Select each report in the Print List and click Destination. In the Report
Destination window, specify whether you want to send the report to the screen,
the printer, or a file.
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5. Print the reports.
Click Print to print all of the reports in the Print List to their specified
destinations.

Printing in the Report Writer

Printing reports from within the Report Writer is useful when you’re modifying
reports or creating your own new reports. You can verify changes you’ve made
quickly.

Report security
To be able to print a report from within the Report Writer, you must have been
granted access to the report. This includes any custom reports the user has created.
If access isn’t granted, the user will encounter a “privilege” error when they try to
display the report. Refer to Accessing modified reports on page 142 and Accessing
custom reports on page 143 for details about granting access to reports.

If a user will be creating or modifying numerous reports in the Report Writer, you may want
to assign the user the POWERUSER security role. This role grants them access to all of the
custom reports they are creating.

Temporary tables
Most reports read data directly from tables in the database for the accounting
system. However, some reports retrieve their data from special “temporary” tables
that are created by the accounting system. Reports that read data directly from
tables in the database can be viewed and printed from within the Report Writer.
Reports that use temporary tables cannot, because the Report Writer has no way to
add data to temporary tables.

If you have selected the modified report in the Report Writer window, but the Print
button is disabled, the report uses temporary tables. This means you can’t print the
report from within the Report Writer, and must return to the accounting system to
print the report.

Report differences
Reports printed from within the Report Writer may not have exactly the same
appearance they would printed from the accounting system. Some of the
differences when reports are printed from the Report Writer include:

• No legend values will be included on the report, because these must be passed
in by the application.

• No additional restrictions will be applied to the report.

• Records included on the report may be sorted in a different order.
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Chapter 24: Mailing Reports
You can send reports generated in Microsoft Dynamics GP to others as e-mail
attachments. Information about mailing reports is divided into the following
sections:

• Mail connectivity
• Attachment types
• Mailing a report

Mail connectivity

The Report Writer allows you to mail reports using standard e-mail applications.
Microsoft Dynamics GP supports Microsoft’s Mail Application Program Interface
(MAPI), which allows you to send mail to other users with a MAPI mailbox.
Microsoft Dynamics GP also supports connecting to a mail server through
Exchange Web Services. If your workstation has a MAPI-enabled e-mail client, or
you have configured the Microsoft Dynamics GP connection to Exchange Web
Services, then you can mail reports from the Screen Output window.

Attachment types

Reports you send as e-mail attachments can be in text format or PDF (Portable
Document Format) format.

Text format
All reports can be mailed as a text attachment. The text representation of the report
generated by the Report Writer will match the report layout as closely as possible.
However, complex report layouts may not have an ideal appearance. If you want to
use the text attachment for reports you e-mail, we suggest making a modified or
custom report that is simplified and designed to be represented with text.

PDF format
If you have the PDFWriter printer driver installed (included with Adobe Acrobat 5
and earlier), or Acrobat Distiller from Acrobat 6 or later, you can also mail the report
as a PDF attachment. Information about Adobe Acrobat is available at
www.adobe.com. PDF provides a very accurate representation of the report, and
works well for graphics reports.

Mailing a report

To mail a report to another user, complete the following procedure:

1. Print the report to the screen.
Print the report as you normally would, but be sure to select the Screen option
in the Report Destination window when you print a report. The Screen Output
window will appear. If mail can be sent from the user’s workstation, the Send
To button drop list will be enabled.

2. Choose to e-mail the report.
In the Send To button drop list, select the attachment type you want to use. Text
format will always be available. If you have the PDFWriter or Acrobat Distiller
installed, PDF format will also be enabled.
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3. Address and send the message.
The report will have been attached to a new mail message. Address the message
and send the report.

If you chose a text attachment, the report will be sent with a .TXT extension. The
user receiving the report can use the application that’s associated with this
extension to view the file. If you chose a PDF attachment, the report can be read
with Adobe’s Acrobat Reader.
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Chapter 25: Exporting Data
The Report Writer can be a useful tool for exporting data from the accounting
system to external files that can be used in other applications. For example, a list of
customer names and addresses could be exported to a file for use with word
processing software as a mailing list. Information about exporting data is divided
into the following sections:

• Export formats
• Creating reports for exporting

Export formats

The following export formats are available from the Report Writer: 

Creating reports for exporting

If you will be using reports to export data to a tab-delimited or comma-delimited
files, you must place fields in the report layout in a special way so the export file has
the proper format. The fields to export must be placed in the body of the report, in
the order they are to appear in the export file. The following illustration shows the
layout of a report to export customer information. Notice that the report contains
only the Body section.

You must also add the ExportOneLineBody=TRUE setting to the defaults file. This
setting causes the items in the report body to be exported to a single line in the
export file. The following illustration shows the output file when the report above is
exported to a comma-delimited file.

Format Description

Text file The report will be saved as text without any formatting. This option 
should be used when the application to which you’re converting the 
document is unable to read any of the other file formats.

Tab-delimited This is the tab-separated ASCII character format used by programs 
such as Microsoft Excel®.

Comma-delimited This is the standard comma-separated ASCII character format often 
used by database programs.

HTML The report will be saved in HTML format to be viewed in a web 
browser.

PDF File This format is available if you have the Acrobat PDFWriter print 
driver or Acrobat Distiller installed. PDF (Portable Document Format) 
files can be read using the Acrobat Reader software available from 
Adobe.

Place the fields in the
order you want them

listed in the export file.
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Part 7: Report Design
Good report design has several benefits such as making reports generate more
quickly, and making them more useful for the intended audience. The following
topics are discussed:

• Chapter 26, “Report Design Guidelines,” provides a set of guidelines to keep in
mind as you create reports.

• Chapter 27, “Preprinted Forms,” explains how to design reports to work with
preprinted forms.

• Chapter 28, “Groups,” describes how to use groups on your reports to organize
information.

• Chapter 29, “Checks, Invoices, and Labels,” describes special design consider-
ations when creating or modifying these types of reports.
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Chapter 26: Report Design Guidelines
This portion of the documentation contains information about designing reports to
improve their utility and optimize their performance. Information is divided into
the following sections:

• Report design
• Optimizing reports

Report design

A report is a tool that turns data into useful information. Careful design can greatly
improve the utility of the reports you create. Keep the following guidelines in mind
when creating reports.

Purpose
Before you begin creating a report, clearly state what the purpose of the report is.
State who will use the report and what they will use the report for. This will help
you determine what information is needed for the report, and which tables the
information will come from. This process can also provide an early indication that a
report is becoming too complex, or is trying to meet several needs that would be
better met by separate reports.

Name
The report’s name is the primary way that users will be able to find the report. Be
sure the name is descriptive, and that the report is assigned to a an appropriate
series in the accounting system.

Layout and organization
Before opening the Report Layout window, it’s often useful to sketch the layout of a
report on paper. You will be able to see the sections of the report, what information
should appear in the headers, what summary information you want to include in
the footers, and so on. You can also determine what calculations need to be
performed with calculated fields. This can save a lot of time when actually creating
the layout. It can also prevent cluttering the report with unnecessary fields.

Remember some basics when creating the layout for a report:

• Include page numbers and the current date on your report.

• Determine whether the report should be printed in portrait or landscape mode,
and be consistent with the layout.

• If your report contains columns of information, be sure the data is properly
aligned under the column headings.

• Consider leaving enough room in the margin so the report can be bound.
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Fonts and graphics
A report is a printed document, so the principles of good page design apply to
reports as well:

• Limit the number of fonts used for the report. Though you can use any fonts
installed on the current workstation, it’s best to limit the number of fonts used
to two.

• Use common fonts. If you will be distributing reports to other users, remember
that they may not have the same set of fonts installed that you did when you
created the report. If a font isn’t available, one will be substituted, but the report
may not have the appearance you intended.

• Graphic elements, such as lines and boxes, can help group the items in a report
and make it easier to read.

• If you will be including company logos or other graphics in your reports, be
sure they look good and don’t detract from the appearance of the report. Refer
to Guidelines for using logos on page 102 for information about enhancing the
appearance of graphics in your reports.

Optimizing reports

How you design and set up a report can directly impact the performance of the
report as it’s printed. Use the following guidelines to optimize the reports you
create.

Use text reports
Use text reports when you want maximum performance printing reports. Text
reports are simpler than graphics reports, so they print much faster. The Report
Writer has also been optimized for maximum performance when printing text
reports.

Page layout
An efficient page layout can improve performance by reducing the total number of
pages used to print the report. Don’t use a landscape layout unless the information
on the report requires the wider format. Using columns can also increase the
amount of information on a page.

Keys and sorting order
When sorting the report, always try to use an existing key for the primary table
used on the report. It takes longer to generate a report when a separate sorting order
is used.
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Chapter 27: Preprinted Forms
You may have existing forms that are already printed, but that you would like to
have filled out by the Report Writer. These are typically referred to as preprinted
forms. The most common preprinted forms are checks and invoices, which are
described in Chapter 29, “Checks, Invoices, and Labels.” Information about setting
up your own preprinted forms is divided into the following sections:

• Report definition settings
• Report layout
• Printing preprinted reports

Report definition settings

Several settings are available for a report definition to allow using preprinted forms
with the Report Writer. The following settings apply to preprinted forms:

Preprinted Form This setting allows you to remove the built-in margin from the
report layout, so you can print fields as close to the edge of the form you’re using as
your printer permits. When this setting is marked, items are printed on paper
exactly where you placed them in the layout.

Six Lines Per Inch This setting allows you to specify that exactly six lines of text
will be printed in each inch of space on a text report. Many preprinted forms are
based on six lines per inch, so this makes it simpler to match the report layout to the
preprinted form.

This setting also prevents fonts from becoming too small when printed in
compressed text. The font will shrink in width so that each line of the report will fit
in the space available, but doesn’t shrink in height so that more than six lines of text
will be printed in an inch.

First Page Header and Last Page Footer  These settings typically should be
unmarked when you are using preprinted forms.

Report layout

Careful planning is required when creating a report layout for use with a preprinted
form. The following hints that can help ensure success.

Page size
Keep in mind the total size of the page when you’re creating the layout for a
preprinted form. A report layout is based on 72 points per inch, and each pixel on
the report layout represents one point. If you are developing a preprinted report for
standard US Letter size page, the total size for each page of the report must be 612
by 792 points (8.5 inches by 11 inches). 

Remember that there are no built-in margins for a preprinted report, so you must account for
any margins you need for your report.

To determine the total size for each page of a report, add up the sizes of each section
of the report. You can find the height of a report section by clicking the handle for
the section in the Report Layout window, and viewing the section size at the bottom
of the Toolbox.
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If the total size of a page for a report is larger than the maximum page size, extra
pages will be generated when the report is printed. If a page only slightly exceeds
the maximum size, an extra blank page may appear in the printed output. If the
total size of a page for a report is smaller than the maximum page size, the report
may “creep” as it is printed. When a report creeps, information on subsequent
pages of the report will tend to move up as pages are printed.

Report sections
If the report for a preprinted form contains additional headers and footers, it’s
important to know exactly when these headers and footers will be printed. If an
additional header or additional footer is printed at an unexpected time, your report
may print extra pages or exhibit page creep. If this occurs, check each section of the
report to verify that they are printed when expected.

You can use the Records Per Report Body setting in the Header Options or Footer
Options for a section to specify the total number of times the additional header or
footer will appear for each report body printed. This setting limits the number of
times a report section can print on a specific page, and will also fill the page with the
appropriate number of empty sections to reach the number specified. This setting is
useful for reports that contain a fixed number of line items, such as invoices.

Special characters
For some preprinted reports, you may want to print special characters such as Xs.
To do this, you will need to create calculated fields that will print the appropriate
characters, based on field values for the report. Refer to Chapter 7, “Calculated
Fields,” for more information about creating calculated fields.

Printing preprinted reports

When creating preprinted reports, you need to account for the unique margin
characteristics of individual printers. The Report Writer has a provision for
adjusting the horizontal and vertical offset of preprinted reports when they are
printed. These offset values appear in the Print dialog displayed when you print a
report.
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The horizontal and vertical alignment settings apply only to reports that have the
Preprinted option marked in the report definition. Other reports aren’t affected by
these settings.

A separate set of alignment settings for each printer you access is saved in the
DEX.INI file on each workstation, so you don’t need to type in the alignment
settings each time you print a preprinted report. Because all preprinted reports will
use the same alignment settings for the selected printer, it’s a good idea to use
consistent left and top margins for all of the preprinted reports you create. That way,
users won’t have to change the alignment settings depending on the report being
printed.



126 U S E R ’ S G U I D E



U S E R ’ S G U I D E 127

Chapter 28: Groups
One way a report can transform data into useful information is by grouping it into
meaningful categories. For example, customer classes, credit limits, or transaction
amounts are just some of the ways you could group information. Information about
groups is divided into the following sections:

• Group overview
• Sorting for groups
• Group headers
• Group footers
• Counting items in a group
• Counting groups
• Totaling and subtotaling
• Advanced groups

Group overview

To group information on a report, you will do the following:

• Determine the items to appear in the group. Determine which table or tables
contain the information you want to appear in the group. List the fields that you
want to appear in the group, and the fields that will used to determine the
members of each group.

• Sort the report data in an order appropriate for creating the group. You need to
sort the data for the report so that the report items appear in an order that
allows them to be grouped.

• Create additional headers for each group category. Additional headers for the
report will contain the information that describes each group.

• Create additional footers to summarize the group information. Additional foot-
ers for the report can perform summary actions such as totaling or subtotaling
for each group.

Sorting for groups

To create groups for a report, the information in the report must be sorted in a way
that allows the groups to be formed. This means the information for the report must
be sorted first by the primary field that identifies each group, then by the items in
the group. For example, if you are creating a report that groups customers by state
or province, the report must first be sorted by the State field, and then by the
Customer Name.

To group the report by State
or Province, the data for the
report must be sorted based

on the State field.
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For optimal performance when printing the report, you should use an existing key
from the primary table to specify how the data for the report is sorted. However,
when you are creating groups for a report, there often isn’t a key available for the
primary table that sorts the data appropriately. This is especially true when you
want to create groups based on data in secondary tables for the report. In this case,
you must create a sort order to indicate how to sort the data for the report. This is
described in Chapter 5, “Sorting.”

Group headers

To add header information to a group, create an additional header for the report.
Refer to Chapter 8, “Additional Headers and Footers,” for more information about
creating additional headers. The additional header contains the field or fields that
each group is based on, and will be printed once for each group on the report. It also
typically contains descriptive column headers for the information that appears in
each group.

For example, the following illustration shows the layout for the User Classes report.
Notice that user information is grouped according to the User Class, and then
Account Access, and so on. An additional header is used for each group category
for the report.

Group footers

Use footers for groups to add summary information for the group, such as totals,
subtotals, or average values. To add footer information to a group, create an
additional footer for the report. Refer to Chapter 8, “Additional Headers and
Footers,” for more information about creating additional footers.

Any additional footers for a group should typically “break” on the same field as any
additional headers for the group. This keeps the headers and footers with the
group, and allows the items in the group to be counted.

When you add a field to an additional footer, it is automatically assigned the Last
Occurrence display type. If you don’t use the Last Occurrence display type, the field
will appear to be looking ahead to the next record for the report. This occurs
because the next record for the report has already been read to determine whether a
group should be considered complete.

If you place calculated fields in footers, you change their display type from Last
Occurrence to Data, so that the calculations are performed properly.
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Counting items in a group

It’s often useful to count the number of items that appear in each group on a report.
Counting the items in a group is done in an additional footer for the group. The
additional footer should be set up to print each time the main category for the group
changes. Place the field for the item you want to count in the additional footer and
set the field’s type to Count. 

For example, the Customers by State report lists all of the customers by each state.
To count the number of customers in each state, an additional footer is added that is
printed each time the State changes. A field that occurs for each customer, such as
the Customer Name is added to the additional footer, and the display type is set to
Count.

Counting groups

If you have several groups on a report, you may find it useful to count the
individual types of groups. To count the number of groups in a report, you need to
use a Control Count field.

A Control Count field is designed to count the number of times an additional footer
appears in a report. This means that the group you are counting must have an
additional footer that indicates the end of the group. Next, create an additional
footer immediately below the additional footer that indicates the end of the group.
This additional footer must contain an instance of the field on which the group you
are counting is based, and you must set the field’s type to Control Count.

For example, the Customers by City and State report groups all of the customers by
State, and then further groups them by City. To count the number of cities in each
state, an additional footer is used that appears at the end of each City group.
Another additional footer is added that will contain the City field, but with the
display type set to Control Count. This field will count the number of times the
additional footer at the end of the City group appears, which is the same as the
number of cities for each state.

This additional footer is printed
each time the State field changes.
The Customer Name display type

is set to Count to count the
number of customers per state.
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The field to which you apply the Control Count display type must be the same field that the
footer immediately above the footer containing the Control Count field breaks on.

Totaling and subtotaling

Another way to extract useful information from a report is by totaling or subtotaling
numeric values. You do this by adding fields that have the Sum or Running Sum
display type applied.

Sum fields
Fields with the Sum display type print the total of the field’s values within a group,
or within the entire report. If you add a Sum field to an additional footer for a
group, it will total the items for the group. Adding Sum fields to the report footer
will total all values for the entire report.

Running sum fields
Fields with the Running Sum display type print the total of the field’s values at the
point where they are placed in the entire report. They are often placed in additional
footers that occur throughout a report, or in the page footer to allow running sum
values to appear on each page.

Advanced groups

Some groups for reports may be too complex to be implemented with the basic
additional header and additional footer capabilities of the Report Writer. If you
have the Modifier with VBA, you can use VBA (Visual Basic for Applications) code
to further control when additional headers and footers appear in a report. Refer to
the VBA Developer’s Guide for more information about using VBA with the Report
Writer.

The report is grouped by
State, and then by City.

This additional footer is at
the end of each City group.

This display type is set to
Control Count, to count the

number of City groups.
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Chapter 29: Checks, Invoices, and Labels
Checks, invoices, and labels are common reports that have layouts that require
modifications with the Report Writer. This portion of the documentation describes
the design of these reports and provides information about how the design affects
the modifications you can make. Information is divided into the following sections:

• Checks
• Invoices
• Labels

Checks

Depending on the design of the checks you are using, the check layout can be
simple, or very complex. A basic check layout doesn’t have a check stub, or has the
check stub either above or below the check. A complex check layout has a check
stub both above and below the check.

Check types
Microsoft Dynamics GP has separate check layouts for Payables Management and
for Payroll. For Payables Management, the following table lists the check formats
that are available, along with the corresponding report used for the check.

For Payroll, the following table lists the check formats that are available, along with
the corresponding report used for the check.

Check Format Report

No Stub Check With No Stub

Stub on Top Check With Stub on Top

Stub on Bottom Check With Stub on Bottom

Stub Top/Bottom - Text Check With Stub on Top and Bottom - Text

Stub Top/Bottom - Graphical Check With Stub on Top and Bottom - Graphical

3 per Page/No Stub 3 Per Page/No Stub

User-Defined Check 1 User-Defined Check 1

User-Defined Check 2 User-Defined Check 2

Check Format Report

Stub on Top - Continuous Employee Checks Stub on Top-D

Stub on Bottom - Continuous Employee Checks Stub on Bottom-D

Stub on Top and Bottom - Single Feed Employee Checks Stub on Top and Bottom-L

Other - Continuous Employee Checks Other-D

Other - Single Feed Employee Checks Other-L
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Modifying check layouts
It’s likely that you will need to modify the check layout to work properly with your
check stock. Keep the following in mind when modifying check layouts:

• Avoid editing the layout for any “Stub on Top and Bottom” check. The layout
for these checks is hard-coded to the software, which prevents most
modifications from working properly. You can make some cosmetic
modifications to these check layouts, such as adding graphics or text.

• Consider modifying the “User-Defined” or “Other” check layouts. These
reports are designed to be customized. For Payables Management checks, the
User-Defined Check 1 report is a stub on top layout. The User-Defined Check 2
report is a stub on bottom layout.

• When modifying checks, don’t move fields from one section of a report to
another. This can cause the checks to not print properly.

• Don’t remove fields from the check layout. When you’re modifying checks, use
the Report Field Options window to set a field to be invisible, rather than
removing the field from the report. Removing fields can prevent a check from
printing properly.

Invoices

Invoices are some of the most complex reports that are commonly modified. They
use several additional headers and additional footers to display line items. Invoices
must also print properly when they require only a single page or span multiple
pages.

Because of the complexity of modifying invoices, Microsoft has created several
modified versions of the invoices available in Microsoft Dynamics GP. You can
access these modified invoices in the Reports Library, which contains reports have
already had common modifications made to them. You can access the Reports
Library at the Microsoft Dynamics web site and browse the modified invoices that
are available there. Refer to Reports Library on page 89 for more information about
using the Reports Library.

Labels

Microsoft Dynamics GP can produce several types of labels, such as those for
customers, vendors, or employees. You can print labels by choosing Company in
the Reports menu, and then choosing Mailing Labels. The Mailing Labels window
will appear, allowing you select the labels you want to print.

When you create the report option for the mailing labels, you must select the format
to use for the labels. You can choose Continuous or Laser. If you choose Continuous,
you can select the number of labels that will be printed across the page. This value
will range from 1 to 5. If you choose Laser, the report will be printed with two labels
across each page.
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To have labels print properly on your printer and with your label stock, you may
need to make modifications to the layouts for the reports used to print labels. The
following table lists the reports that correspond the Format and Number Across
options you can specify in the Mailing Label Report Options window.

To easily select the appropriate mailing label report to modify, print the mailing labels to the
screen, and then choose to modify the current report.

If you are using the Laser format, and want to have more than two labels across the
page, you will need to use the Divider tool to add additional columns to the report
layout.

When information is printed in columns, it will be printed from the left column to
the right column, and then down to the next row. This is shown in the following
illustration.

When setting up mailing labels the first time, it is useful to test the layout on blank
paper before you print the actual labels. It’s also a good idea to print several pages
of labels to verify that the labels aren’t creeping up or down as multiple pages are
printed. If this occurs, you will need to modify the report layout to add or remove
space from the report section containing the labels.

Format Number Across Report

Continuous 1 Mailing Labels One Up

Continuous 2 Mailing Labels Two Up

Continuous 3 Mailing Labels Three Up

Continuous 4 Mailing Labels Four Up

Continuous 5 Mailing Labels Five Up

Laser N/A Laser Mailing Labels Two Up

Use the Divider tool to
add additional columns to

the report layout.

Record 3Record 2Record 1

Record 4

Record 7

Record 5

Record 8

Record 6

Record 9



134 U S E R ’ S G U I D E



P
A

R
T

 8
: S

T
O

R
IN

G
 A

N
D

 A
C

C
E

S
S

IN
G

 R
E

P
O

R
T

S



136 U S E R ’ S G U I D E

Part 8: Storing and Accessing 
Reports
This portion of the documentation contains information about how reports you
create or modify are stored and accessed. The following topics are discussed:

• Chapter 30, “Storing Reports,” explains how new and modified reports are
stored and describes two common Report Writer configurations.

• Chapter 31, “Accessing Reports,” describes how to control access to the Report
Writer and to the reports that you have created or modified.

• Chapter 32, “Packaging Reports,” explains how you can package and distribute
modifications to other users.

• Chapter 33, “Importing Reports,” describes how to import reports from another
reports dictionary into the current reports dictionary.
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Chapter 30: Storing Reports
All new reports and modifications you make with the Report Writer are stored in
the Reports dictionary. Information about storing reports is divided into the
following sections:

• Reports dictionary
• Launch file
• Report Writer configurations

Reports dictionary

All changes and additions you make using the Report Writer are stored in the
reports dictionary for the application. By storing the new and modified resources in
a separate dictionary, the integrity of the main dictionary can be maintained. For
example, the following illustration shows the dictionary for Microsoft Dynamics GP
and its associated reports dictionary.

When you access the Report Writer for the first time, all of the core resources for the
application dictionary are copied to the reports dictionary. Core resources include
strings, data types, and global fields that are used by several parts of the system.
After core resources have been copied to the Reports dictionary, the runtime engine
will look there first when it retrieves resources from the dictionary. Any additions or
modifications you make to core resources will be stored in the reports dictionary.
The modifications will be accessed automatically when you use Microsoft
Dynamics GP.

When you create a new report, or select a report to modify, that report is copied into
the reports dictionary. Any modifications or additions you make to that report will
be stored only in the reports dictionary. To access the modifications you make to
reports, you must set security in the accounting system to access the modified
report. This is described in Chapter 31, “Accessing Reports.” 

Launch file

When you start Microsoft Dynamics GP, you use the launch file that tells the runtime
engine which dictionaries will be used by the application. The launch file stores the
location of the application dictionary as well as the names and locations of any
forms or reports dictionaries.

By default, the reports dictionary is named Reports.dic and is located in the Data
folder for the Microsoft Dynamics GP installation. You can use the Edit Launch File
window to change the name or location of the reports dictionary. 

To update the launch file, you must have appropriate user privileges. Typically, this means
being part of the Administrators group or the Power Users group. On operating systems
with User Account Control (UAC) active, it means launching Microsoft Dynamics GP with
Administrative privileges.

Dynamics Reports.dic

New and modified 
resources are stored in 
the reports dictionary.
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To display this window, choose Microsoft Dynamics GP >> Tools >> Setup >>
System >> Edit Launch File. 

To change the name or location of a reports dictionary, select a product such as
Microsoft Dynamics GP. Then edit the name or location of the reports dictionary in
the field at the bottom of the Edit Launch File window.

Be sure that you have correctly specified the name and location of the reports dictionary.
Otherwise, the accounting system may not start properly.

Report Writer configurations

Two common configurations are used with the Report Writer. One configuration
has the reports dictionary stored locally on each workstation. In the other
configuration, the reports dictionary is stored in a network location accessible by all
workstations.

Storing the reports dictionary locally
In this configuration, each workstation has its own reports dictionary. Typically the
reports dictionary is stored in the Data folder for the Microsoft Dynamics GP
installation. This configuration is also used for single-user installations. This
configuration has the following advantages:

• Each workstation can have its own unique set of new and modified reports.

• Users can access the Report Writer at any time.

It has the following disadvantage:

• New and modified reports can’t easily be shared by multiple users. This issue
can be partially resolved by making modifications on one workstation and then
distributing the modifications to other workstations.

Storing the reports dictionary on a network
In this configuration, one reports dictionary is stored in a network location that can
be accessed by each workstation. This configuration has the following advantages:

• The same new and modified reports are available to all users.

• Any new reports or modifications users make are available to other users.

Select a product for which
you want to modify

dictionary locations.

You can change the
name of the reports

dictionary here.
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It has the following disadvantages:

• Only one user can access the Report Writer at one time.

• All workstations are dependent on a single reports dictionary. If this dictionary
is not available or becomes damaged, all users are affected.

• Users can’t have different sets of new or modified reports.

The configuration you choose depends on how many reports you want to modify,
whether individual users will be creating new reports or modifying existing reports,
and how you want to share new and modified reports among users.
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Chapter 31: Accessing Reports
You can control access to the Report Writer and which new and modified reports
specific users will be able to use. Information about controlling access is divided
into the following sections:

• Accessing the Report Writer
• Accessing modified reports
• Accessing custom reports
• Accessing third-party reports
• Removing modified reports

Accessing the Report Writer

The predefined security task ADMIN_SYSTEM_008 for Microsoft Dynamics GP is
used to control which users will be able to access the Report Writer. Assign this
security task to an existing role to grant access to the Report Writer for users
assigned to that role. You might also consider creating a new security role for the
Report Writer. Any user assigned to this new role will be able to access the Report
Writer.

Consider creating a new
security role that has
access to the Report

Writer task.



P A R T  8 S T O R I N G  A N D  A C C E S S I N G  R E P O R T S

142 U S E R ’ S G U I D E

Accessing modified reports

If you want to view a modified report from within the application, you must use the
Alternate/Modified Forms and Reports window in Microsoft Dynamics GP to grant
access. To open this window, choose Microsoft Dynamics GP menu >> Tools >>
Setup >> System >> Alternate/Modified Forms and Reports.

Complete the following procedure to specify that a modified report should be used.

1. Specify the ID.
Select the ID for the set of forms and reports you are modifying. The users that
you want to view the modified version of the report must be assigned to use the
set of modified/alternate forms and reports you selected. The User Security
Setup window is used to specify the set of modified/alternate forms and
reports for each user.

2. Select the product containing the modified report.
This is the product in which the report was originally defined.

3. Choose to display reports.
Choose Reports as the type of resource to display. The tree view will be filled
with the modified reports available.

4. Set the series.
By default, the Series drop-down list will be set to All. You can choose to
display resources from a specific series.

5. Locate the modified report.
Expand the nodes in the tree view to locate the report that you modified. The
reports are organized by series.

6. Choose to use the modified report.
The original and modified versions of the report will be listed. Mark the
modified version.

If you later wanted to use the original version of the report, you would mark the original
report instead.

Mark the item to use
the modified version

of the report.
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7. Save the changes.
Click Save to save the changes.

After you have set access to the modified report, print it as you typically would. Be
sure the user printing the report is assigned to the appropriate set of modified/
alternate forms and reports. For more information about printing reports, refer to
Part 6, Printing and Mailing Reports.

Be sure to activate security once you've made your selections by marking the
Security option in the Company Setup window in Microsoft Dynamics GP. When
the user chooses to display the report, the modified version of the report will be
displayed instead.

Changes made to core resources like strings and data types are seen by all users.

Accessing custom reports
Custom reports are new reports or copies of existing reports that you have created
with the Report Writer. To control access to a custom report, you must create a
security task for the custom report. Use the Security Task Setup window to do this.

To open this window, choose Microsoft Dynamics GP menu >> Tools >> Setup >>
System >> Security Tasks. Name the new security task. Select the product for which
the custom report was defined. Select Custom Reports as the resource type, and
choose the series. The custom reports in the selected series will be shown. Mark the
custom reports to include in the new task.

After the task is defined, you can assign it to a new or existing security role. Any
user assigned to that role will be able to access the custom report.

Be sure to activate security by marking the Security option in the Company Setup window
in Microsoft Dynamics GP.
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Accessing third-party reports

You can use the Report Writer to make changes to forms that are part of third-party
products created with Dexterity®. Dexterity is the tool used to create Microsoft
Dynamics GP. If you have third-party products that integrate with Microsoft
Dynamics GP, you will be asked which product you want to modify when you start
the Report Writer. When you choose a third-party product, you will be modifying
reports for that product.

Modified reports
Any modifications you make to the reports for a third-party product will be stored
in a separate reports dictionary for that product. To access these modified reports,
you must select the third-party product in the Alternate/Modified Forms and
Reports window. You can then choose to use the modified version of the report.

Alternate reports
Some third-party developers create alternate reports. These are Microsoft Dynamics
GP reports that the third-party developer has enhanced and transferred to their
own dictionary. By choosing the third-party dictionary when you start the Report
Writer, you can make modifications to these alternate reports.

When using the Alternate/Modified Forms and Reports window to set access to
these reports, choose the modified version of the alternate report to display the
modifications you made. For example, the following illustration shows how you
would display a modified version of the alternate Purchase Order History Report
provided by the Purchase Order Enhancements dictionary.

If you have integrating
products, use this window

to select the product
whose reports you want

to access.

This is a modified version of
the Equipment Status List
report in the Field Service

third-party application.
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Removing modified reports

If you remove a modified report from the Reports dictionary, be sure that you
change the security settings to use the original report rather than the modified
report. Otherwise, Microsoft Dynamics GP will not be able to properly access the
report.

This is the modified
alternate version of the
Purchase Order History

Report.
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Chapter 32: Packaging Reports
When you have finished modifying existing reports or creating new reports, you
may want to distribute them to other users. This portion of the documentation
describes how you can use package files to distribute new and modified reports.
Information is divided into the following sections:

• Package files
• Exporting a package file
• Importing a package file
• Package file import/export issues

Package files

Package files are special text files that are used to deliver customizations made with
the Modifier, VBA, and the Report Writer. A developer can create a package file that
contains their customizations, move the package file to the destination workstation,
then import the customizations into the installation.

A package file can contain the following items:

Modified forms Forms that have been customized with the Modifier.

New or modified reports Reports that have been created or customized with
the Report Writer.

VBA forms Forms that have VBA code attached.

VBA reports Reports that have VBA code attached.

VBA components User forms, code modules, or class modules created with the
VBA development environment.

References References to external components used by VBA. A package file
cannot contain the actual components referenced by the VBA customization. Those
components must be delivered separately.

Exporting a package file
Package files are created using the Customization Maintenance window. Complete
the following procedure to create a package file.

1. Open the Customization Maintenance window.
Open this window by pointing to Customize in the Tools menu and choosing
Customization Maintenance.
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2. Select the components needed for the customization.
The Customization Maintenance window lists all of the components that have
been customized with the Modifier, Report Writer, or VBA. Select all of the
components that are required for your customization.

To select non-contiguous items in the list, hold down the CTRL key and click the items.

Click Export. A file dialog will appear, allowing you to specify the name of the
package file. Be sure the file has the .package extension. The results of the
export operation will be displayed in the status area at the bottom of the
window.

Note that some global changes you make with the Modifier and Report Writer can’t be
included in a package file. For instance, changes to picture resources or global data types
won’t be included in package files.

Importing a package file
To import the contents of a package file, complete the following procedure.

1. Open the Customization Maintenance window.
Open this window by pointing to Customize in the Tools menu and choosing
Customization Maintenance.

2. Open the Import Package File window.
Click Import in the Customization Maintenance window to display the Import
Package File window.

3. Select the package to import.
Click Browse to open a file dialog that allows you to select the package file you
want to import. The contents of the package will be displayed in the Import
Package File window.

Select all of the
components that are part

of the customization.
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An “X” in the Overwrite column indicates that a customized version of a
component already exists for the system, and will be overwritten by the
contents of the package file. Refer to Package file import/export issues on page 149
for details about overwriting existing customizations.

If any of the package file items contain VBA code, the user importing them must have
appropriate user privileges to update the .vba files in the Microsoft Dynamics GP
installation. Typically, this means being part of the Administrators group or the Power
Users group. On operating systems with User Account Control (UAC) active, it means
launching Microsoft Dynamics GP with Administrative privileges.

Click OK to start the import process. If any errors occur during the import
process, the Errors window will be displayed. The results of the import
operation will also be displayed in the status bar of the Customization
Maintenance window. To view the list of the last errors that occurred, click the
Errors button in the status bar.

4. Set access to any modified forms or reports that are part of the 
customization.
If necessary, use the security features in Microsoft Dynamics GP to grant access
to any modified forms or modified reports that are part of your customization.

Package file import/export issues

There are some additional issues you need to be aware of when importing and
exporting package files, concerning how customized resources are stored by
Microsoft Dynamics GP.

Microsoft Dynamics GP contains forms, which are groups of windows, menus and
other resources that work together for a common purpose. A form can have several
windows, but you can make customizations to individual windows with the
Modifier and VBA. When you export a form to a package file, you are exporting all
of the windows in that form, not just the windows you modified or applied VBA
code to.

This fact is important to keep in mind when you import a package file that contains
customized forms. If a customized version of the form already exists in the system
and you import another set of customizations for that same form, the original
customizations will be overwritten. This occurs even if the customizations are made
for different windows in the form.

A similar issue occurs for reports. If you’ve made customizations to a report, then
import a package that contains customizations for that same report, the existing
customizations will be overwritten.

A warning message is automatically displayed allowing you to cancel an import operation
that will overwrite existing customizations.
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Chapter 33: Importing Reports
In versions of the Report Writer prior to Release 6, the only way to move a report
from one reports dictionary to another was to use the Import Reports capability.
Information about importing reports is divided into the following sections:

• Importing from a reports dictionary
• Validating reports

Importing from a reports dictionary

The Import Reports capability allows you to open a reports dictionary from another
installation of Microsoft Dynamics GP and import reports into the reports
dictionary for the current installation.

The Import Reports capability is no longer the preferred method for transferring reports from
one reports dictionary to another. Instead, we recommend that you use package files, as
described in Chapter 32, “Packaging Reports.”

To import reports, use the following procedure:

1. Start the Report Writer.
If it isn’t already running, start the Report Writer.

2. Open the Report Writer window.
Click the Reports button on the toolbar to open the Report Writer window.

3. Open the Import Reports window.
Click Import in the Report Writer window to open the Import Reports window.

4. Select the reports dictionary to import from.
Click the Source Dictionary lookup button to select the reports dictionary from
which you want to import.

It’s important that both the source dictionary and the destination dictionary be based on
the same version of the Microsoft Dynamics GP dictionary, and that they use the same
account framework. Otherwise, reports may not be imported correctly.

5. Select the reports to import.
In the Source Dictionary Reports list, select the reports you want to import, and
click Insert.

6. Import the reports.
Click Import to import the reports you have selected.

7. Close the window.
After you have finished, click Close to close the Import Reports window.

8. Validate the reports.
We recommend that you perform a validate operation on any reports you have
imported.
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Validating reports

After you have imported reports from another reports dictionary, it’s important to
verify that the report’s references to tables and other resources are still valid. To
validate a report, use the following procedure:

1. Select the report.
In the Report Writer window, select the report to validate in the Modified
Reports list.

2. Validate the report.
Click Validate in the Report Writer window to validate the selected report.

3. View the validation results.
The Validation Results window will appear, listing any invalid references that
were found. If invalid references were found, you must correct them before the
report will run properly. The following table lists the messages that may be
displayed, and describes what is causing the issue.

Message Cause

No invalid references found The report contains only valid references, so 
no changes are required.

Report XXX: Report XXX references a field 
that does not exist in table XXX.

A field in the layout of the specified report no 
longer exists in the specified table.

Report XXX: Restriction XXX references a 
field that does not exist in table XXX.

A field in the restriction definition for the 
specified report no longer exists in the 
specified table.

Report XXX: Expression XXX references a 
field that does not exist in table XXX.

A table field that’s used as part of a 
calculated or conditional expression no 
longer exists in the specified table.

Report XXX: Field XXX in sort segment not 
in table XXX.

A field in the sorting method for the 
specified report no longer exists in the 
specified table.

Report XXX: Field XXX in header is not part 
of table XXX.

A field in the specified header no longer 
exists in the specified table.

Report XXX: Field XXX in footer is not part of 
table XXX.

A field in the specified footer no longer 
exists in the specified table.
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Part 9: Word Templates
This portion of the documentation contains information about producing report
output in Microsoft Word format. The following topics are discussed:

• Chapter 34, “Overview of Word Templates,” provides a general description of
how Word templates work.

• Chapter 35, “Setting Up Microsoft Word,” describes how to set up Microsoft
Word to work with Word template documents.

• Chapter 36, “Report Template Design,” describes the structure of a report
template document, and provides details about how to design one.

• Chapter 37, “Creating Report Templates,” explains how to create a report
template document for a report.

• Chapter 38, “Report Templates for Modified Reports,” describes how to create a
report template document for a report that you have modified in Microsoft
Dynamics GP.

• Chapter 39, “Word Template Generator,” explains how to use the Word
Template Generator tool to create a report template document for a report.

• Chapter 40, “Troubleshooting Templates,” provides solutions to common
problems when you are working with report document templates.
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Chapter 34: Overview of Word Templates
In Microsoft Dynamics GP, the Report Writer is used to render the output of most
reports. Beginning with Microsoft Dynamics GP 2010, several reports can also be
rendered in Microsoft Word format. General information about Word templates is
divided into the following sections:

• Template-enabled reports
• Report definition
• Report template document
• How Word Templates are processed
• Capabilities of Word templates

Template-enabled reports

Template-enabled reports are Report Writer reports that have Microsoft Word report
template documents associated with them. When these template-enabled reports
are printed, the appropriate Microsoft Word report template document is retrieved
and used to render the output in Microsoft Word format. The Reports window in
Microsoft Dynamics GP is used to select a report that you want to define a template
for.

Report definition

A report that is rendered as a Microsoft Word document is still based on a standard
report definition in the Report Writer. The report definition is needed for things like: 

• Defining which tables are used for the report
• Specifying how data is sorted
• Determining which sections the report has
• Specifying which fields are in each section
• Defining calculated values that appear on the report

Microsoft Word does not perform any of these standard report actions. It is used
only to display the report that has been rendered in Microsoft Word format.

You can define templates
for the reports that are

listed here.
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Report template document

The report template document defines the layout of a report. It is a standard
Microsoft Word document (Word 2007 format or later) that also contains the report
definition details, such as the sections in the report, the fields in each section, and
the static text values defined for the report. This information is gathered from the
report definition, and then embedded into the report template document when the
document is created.

The Microsoft Word Add-in for Microsoft Dynamics GP is used to access this report
definition information in the report template. It makes the information available so
it can be used when the layout of the report template document is defined.

How Word Templates are processed
When you run a report that is template-enabled, and at least one Microsoft Word
report template document has been assigned to the report, the Report Destination
window will have the Template choice available in the Report Type drop-down list.

Choosing Template when no report template is assigned will display the HTML version of
the report.

When you choose Template as the Report Type, the assigned Microsoft Word
document will be used to generate the output of the report. The following
illustration shows the basic process used to process the report.

XML Document
Contains Report Definition

and Data

Report Definition in
Microsoft Dynamics GP

Template Processing
Engine

Microsoft Word Template
for the Report

Completed Report in
Microsoft Word
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The Microsoft Dynamics GP runtime uses the report definition for the report to
generate an XML document that contains both the report definition and the data for
the report. The appropriate Microsoft Word report template document that was
created for the report is retrieved. This template document defines how the data in
the report is to be rendered. The XML and template documents are passed to the
Template Processing Engine, which combines them to produce the completed
Microsoft Word document for the report.

Capabilities of Word templates

Rendering the output for a report in Microsoft Word format provides several
improvements over the capabilities of the Microsoft Dynamics GP Report Writer
rendering engine. These include:

• Support for any font.

• Better graphics support for images such as logos.

• Support for Microsoft Word features such as watermarks.

• Portability of the report. Any user with Microsoft Word can view the report.

Microsoft Word is not designed to have the features of a report writer. The following
is a list of the capabilities of the Microsoft Dynamics GP Report Writer rendering
engine that are not available in the reports generated in Microsoft Word format:

• No running sums on pages

• No page headers or page footers in the report. All page headers and page
footers must be implemented using feature provided by Microsoft Word.
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Chapter 35: Setting Up Microsoft Word
You will use Microsoft Word 2007 or later to create or modify the Word template
documents used for reports. A Microsoft Word add-in and some additional
configuration is needed to allow Microsoft Word to perform these actions.

• Add-in for Microsoft Word
• Microsoft Word settings

Add-in for Microsoft Word
The Microsoft Dynamics GP Add-in for Microsoft Word is used when creating the
layout of the Word template document for a report. You need it only if you are going
to modify existing Word template documents or create new Word template
documents.

This add-in is an additional product that can be installed. It is accessed from the
main Microsoft Dynamics GP installer.

If you have installed the Microsoft Dynamics GP Add-in for Microsoft Word from a
previous release of Microsoft Dynamics GP, be sure that you remove the add-in and install
the most recent version for the current Microsoft Dynamics GP release.

After installing the Microsoft Word add-in, you access it through the Developer tab
in the Ribbon.

• To display the Developer tab in Word 2007, go to the Office menu and choose
Word Options. In the Word Options window, select the Popular category. Mark
Show Developer Tab in the Ribbon, and then click OK.

• To display the Developer tab in Word 2010, go to the File menu and choose
Options. In the Word Options window, select Customize Ribbon. In the Main
Tabs list, mark Developer, and then click OK.

The following illustration shows the group that is added to the Ribbon.

The Microsoft Word
add-in is an additional

product that can be
installed.
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The Microsoft Dynamics GP Add-in is used to add fields, captions, and legends
from the various sections of the report to the report template layout. It is also used
to work with the data sources (report definition information) that is embedded in
the report template document.

Microsoft Word settings

We suggest you make the following settings in the Word Options window of
Microsoft Word to help you see the layout structure of the report template
documents and make editing them easier. To open the Word Options window for
Word 2007, go to the Office menu and choose Word Options. To open the Word
Options window for Word 2010, go to the File menu and choose Word Options.

Display options
In the Word Options window, select the Display category. Mark the following
options:

• Paragraph marks
• Hidden text
• Object anchors

Advanced options
In the Word Options window, select the Advanced category. Mark the following
options:

• Show bookmarks
• Show text boundaries

The Microsoft Dynamics GP
Add-in is used to add fields,
captions, and legends to the

report template layout.
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Chapter 36: Report Template Design
The report template documents that are used for rendering reports in Microsoft
Word format must conform to several guidelines so that they can be processed by
the template processing engine. The following sections describe how a report
template document is designed:

• Document structure
• Creating a report template layout with tables
• Fields, captions, and legends
• Bookmarks
• Company image
• Tips for working with report template documents
• Common report template patterns
• Making report templates read-only

Document structure

The report template document is a standard Microsoft Word document. When it is
created from with Microsoft Dynamics GP, the additional information about the
report definition is embedded into the document. The document is a single-sided,
which means that there are no left-hand or right-hand pages.

Several tables in the report template document define the overall structure. All of
the content that is displayed in the generated Word document is placed inside these
tables. The following illustration shows the structure of a report template
document.

Any text that is not within one of these single-cell tables will not be included in the
generated Microsoft Word document for the report. It is common to add text to the
document in the areas outside of the single-cell tables to describe the report
template.

Page header table
The page header table is a table that is placed in the header of the Microsoft Word
document. This corresponds to the page header for a standard Report Writer report.
Because it is in the header of the Microsoft Word document, the content of the page
header table is displayed at the top of every page of the generated report.

Page Header

Page Footer

Body

Report Header

Report Footer

Word Document Header

Word Document Footer

Word Document Body
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Report header table
The report header table is a table that is located at the beginning of the Microsoft
Word document. This corresponds to the report header for a standard Report Writer
report. The content of the report header table is displayed only one time at the
beginning of the generated report.

Body table
The body table is a table that is located after the report header table of the Microsoft
Word document. It contains the main content of the report. This includes the report
body content, any additional headers, and any additional footers.

Report footer table
The report footer table is a table that is located at the end of the Microsoft Word
document. This corresponds to the report footer for a standard Report Writer report.
The content of the report footer table is displayed only one time at the end of the
generated report.

Page footer table
The page footer table is a table that is placed in the footer of the Microsoft Word
document. This corresponds to the page footer for a standard Report Writer report.
Because it is in the footer of the Microsoft Word document, the content of the page
footer table is displayed at the bottom of every page of the generated report.

Creating a report template layout with tables

Tables are used to create the layout of the report template. The rows and columns
create the table cells where the report data can be placed. You will add the fields,
captions, and legends from the report to these table cells.

Each report field, caption, and legend value should be in its own table cell. For
example, the following illustration shows a caption and a report field in the page
header table of a report template. Notice how each is placed in its own table cell.

Page header and page footer tables
The page header and page footer tables, located in the header and footer of the
Microsoft Word report template document, contain the values that come from the
ReportHeader section and ReportFooter section of the report definition. Things like
the report date and current user are included in these tables. A typical page header
table is shown in the following illustration.
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Report header and report footer tables
The report header and report footer tables, located at the beginning and end of the
Microsoft Word report template document, contain values from the ReportHeader
and ReportFooter section of the report definition. Values that are displayed only one
time, such as sorting criteria, are placed in this table. A simple report header table is
shown in the following illustration.

Body table
The body table is located between the report header and report footer tables in the
Microsoft Word report template document. It contains values from the Body section,
and from any additional header and additional footer sections of the report
definition.

The body table has multiple rows. The table has one row for the actual report body.
There is also one row for each additional header and one row for each additional
footer. There can also be a rows that are used for captions, such as column headers.

Typically, additional tables are used within the rows of the body table to create the layout for
the row.

A basic body table is shown in the following illustration. The first row in this body
table contains captions for the column headings. The next row contains data for an
additional header. The third row contains data from the report body. The last row
contains data for an additional footer.

The row of the body table that contains items from the report body must have a
special Microsoft Word bookmark that the template processing engine in Microsoft
Dynamics GP uses to identify this row. You can see this bookmark located on the
left side of the body row in the previous illustration. Refer to Bookmarks on page 166
for details about adding bookmarks to the report template document.

As Microsoft Dynamics GP processes the report, it examines the report data to
determine when the rows from the body table are included in the generated output
for the report. For example, when the data for an additional header is encountered
for a report, that row is included in the generated output.

If the body table contains a row with column headers, this row of the body table
should be set to repeat as the header row at the top of each page. This is a Microsoft
Word feature that is applied to a specific row of the body table.
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Fields, captions, and legends

After the tables that define the overall structure of the report template document
have been created, you will add fields, captions, and legends. The Microsoft
Dynamics GP Add-in for Microsoft Word is used to do this.

Adding an item
To add a field, caption, or legend, complete the following steps:

1. Display the Developer tab.

2. Click Field List in the Microsoft Dynamics GP group.
The Custom XML Mapping pane will be displayed. This pane provides access
to the report definition data that was embedded into the report template
document when it was created.

3. Select an XML resource.
In the drop-down list in the Custom XML Mapping pane, select the XML
resource for the report. Typically, there is only one XML resource. The Report
Section list will be filled with the sections in the report.

4. Select a report section.
Select the section of the report from which you want to add items. The Fields list
will be filled with the fields, captions, and legends that are contained in that
section from the report definition.

5. Add items to the layout.
Drag items from the Fields list to the cells in the layout of the report template
document. Caption items will display the text of the caption. Other fields will
display placeholder characters that show the maximum length of the data in the
field.

These are the items found
in the selected section of

the report definition.
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Use the guidelines in the following table when deciding which section of the
Field List in the Custom XML Mapping pane to drag items from when you
place them in the layout of the report template.

If you place items from the field list into an inappropriate location in the report
template, their values will not appear in the generated report.

6. Specify the appearance of the item.
Use the standard features of Microsoft Word to specify characteristics like the
font, style, and alignment.

Removing an item
To remove a field, caption, or legend, complete the following steps:

1. Click on the item in the document.
The tag containing the name of the field will be displayed.

2. Click on the tag.
Click the tag to select it.

3. Remove the item.
Press the Backspace key to remove the item from the report template layout.

Displaying item properties
You may want to view the properties of a field, caption, or legend after it has been
added to the report template document. The properties of an item show you what
section of the report data the item originated from.

To display the properties, click on the item in the document. In the Developer tab,
click Properties. 

Location in report template Source in Field List

Page Header table ReportHeader

Report Header table ReportHeader

Body table Body
AdditionalHeaders
AdditionalFooters

Report Footer table ReportFooter

Page Footer table ReportFooter

Click on the item to select it.

Click on the tag to select it.
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Bookmarks

Microsoft Word bookmarks are used to identify three of the tables that define the
structure of the report template document. The following table lists these
bookmarks.

Every report template document must have the StartTemplateSectionRepeating bookmark
defined for the template to work properly.

You must define these bookmarks in Microsoft Word, and then insert them into the
report template document in the appropriate locations.

To be found by the template processing engine in Microsoft Dynamics GP, these
bookmarks must not be located within the fields, captions, or legends used for the
report.

Some of the report template documents for reports in Microsoft Dynamics GP, have
bookmarks that are named StartTemplateDocumentBookmark and
EndTemplateDocumentBookmark. These bookmarks are used only for calculating page
numbers for these reports. They do not identify tables in the report template document.

The Tag indicates the
section of the report

definition the value of the
item is from.

Bookmark Description

StartTemplateDocumentHeaderBookmark This bookmark identifies the Page Header table. The 
bookmark is placed inside the table located in the 
header of the report template document.

StartTemplateSectionRepeating This bookmark is located within one row of the Body 
table of the report template document. It identifies 
what row of the Body table will be repeated for each 
record of the report.

EndTemplateDocumentFooterBookmark This bookmark identifies the Page Footer table. The 
bookmark is placed inside the table located in the 
footer of the report template document.

The bookmarks must
be defined in

Microsoft Word.
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Company image

Each company in Microsoft Dynamics GP can have an image assigned that is to be
displayed on the Microsoft Word template reports. When you run the report for a
specific company, the image assigned for that company will be displayed on the
generated document. Typically, this logo is placed in the Page Header table for the
report template document. To add a company image to a report template, complete
the following steps:

1. Create a cell to contain the image.
In the report template document, create a table cell in the location where you
want the image to appear.

2. Add a Picture Content Control.
Display the Developer ribbon in Microsoft Word. In the Controls group, choose
to insert a Picture Content Control.

3. Set the picture size.
Use the resize handles on the Picture Content Control to the size required for
your report template document.

4. Set the picture properties.
With the Picture Content Control selected, click Properties in the Controls
group. Set the following properties:

Title Set this property to CompanyLogo

Tag Set this property to globals.'Company Logo'

Click OK.

Tips for working with report template documents

Keep the following tips in mind when working with report template documents in
Microsoft Word.

• Get the basic report template layout working first. Do the intricate layout work
such removing extra space and aligning data values after the report template is
retrieving data and displaying it correctly.

• Press and hold the Alt key when moving table borders to prevent them from
snapping to the grid in Microsoft Word.

• Use the Design Mode that can be activated from the Developer tab to see
quickly which sections the items in the report template layout come from.

• Make regular backups of your template as you are working, in case you make a
change that you would like to revert.
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Common report template patterns

Two common patterns are used when creating a report template document layout.
You can use these patterns as a base for creating your own report template
documents.

Form pattern
In the form pattern, the data is displayed as a block of values for each record in the
table. The block typically contains several pairs of labels and data values that are
arranged in the block. The following illustration shows this pattern.

The layout has the following characteristics:

• The Body table in the layout is a single cell.

• The Body table has another table nested in it that contains the rows and
columns that define the layout of the data.

• The captions and fields for the report are placed in the cells of the nested table. 

• The StartTemplateSectionRepeating bookmark is placed in a cell of the nested
table to indicate that the entire single-cell row of the Body table will be repeated
for each record in report.

The Body table may also have rows for additional headers and additional footers.
The Report Footer table and Page Footer table are optional in this pattern.

Page Header table

Page Footer table (optional)

Body table (single-cell)

Report Header table

Report Footer table (optional)

StartTemplateSectionRepeating
bookmark

Nested table inside the
Body table, with multiple

rows and columns
containing the data from

each record.

xxx xxx
xx xxxxx

xx xxxxx

xx x
xxxx xxxxx
xxx xxx
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Column pattern
In the column pattern, the data for the report is divided into columns, with one row
for each record in the table. A set of column headers appears at the top of each page.
The following illustration shows this pattern.

The layout has the following characteristics:

• The first row of the Body table is divided into columns that contain the captions
for the values in the report. The properties for the row are set in Microsoft Word
to make the column repeat at the beginning of each page.

• The Body table can contain rows for additional header data and additional
footer data.

• The Body table has a row that contains a nested table. This nested table is
divided into columns, and the fields for the report are placed in these columns.

• The StartTemplateSectionRepeating bookmark is placed in a cell of the nested
table to indicate that the entire row of the Body table will be repeated for each
record in report.

The Report Footer table and Page Footer table are optional in this pattern.

Making report templates read-only

You may want the Microsoft Word document generated for a report to be read-only,
so the recipient of the document cannot make modifications to it. Functionality in
Microsoft Word makes this possible. To do this, complete the following steps:

1. Open Report Template Maintenance.
In Microsoft Dynamics GP, choose Administration >> Reports >> Template
Maintenance.

2. Select the original template.
In Report Template Maintenance, select the report template for which you want
to make a read-only version.

Page Header table

Page Footer table (optional)

Body table

Report Header table

Report Footer table (optional)

xxx xxx

xx xxxxx

xxxxx xxxxx

xxxx xxx

The first row of the Body
table contains the captions

for the columns. The row is
set to repeat each page.

StartTemplateSectionRepeating bookmark

Nested table inside one
row of the Body table,
with multiple columns

containing the data from
each record.

Additional header rows (if needed)

Additional footer rows (if needed)
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3. Create a new template.
Click New to create a new report template. In the New Template window, mark
the From Existing Template option, and select the original template. Supply a
name for the new template.

You may want to include “read only” in the name to indicate how the template is to be
used.

Click Create.

4. Modify the new template.
In the Report Template Maintenance window, select the new template. Click
Modify to modify the template in Microsoft Word.

In Microsoft Word 2007 Display the Review tab. In the Protect group,
click Protect Document and choose Restricted Access. Mark the option to
restrict permission to this document. Click More Options. In the Permissions
window, specify the options needed, such as only allowing the document to be
viewed. Typically, you will want to give all users read-access. Click OK.

In Microsoft Word 2010 Display the Review tab. In the Protect group, click
Restrict Editing. Mark the check box for item 2, Editing restrictions, and choose
No changes (Read only). Click Yes, Start Enforcing Protection. Enter a password
for the document. Click OK.

5. Save the changes you made to the template.
In Microsoft Word, save the modified report template document to a convenient
location where you can easily find it.

6. Close the modified report template.
In Microsoft Word, close the modified report template document.

7. Import the modified report template document.
In the Report Template Maintenance window in Microsoft Dynamics GP, select
the modified template. Click Add Template (the green plus). A file dialog box
will appear. Select the report template document you just saved for the
modified report, and then click Open.

8. Replace the existing report template document.
A message will be displayed that indicates you are replacing an existing
template. Click Yes to replace the existing report template document with the
one you just made modifications to.

9. Assign the new template to the appropriate company.
When you run the report, the Microsoft Word document generated will have
the restricted (read-only) characteristics that you defined.
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Chapter 37: Creating Report Templates
You can create your own report template documents for reports. Information about
how to do this is contained in the following sections:

• Overview of creating report template documents
• Creating a new report template document

Overview of creating report template documents
Microsoft Dynamics GP contains several reports that have report template
documents already defined for them. You can create additional report template
documents for these reports. These additional report template documents are
created to be used with specific companies, customers, or vendors. Third-party
integrating applications may also have reports that you can create additional report
template documents for.

Microsoft Dynamics GP and third-party integrating applications can have reports
that do not have any report template documents defined for them. You can create
report template documents that can be used with these reports, which allows them
to generate the report in Microsoft Word format. 

You can create report template documenta manually, or you can use the Word Template
Generator tool included with Microsoft Dynamics GP to create them. For information about
the Word Template Generator, see Chapter 39, “Word Template Generator.”

You can also create report templates that can be used with modified versions of
reports. Refer to Chapter 38, “Report Templates for Modified Reports,” for details
about how to do this.

Creating a new report template document
To create a new report template document, complete the following procedure:

1. Open Report Template Maintenance.
In Microsoft Dynamics GP, choose Administration >> Reports >> Template
Maintenance.

2. Select the original version of the report.
Choose More Reports in the Report Name drop-down list. In the Reports
lookup window, select the original report.

Click Select.



P A R T  9 W O R D  T E M P L A T E S

172 U S E R ’ S G U I D E

3. Create a new report template document.
In the Report Template Maintenance window, click New to create a new report
template document for the report.

4. Specify the details of the new report template document.
In the New Template window, specify how the new report template document
will be created.

• For reports that have no existing report template documents, the new
report template will be blank (no layout). 

• For reports that have existing report template documents, the new template
can be created based on the template you select. In most cases, you will
choose to create the template based on an existing template, because then
you don’t have to re-create the report template layout.

You must also supply a name for the report template you are creating. The
name should indicate how the report template is intended to be used.

Click Create.

5. Modify the new report template.
In the Report Template Maintenance window, select the new report template
you created, and then click Modify. The report template will be opened in
Microsoft Word.

Using the techniques and guidelines described in Chapter 36, “Report Template
Design,” add to or modify the report template document as needed.

6. Save the new report template.
In Microsoft Word, save the new report template document to a convenient
location where you can easily find it.

7. Close the new report template.
In Microsoft Word, close the new report template document.
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8. Import the new report template document.
In the Report Template Maintenance window in Microsoft Dynamics GP, select
the new template. Click Add Template (the green plus). A file dialog box will
appear. Select the report template document you just saved, and then click
Open.

9. Replace the existing report template document.
A message will be displayed that indicates you are replacing an existing
template. Click Yes to replace the existing report template document with the
one you just selected.

The new report template is ready to be assigned and used in Microsoft Dynamics
GP.
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Chapter 38: Report Templates for Modified 
Reports
If you make a modified version of a report that has a Microsoft Word report
template defined for it, you need to make a modified version of the report template
document to have your changes appear in the generated Microsoft Word document.
When the modified report is run in Microsoft Dynamics GP, the modified report
template document is used so that your modifications are included in the generated
Microsoft Word document. The following topics are discussed:

• Modifying the report definition
• Creating a modified report template document
• Using the modified report template document
• Updating the data source for a report template

Modifying the report definition

The report definition for the modified report will be the basis for your report
template document. If you are adding any additional content to the modified
report, such as report fields, calculated fields, static text, or legends, you should
make all of the necessary changes before you work on the report template
document.

Be sure that your modified report is working correctly when it is run as a standard
report from Microsoft Dynamics GP. If the modified report does not display
correctly as a standard report, it will not display correctly as a generated Microsoft
Word document.

The following example demonstrates the end-to-end process for making a report
template for a modified report. Assume the SOP Blank Quote Form report is being
modified to include the e-mail address of the person for whom the quote is being
generated. A calculated field can be defined for the modified report that will
retrieve the e-mail address for the quote recipient. This calculated field has the
following calculated expression:

FUNCTION_SCRIPT(RW_GetInternetInfo "CUS" 

RM_Customer_MSTR_ADDR.Customer Number 

RM_Customer_MSTR_ADDR.Address Code 1 )

This calculated field with the e-mail address is added to the report layout, as shown
in the following illustration.

This EMailAddress calculated field was added to both the Report Header and Page
Header sections of the report layout.
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Creating a modified report template document
After the modified report definition has been created, you can make a report
template document for it. Do this using the following procedure:

1. Open Report Template Maintenance.
In Microsoft Dynamics GP, choose Administration >> Reports >> Template
Maintenance.

2. Select the modified version of the report.
Choose More Reports in the Report Name drop-down list. In the Reports
lookup window, select the modified report.

Click Select.

3. Create a new report template document.
In the Report Template Maintenance window, click New to create a new report
template document for the modified report.

4. Specify the details of the new report template document.
In the New Template window, specify how the new report template document
will be created. The new report template can be blank (no layout) or it can be
created with layout of an existing template. In most cases, you will choose to
create the template based on the original report template.

You must also supply a name for the report template you are creating. The
name should indicate that the template is for a modified version of the report.

Click Create.
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5. Modify the new report template.
In the Report Template Maintenance window, select the new report template for
the modified report, and then click Modify. The report template document will
be opened in Microsoft Word.

6. Display the field list for the report.
In Microsoft Word, select the Developer tab. In the Microsoft Dynamics GP
Templates group, click Field List. 

7. View the additional resources for the report.
At the top of the Field List, select the XML resource that contains the report
definition data. When you select the individual sections of the report, you
should see the fields, captions, and legends that you added to the layout for the
modified report.

Continuing the example from the previous section, the EMailAddress
calculated field can be seen in the Fields list for the ReportHeader and
PageHeader sections. These were the sections it was added to in the layout for
the modified report.

8. Make modifications to the report template layout.
Following the techniques and guidelines described in Chapter 36, “Report
Template Design,” make the necessary changes to the report template
document. For instance, you will want to add the additional fields and captions
you created for the modified report.

Continuing the example for the modified Sales Blank Quote Document report,
the EMailAddress field was added to the report template document. Following
the guidelines, the value was dragged from the ReportHeader section in the
Custom XML Mapping pane.

This calculated field was
added to the layout of the

modified report.
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9. Save the modified report template.
In Microsoft Word, save the modified report template document to a convenient
location where you can easily find it.

10. Close the modified report template.
In Microsoft Word, close the modified report template document.

11. Import the modified report template document.
In the Report Template Maintenance window in Microsoft Dynamics GP, select
the modified template. Click Add Template (the green plus). A file dialog box
will appear. Select the report template document you just saved for the
modified report, and then click Open.

12. Replace the existing report template document.
A message will be displayed that indicates you are replacing an existing
template. Click Yes to replace the existing report template document with the
one you just made modifications to.

Using the modified report template document

To use the modified report template document, you must assign it to be used with
the modified report. To do this, complete the following procedure:

1. Open Report Template Maintenance.
In Microsoft Dynamics GP, choose Administration >> Reports >> Template
Maintenance .

2. Select the modified version of the report.
Choose More Reports in the Report Name drop-down list. In the Reports
lookup window, select the modified report. Click Select.

3. Assign the modified report template.
In the Report Template Maintenance window, select the modified report, and
then click Assign. Use the Company Assignment window to assign the
modified report template to a company.

Security in Microsoft Dynamics GP must be configured to that the modified version
of the report is used. Refer to Accessing modified reports on page 142 for details about
how to do this. When the report is run, the Report Type drop-down list in the
Report Destination window will have the Template choice available. If you choose
Template, the modified report template for the modified version of the report will
be used to generate the output in Microsoft Word format.

Continuing the example from the previous sections, the modified report template
for the SOP Blank Quote Form was assigned to the Fabrikam sample company.
When the modified SOP Blank Quote Form report is run, and Template is chosen as
the report type, the modified report template is used to generate the output as a
Microsoft Word document. In this example, the output contains the e-mail address
that was added to the modified report.
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Updating the data source for a report template

When you have created a modified report and its corresponding report template
document, the report definition data embedded into the report template document
matches the layout of the modified report. If you make additional changes to the
modified report, such as adding additional fields to layout, the report definition
data embedded into the report template won’t have those changes.

Rather than having to re-create the report template document, you can replace the
embedded report definition data with an updated version. To do this, complete the
following procedure.

1. Update the modified report.
Make the additional changes to the modified report. Be sure the report is
working correctly.

2. Export the XML representation of the report.
In Microsoft Dynamics GP, run the modified report. In the Report Destination
window, set the Report Type to Standard. Mark the File check box, specify XML
Data file as the export format, supply a filename for the export file, and then
click OK.

When the modified report is run,
the modified report template is

used. It contains the e-mail
address that was added.

Export the report in XML
Data format.
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The XML data file for the report has two main sections. The first section
contains the report definition information, while the second section has actual
data for the report. The updated report definition section is what must be
embedded into the report template document.

3. Open the report template document.
In Microsoft Word, open the report template document for which you want to
replace the report definition information.

4. Select the XML resource containing the report definition.
Display the Developer tab, and then click Field List in the Microsoft Dynamics
GP Templates group. The Custom XML Mapping pane will be displayed. In the
XML Resource drop-down list, select the XML resource for the report.

5. Remove the XML resource.
In the Microsoft Dynamics GP Templates group, click Remove Source. A
message will be displayed warning of possible missing data. Click OK to
remove the source.

6. Add the updated report definition.
In the Microsoft Dynamics GP Templates group, click Add Source. In the file
dialog displayed, locate the XML data file you exported for the revised
modified report. Select the file and click Open.

7. Select the updated XML resource.
In the Custom XML Mapping pane, use the XML Resource drop-down list to
select the updated XML resource for the report. The Report Section and Fields
lists should contain items that match the revised report definition.

8. Make the changes to the report template.
Using the techniques and guidelines described in Chapter 36, “Report Template
Design,” make the necessary changes to the report template document to match
the changes you made to the modified report. 
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Chapter 39: Word Template Generator
The Microsoft Dynamics GP Word Template Generator is a utility that can help you
create Word templates for Microsoft Dynamics GP reports. The following sections
describe how to use this utility:

• Overview
• Accessing the Word Template Generator
• Using the Word Template Generator
• Generated template expectations

Overview

In Microsoft Dynamics it is possible to create a Word template for any report.
However, Microsoft Dynamics GP does not include a template for every report. You
can use the Word Template Generator to create the initial Word Template for a
report in Microsoft Dynamics GP. 

The Word Template Generator utility saves development time because you don’t
need to create the report template from scratch. The utility creates a template
document that closely matches the design of the Report Writer report.

See Generated template expectations on page 184 for information about the results you can
expect from the template generator. You will also find a list of the specific types of reports for
which generated templates are not supported.

Accessing the Word Template Generator

The Word Template Generator is included with each installation of Microsoft
Dynamics GP. You can find the TemplateGenerator.exe in the AddIns folder of the
Microsoft Dynamics GP installation.

The Report Template Generator is run from the command prompt. To make it more
convenient to use the utility, consider adding the location of the AddIns folder to
the PATH variable for your system.

Using the Word Template Generator

We recommend that you be familiar with using the Word Templates feature before
you use the Word Template Generator. Refer to Chapter 34, “Overview of Word
Templates,” for basic information about Word Templates.

To use the Word Template Generator, complete the following procedure:

1. Run the report for which you want to create a template.
In Microsoft Dynamics GP, run the report for which you want to create a
template. For example, if you were creating a Word template for the Vendor
Information report, you would use the Vendor Maintenance form to run the
report.
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2. Export the report in XML format.
In the Report Destination window, export the report as a file in XML format.

Click OK to export the report.

3. Display the report in the Screen Output window (optional).
You may want to re-run the report and display it in the Screen Output window.
The name of the report is displayed in the title bar of the Screen Output
window. You will need to know this name when you add your template to the
report in Microsoft Dynamics GP.

4. Start a command prompt.

5. Set the working folder.
In the command prompt window, set the working folder to the location where
you exported your .xml report document.

6. Generate the Word template document.
Use the following command to generate the Word template document for the
report:

TemplateGenerator.exe filename.xml 

If you didn’t add the AddIns folder to the PATH variable for your system, you will need
to supply the complete path to the TemplateGenerator.exe file..

A Word template document with the same name as the .xml file will be
generated. If you supply a second parameter with different name for the output
file, that name will be used instead.

You can also use a drag-and-drop operation to generate the template document. Simply
drop the .xml report document onto the TemplateGenerator.exe file. A Word template
document will be created in the same location as the .xml report document.

Choose to export the
report in XML format.
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7. View the Word template document (optional).
You can use Microsoft Word to view the Word template document. Its layout
will closely match the layout of the report in Microsoft Dynamics GP.

8. Add the template into Microsoft Dynamics GP.
Use the Report Template Maintenance window to add the Word template to
Microsoft Dynamics GP. Refer to Creating a new report template document on
page 171 for information about how to do this.

9. Test the template.
Run the report from Microsoft Dynamics GP, and choose to use the template.
Verify that the report is being generated correctly.

10. Revise the template as needed.
Make any changes needed for the template, such as fonts and spacing. Refer to
Chapter 36, “Report Template Design,” for detailed information about working
with Word Template documents.

The generated Word
template document will

closely match the layout
of the report.
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Generated template expectations

As you use the Word Template Generator tool, it’s important to have proper
expectations for it.

Typical reports
The Word Template Generator can create a template for any Report Writer report in
Microsoft Dynamics GP. Most of these Word Templates will produce the results you
expect when they are used in Microsoft Dynamics GP.

Some reports in Microsoft Dynamics GP have very complex layouts. It is possible
that features of these complex reports cannot be reproduced by the Word Template
Processing Engine. In some cases, you may be able to manually modify the report
template to produce the desired results. The modifications could be extensive. It is
up to you to decide whether the report generated from the Word template will fulfill
your requirements.

Specific reports
The following is a list of the reports and report types in Microsoft Dynamics GP that
have known issues with the Template Processing Engine. Word templates that you
create for these reports and report types likely won’t produce acceptable output,
and are not supported.

• PM checks

• Payroll checks

• Posting journals (such as the SOP posting journal)

• Reports that use the “Divider” tool (such as Company Labels)

• Some reports that use temporary table fields to generate report content

Third-party reports
The Word Template Generator can be used with third-party reports for integrating
applications that have been installed with Microsoft Dynamics GP. Because these
third-party reports may not conform to the same standards as Microsoft Dynamics
GP reports, the Word Template Processing Engine may not produce the output you
expect. The report templates created for these reports could require extensive
manual modification to work correctly.
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Chapter 40: Troubleshooting Templates
Use the following information to help you troubleshoot issues you may encounter
when working with report template documents. The following items are discussed:

• Template layout issues
• Template processing issues

Template layout issues

The following layout issues can occur for report template documents.

Word add-in issues
If you experience issues with the Word add-in, such as the field list not containing
data, be sure that you have installed the latest version of the add-in. When you
upgrade to a new release of Microsoft Dynamics GP, be sure that you install the new
version of the Word add-in as well.

Incorrect data in Word document
If the generated Microsoft Word document for a report does not contain the correct
data, or data is missing from the document, check the following:

• Verify that the standard version of the report is working correctly. If the
standard version of the report isn’t displaying data correctly, the template
version will not either. This problem is more likely to occur if you have made a
modified version of a report.

• Be sure the bookmarks for the report template document are defined with the
correct names.

• Verify that the bookmarks are not located inside of a field you added to the
report template document. If they are, the template processing engine won’t be
able to find the bookmarks.

Field values are empty
If a field value is empty in the generated Microsoft Word document, check the
following:

• Verify the item was dragged to the report template document from the
appropriate report section of the XML data. If the item comes from the wrong
section, it will not contain any data.

• Be sure that you have all of the tables needed for the report template document.
Data values may not appear in a report if the report is missing one of the
standard tables, such as the Report Header table.

Field values display as X’s
If field values in the generated Microsoft Word document display as a series of X’s,
this means that data is not being substituted into the field. If this occurs, view the
bookmarks for the report template document to be sure that you haven’t deleted
one. If you need to re-add a bookmark, be sure that is has the correct name and is in
the correct location. See Bookmarks on page 166 for more information.



P A R T  9 W O R D  T E M P L A T E S

186 U S E R ’ S G U I D E

Column headers do not repeat
This issue can occur for report template documents that use the column pattern.
Column headers for tables that repeat at the beginning of each page are a feature of
Microsoft Word. You must set the table property that indicates the first row of the
table is to be repeated.

Items missing from Custom XML
If items are missing from the Custom XML for a report template document, this
typically means that the report definition was changed after the report template
document had been generated. You can import the updated report definition using
the procedure described in Updating the data source for a report template on page 179.

Fields missing from a modified report
If fields are missing from the report template document for a modified report, you
must update the data source for the report template document. Do this using the
procedure described in Updating the data source for a report template on page 179.

Company image does not display
If the company image for a report does not display in the generated Microsoft Word
document, check the following:

• Be sure that an image has been assigned for the company. You may also want to
run another report for the company to verify that the image is displayed.

• Be sure that the Picture Content Control has been properly defined. If the
properties for that control are not set to the proper values, the template
processing engine will not be able to find the control.

Template processing issues
The following issues can occur when report template documents are processed to
generate output in Microsoft Word format.

Incorrect template document is used
If an incorrect report template document is used, verify the assignment of the
template document.

If a default report template document is assigned for a company, but a different
template document is being used when you generate the report, be sure that the
specific user generating the report does not have a specific template document
assigned for the report. The specific assignment for a user will override the
assignment for the company.

Template processing does not complete
If you run a report, choose to generate the output in Microsoft Word format, but the
processing never completes, try the following:

• Be sure that the SQL Server Browser service is running on the machine. This
service is necessary for template processing to complete successfully.

• The Template Processing Engine may have encountered an error and be in an
unknown condition. Restart Microsoft Dynamics GP so the Template Processing
Engine is re-initialized.

• Remove any non-typical controls that may have been added to the template
layout. For example, templates cannot be processed if they contain the “Rich
Text Control” that can be added from the Developer ribbon.
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• If a specific report is causing problems, try simplifying the report template
document to isolate the problem. For example, if a modified report will not
generate the output in Microsoft Word format, try running the original version
of the report. If the original report can generate the output in Microsoft Word
format, the issue can be isolated to changes you made in the modified report
template document.

• Add the following settings to the Dex.ini file:

KeepTemplateFiles=TRUE

TPELogging=TRUE

When you add these settings, a log file that has a name beginning with
TemplateProcessing, as well as the intermediate template documents are stored
in the current user’s temporary folder. To access the temporary folder, type the
following in the Run command:

explorer %temp%

Sort the contents of the temporary folder by the modified date. Examine to files
related to the report that won’t process. They will contain information that can
be helpful when troubleshooting.

Template reports cannot be sent through email
Several of the reports for the Sales series and Purchasing series have predefined
templates, and the generated report output from these templates can be emailed. In
some cases, you can set up the report output to be emailed, but no email messages
are sent. No error messages are displayed.

Typically, this problem occurs because the report processing code is expecting a
specific configuration for the “break” field in the header and/or footer for the
report. If the definition of the report section has been edited to specify a different
table for the “break” field, then an error will occur during processing and the report
cannot be emailed. You must edit the specific header and footer options for the
report to be sure the Report Table and Field are set to their original values.

For specific headers and
footers, the Report Table and

Field must be set to their
original values, or the reports

cannot be emailed.
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The following table lists the reports from the Sales series that can be emailed. For
each report, the header and footer are listed with the corresponding value for the
Report Table and Field. These are the settings that must be used so that the report
template output can be emailed.

Report Header/Footer Report Table Field

MC Statement Blank Form Header: Run Number RM Statements Header Temp Run Number

Footer: Run Number RM Statements Header Temp Run Number

RM Blank Document Header: None

Footer: RM Document Type-All RM Open Temp File RM Document Type-All

RM Statement on Blank Paper Header: None

Footer: Run Number RM Statements Header Temp Run Number

SOP Blank Back Order Form Header: Dymmy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank History Invoice Form Header: Dummy1 Sales Transaction Amounts History SOP Number

Footer: Back Order Sales Transaction Amounts History SOP Number

SOP Blank History Options Invoice 
Form

Header: Dummy1 Sales Transaction History SOP Number

Footer: Invoice Sales Transaction History SOP Number

SOP Blank History Options Order 
Form

Header: Dummy1 Sales Transaction History SOP Number

Footer: Invoice Sales Transaction History SOP Number

SOP Blank History Options Quote 
Form

Header: Dummy1 Sales Transaction History SOP Number

Footer: Invoice Sales Transaction History SOP Number

SOP Blank History Order Form Header: Dummy1 Sales Transaction Amounts History SOP Number

Footer: Back Order Sales Transaction Amounts History SOP Number

SOP Blank History Quote Form Header: Dummy1 Sales Transaction Amounts History SOP Number

Footer: Back Order Sales Transaction Amounts History SOP Number

SOP Blank Invoice Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank Options Invoice Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank Options Order Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank Options Quote Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank Order Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number

SOP Blank Packing Slip Form Header: Doc Print Seq Sales Document Header Temp Document Print Sequence

Footer: Doc Print Seq Sales Document Header Temp Document Print Sequence

SOP Blank Quote Form Header: Dummy1 Sales Transaction Work SOP Number

Footer: Back Order Sales Transaction Work SOP Number
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The following table lists the reports from the Purchasing series that can be emailed.
For each report, the header and footer are listed with the corresponding value for
the Report Table and Field. These are the settings that must be used so that the
report template output can be emailed.

Report Header/Footer Report Table Field

Check Remittance Header: Remittance Header PM Remittance Temp Document Number

Footer: Remittance_Footer PM Remittance Temp Document Number

PM Blank Document Header: None

Footer: Document Number Purchasing Transaction Temp Document Number

POP History Purchase Order Blank 
Form

Header: PO Header Print Documents List PO Number

Footer: PO Footer Print Documents List PO Number

POP History Purchase Order Rollup 
Blank Form

Header: PO Header Print Documents List PO Number

Footer: PO Number Print Documents List PO Number

POP Purchase Order Blank Form Header: PO Header Print Documents List PO Number

Footer: PO Footer Print Documents List PO Number

POP Purchase Order Rollup Blank 
Form

Header: PO Header Print Documents List PO Number

Footer PO Number Print Documents List PO Number
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Appendix
This manual has the following appendix:

• Appendix A, “User-defined Functions,” lists common user-defined functions
available for use in calculated fields.
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Appendix A: User-defined Functions
This appendix describes the common user-defined functions that are available for
use in calculated fields. The following functions are described:

• RW_Address
• RW_CityStateZip
• RW_GetAccountNumber

A document with descriptions of the user-defined functions available for the Report Writer
is found in the Microsoft Dynamics GP SDK in the “Procedures and functions” category.
You can find the document by searching for “Report Writer”.

RW_Address
Most addresses in Microsoft Dynamics GP allow up to three address lines. In some
cases, you may want to suppress the address lines that are empty, and have the
remaining lines of the address move up to occupy the unused space. In earlier
versions of the Report Writer, you needed several calculated fields to accomplish
this. The RW_Address user-defined function provides this functionality with only
four calculated fields, one for each line of the address. The function takes the
following parameters:

in integer Line_Number
in string Line1
in string Line2
in string Line3
in string City
in string State
in string PostalCode

The Line_Number parameter indicates which line of the address the calculated field
will be producing. The value ranges from 1 to 4. The remaining lines are string
values that are used to pass address information into the function.

For example, the address information in the RM_Customer_MSTR table consists of
the Address 1, Address 2, Address 3, City, State, and Zip fields. The following
calculated field displays the first line of the address. Notice that the first parameter
passed to the RW_Address function is the integer value 1, indicating this is the first
line of the address. The remaining parameters pass in address information from the
RM_Customer_MSTR table.

FUNCTION_SCRIPT(RW_Address 1 RM_Customer_MSTR.Address 1 
RM_Customer_MSTR.Address 2 RM_Customer_MSTR.Address 3 RM_Customer_MSTR.City 
RM_Customer_MSTR.State RM_Customer_MSTR.Zip ) 

The following calculated field is used to display the second line of the address.
Notice that the first parameter is the integer value 2, indicating this is the second
line of the address. All of the other parameters remain the same.

FUNCTION_SCRIPT(RW_Address 2 RM_Customer_MSTR.Address 1 
RM_Customer_MSTR.Address 2 RM_Customer_MSTR.Address 3 RM_Customer_MSTR.City 
RM_Customer_MSTR.State RM_Customer_MSTR.Zip ) 
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The third and fourth calculated fields are similar. The only difference is the first
parameter is either the integer value 3 or 4, indicating the third or fourth line of the
address. When all of the calculated fields are complete, add them to the report
layout in place of the standard address fields.

RW_CityStateZip
The RW_CityStateZip user-defined function strips the space from between the City,
State, and Zip Code fields of an address. It takes the following parameters:

in string City
in string State
in string ZipCode

The following calculated field uses the function to remove the extra spaces from the
City, State, and Zip fields retrieved from the RM_Customer_MSTR table:

FUNCTION_SCRIPT(RW_CityStateZip RM_Customer_MSTR.City RM_Customer_MSTR.State 
RM_Customer_MSTR.Zip )

RW_GetAccountNumber
The RW_GetAccountNumber user-defined function retrieves an account number
based on the account index. This allows you to retrieve an account number without
having to link the Account Master table to your report. The function takes the
following parameter:

in string AccountIndex

The following example shows an account number being retrieved, based on the
Account Index field from the Year-To-Date Transaction Open table.

FUNCTION_SCRIPT(RW_AccountNumber GL_YTD_TRX_OPEN.Account Index )

Use the calculated fields
in place of the standard

address fields.
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Glossary
Additional headers and footers

Report sections that are printed when a
specified field changes. Additional headers
and footers are created using the Report
Options and Header/Footer Options
windows.

Alphanumeric
A combination of numbers and letters.

Array field
A field containing multiple occurrences of
the same type of information. The individual
pieces of information stored by an array field
are called elements. For example, a seven-
element array field could be used to store
daily sales totals instead of seven individual
fields.

Array index
The number designating a specific element
within an array field. Each component field
within an array field has an array index.

Boolean expression
An expression that results in a value of true
or false.

“Break on” field
A field on a report, that when the value
changes, causes an additional header or
additional footer to be printed.

Calculated field
A field containing an expression that
combines fields in a report’s table, report
fields, constants, functions, and operators.
The result of the calculation is displayed in
the field if the field is placed on the report.
Calculated fields are created in the
Calculated Field Definition window.

Check box
A control type used to define data types that
allow users to mark or unmark an option.
Check boxes have boolean storage types.

Combo box
A control type used to define data types that
allow users to enter a text value or choose
that value from a list. The items in the list are
determined by the static text values in the
data type definition.

Component
One field of a composite field.

Composite
A group of fields and their associated data
types that form a single data type.
Composite data types are defined by the
composite control type and the fields that
make up the composite.

Concatenate
To connect two strings to form a single
string.

Conditional expression
A boolean expression used to print the
corresponding true or false case in a
calculated field. Conditional expressions are
written in the Calculated Field Definition
window.

Control type
The main characteristic of a data type,
controlling the type of information that can
be stored in fields that use that data type,
and some aspects of how the information
will be displayed.

Custom report
A new report that you make. You can start
with a blank report, or you can start by
making a copy of a report that already exists.

Defaults file
A file that stores information specific to the
current workstation. This file is named
DEX.INI for Windows.

Definition window
A window that allows you to create a
resource and specify its functional
characteristics.

DEX.INI file
A file that stores information specific to the
current workstation. Also referred to as the
defaults file.

Dictionary
A group of resources that, when interpreted
by the runtime engine, present a complete
functioning application. See also Reports
dictionary.

Drop-down list
A control type used to define data types that
allow users to select one item from a list. The
integer value corresponding to the position
of the item chosen, not the item’s static text
value, is stored when the user’s selection is
saved.

Exchange Web Services
An API that allows connecting to an
Exchange server to send e-mail. If you have
configured the Microsoft Dynamics GP
connection to Exchange Web Services, you
can mail reports to other users.

Expression
A sequence of operands and operators that
are evaluated to return a value.

Field
A field contains a single piece of information
used by the application dictionary.

Footer
A report section that is printed at the bottom
of a report, page, or group. Reports can
include report footers, page footers and
additional footers.

Format
The extra characters, spacing, and attributes
that can be applied to a data type when data
is displayed.

Format field
An integer field that specifies the format to
use for a string or currency field.

Format string
A data “mask” used for string and
composite formats. The format string allows
extra characters to appear in a field without
affecting the way data in the field is stored.

Global variable
A variable available to any report or
calculated field in the application at any
time.

Graphics report
A report on which graphics, colors (if the
printer has color capabilities), patterns, and
fonts other than the default font can be
printed.

Header
A report section that is printed at the top of a
report, page, or group. Reports can include
report headers, page headers, and additional
headers.

HTML
HyperText Markup Language. Reports
created with the Report Writer can be
exported to HTML files.

Key
A field or combination of fields within a
record that is used as a basis by which to
store, retrieve, and sort records. 

Key segment
One field of a group of fields that compose a
key.

Keyable length
The number of characters that can be
displayed by a field.

Launch file
A file that is used to start an application with
the runtime engine. This file stores the
location of the dictionaries that will be used,
including the application dictionary and the
reports dictionary.

Layout window
A window that allows you to design the
layout of a report.

List box
A control type used to define data types that
allow users to select one static text value
from a list.

MAPI
An acronym for Mail Application Program
Interface. If you have a MAPI-compliant
mail system, you can mail reports to other
users.
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Modified reports
A copy of an original report that you have
made changes to. Modified reports are
stored in the Reports dictionary. A modified
report can be substituted for an original
report in the accounting system.

Multi-select list box
A control type used to define fields from
which one or more static text values can be
selected.

Numeric expression
An expression that results in a numeric
value.

One-to-many
A type of relationship between two tables.
For every record in the first table, there are
many records in the second table that are
related to it. For example, an invoice header
table contains a list of invoices, while an
invoice line item table contains a list of the
items on each invoice. For one invoice in the
first table, there are many line items in the
second table, so there’s a one-to-many
relationship between the tables. The
relationship between two tables is viewed or
defined in the Table Relationship Definition
window.

One-to-one
A type of relationship between two tables.
For every record in the first table, there is
only one corresponding record that is related
to it in the second table. The relation between
two tables is viewed or defined in the Table
Relationship Definition window.

Operand
An item in an expression that is acted on by
an operator.

Operator
A symbol that indicates the action to
perform on the operands in an expression.

Order of precedence
The order in which the operations are carried
out for an expression. The traditional order
of precedence for numeric expressions is:
first unary minus, then exponentiation,
followed by multiplication, division, and
modulus, then addition and subtraction, and
finally shift, equality, and logical operations.
This is also referred to as the order of
evaluation.

Original report
A report that was provided with the
accounting system. You can make modified
versions of original reports.

Overflow
The condition that occurs in a numeric
expression when an intermediate or final
result of the expression is too large to be
stored by the type of data used in the
expression.

Package files
Special text files that are used to deliver
customizations made with the Modifier,
VBA, and the Report Writer.

Picture library
A feature in the Report Writer that allows
you to store graphics in a generic format that
can be used on any supported platforms.

Pixel
The smallest graphical element displayed on
a monitor. The pixel is the smallest unit of
measurement in layout windows. You can
move objects one pixel at a time within a
layout window by using the arrow keys on
the keyboard.

Point size
The vertical size of a font. There are 72 points
to an inch.

Precedence
The order in which operations are performed
for a type of expression. See also Order of
precedence.

Radio button
A control type used to define data types that
allow a single selection to be made from a
group of two or more selections. Radio
buttons must be used with a radio group.

Radio group
A control type that’s used to group related
radio buttons and store the value of the
selected button. A radio group’s value is
stored as an integer corresponding to the
selected radio button’s position in the tab
sequence, beginning with 0. For instance, if
the second radio button in the tab sequence
is selected, the radio group’s value is 1.

Record
A collection of data made up of one instance
of each field in a table.

Relationship
See Table relationship.

Report field
In the Calculated Field Definition window, a
report field is a field with a modified display
type. Report fields can be used in conditional
and calculated expressions in calculated
fields.

Report template document
A Microsoft Word document that defines the
layout and formatting for a report that can
generated in Microsoft Word format.

Reports dictionary
The dictionary that stores modified reports
from the main dictionary and new reports
created with the Report Writer. The reports
dictionary is created when the Report Writer
is accessed for the first time. All reports you
modify or create with the Report Writer are
stored in the reports dictionary.

Reports Library
A special web site that contains reports have
already had common modifications made to
them.

Resource
An object such as a field, string, native
picture, table, window, or script that can be
used to create applications in Dexterity.

Resource definition window 
See Definition window.

Resource descriptions tool
A tool that displays information about the
current dictionary’s fields, windows, and
tables.

Resource list window
A window in the Report Writer that allows
you to view all the resources of a particular
type, such as fields.

Runtime engine
An application that’s used to interpret a
dictionary. When a user starts an application,
the runtime engine uses the resources in the
dictionary to present a functioning
application.

Series
A predefined category to which report and
table resources are assigned. Series allow
categorization of resources.

Static text value
Text that’s displayed as part of a data type,
such as the items in a list box.

Storage type
One of the standard forms used to store the
data in a field. The storage types are:
boolean, integer, long, currency, variable
currency, string, text, date, and time. The
control type determines which storage type
is used to store the data in the field.

String
A sequence of up to 255 ASCII characters.
See also String resources.

String expression
An expression that results in a string value.

String resources
Sequences of up to 79 characters used
throughout an application dictionary for
window names, field prompts, static text
values, and report text.

Table
A collection of related data formatted in
rows. Each row represents a separate record,
and each column represents a separate field.
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Table relationship
A link between tables that have fields in
common. These relationships allow the
Report Writer to select fields from all of the
related tables and use them on a single
report. Table relationships are set up using
the Table Relationship Definition window.

Template-enabled report
A report that can have Microsoft Word
report template documents associated with
it, and generate the report output in
Microsoft Word format.

Text report
A report that can display only characters in a
native printer font.

Toolbox
A window that opens in conjunction with
the Report Layout window. It contains tools
used to place and arrange items in the layout
area.

Virtual table
A special type of table that allows data
stored in separate tables to be read as if it
had been stored in a single table.

Visual Basic for Applications (VBA)
A development system created by Microsoft
that can be embedded into applications.
VBA is embedded into the Report Writer,
providing additional customization
capabilities.

WYSIWYG
An acronym meaning “what you see is what
you get.” This applies to intuitive design
tools used to create reports in the Report
Writer.



198 U S E R ’ S G U I D E



U S E R ’ S G U I D E 199

Index
A
About, menu item 10
Accessing Reports, chapter 141-145
account numbers, retrieving for reports 

194
add-in

for editing report templates 159
updating for Microsoft Dynamics GP 

version 185
adding fields

to a report layout 23
to a report template document 164

addition operator, use in calculated fields 
45

additional footers
beginning a new report after 57
creating 56-58
defined 195
described 55
illustration 55
in report template documents 163
position in report layout 56
printing after given number of 

records in body 57
relationship with additional headers 

55
selecting field based upon 57
starting a new page after 57
suppressing 57
use in reports 22

additional headers
creating 56-58
defined 195
described 55
illustration 55
in report template documents 163
position in report layout 56
relationship with additional footers 

55
selecting field based upon 57
suppressing 57
use in reports 22

Additional Headers and Footers, chapter 
55-58

addresses, suppressing empty lines 193
ADMIN_SYSTEM_008 task 141
Adobe Acrobat documents, see PDF
align to bottom tool, using in report layout 

24
align to left tool, using in report layout 24
align to right tool, using in report layout 

24
align to top tool, using in report layout 24
aligning, fields in reports 24
Alignment

drawn object property 28
field property 28

alignment, for preprinted reports 125

alphanumeric, defined 195
alternate reports

described 145
modifying 145

Alternate/Modified Forms and Reports 
window 84, 142

arrange tools, described 24
arranging items, in report layout 24-25
array fields

adding to a report layout 25
defined 195

array indexes
defined 195
setting for report fields 25

ArrayIndex, field property 27
arrow tool, using in report layout 23
AVERAGE, report restriction function 36
Average, report display type 64

B
BackColor

drawn object property 28
field property 28

Basics, part 6-12
Body table

example 163
in report template document 162
layout of 163

bookmarks
list of 166
used for report template documents 

166
boolean, use in reports 29
boolean expressions, defined 195
break on field, defined 195

C
Calculated Field Definition window 43
calculated fields

adding fields to the expression 46
calculated expressions 43
chapter 43-53
concatenating in 45
conditional expressions 43
creating, procedure 44
defined 195
described 43
nesting system-defined functions 48
operators used in 44-46
result type restrictions 43
using constants in 47
using global variables in 47
using legends in 46
using other calculated fields in 46
using report fields in 46
using system-defined functions in 48
using user-defined functions 48, 52

Cancel button, how used in Report Writer 
12

captions, adding to report template 
documents 164

CAT operator, use in calculated fields 45
characters per inch, for report text 31
charts

composite format options 96
currency format options 96
drawn object properties 28
field properties 27-28
formats for currency fields 63
numeric format options 96
report sections 22
report template item placement 164
standard buttons in the Report Writer 

12
static text values 94
string format options 96

check boxes
defined 195
use in reports 29

checks
modifying 132
overview 131
printing 131
types of 131

Checks, Invoices and Labels, chapter 
131-133

circle tool, using in report layout 24
Clear, menu item 10
Clustered, key option 106
clustered keys 106
colorizing report sections 22
colors

custom colors for reports 31
for report items 31

column pattern, for report document 
templates 169

columns, adding to mailing labels 133
combo boxes

defined 195
use in reports 29

comma-delimited files, saving reports to 
117

Common Modifications, chapter 87-89
company image

in Word Template reports 167
not displaying in Word output 186

components, defined 195
composite formats

example 97
format options 96

composites
defined 195
formatting 97

concatenating
defined 195
in reports 45

conditional expression, defined 195
configurations, for Report Writer 138
constants, using in calculated fields 47
Contents, menu item 10
Control Count

described 129
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Control Count (continued)
report display type 64

control types
defined 195
static values for 94

conventions, in documentation 3
Copy, menu item 10
core resources, described 137
Count, report display type 64
counting

group items 129
groups 129

Create Index, key option 106
Creating Report Templates, chapter 

171-173
Creating Reports, part 14-66
creep, described 124
CUR_STR, calculated field function 48
currency formats

format options 96
using format fields 63

currency values, suppressing decimals 17
current report, modifying 82
custom colors, for report items 31
custom reports

accessing 143
defined 195
described 7
printing 112

Custom XML Mapping pane
displaying in Microsoft Word 164
items missing 186
selecting XML resource 164

Customization Maintenance window 147
customizations, see modified reports
Cut, menu item 10

D
Data, report display type 64
data source in report template document, 

updating 179
Data Storage, chapter 69-72
data storage, terminology 69
Data Type Definition window 93
data types

chapter 93-94
characteristics 93
described 93
format 94
keyable length 93
opening 93
opening from global fields 99
static values 94

database types, for tables 105
date tool, using in report layout 23
dates, use in reports 29
DAY calculated field function 48
DAY_NAME, calculated field function 48
defaults file, defined 195
definition windows

defined 195

definition windows (continued)
described 11

Delete button, how used in Report Writer 
12

deleting modified reports 145
Descending, key segment option 107
designing reports 121
DEX.INI

defined 195
ExportOneLineBody 117

dictionaries, defined 195
display names

described 71
for tables 105

display types
for reports 64
use in report sections 66

DisplayName, report property 27
DisplayType, field property 27
distributing reports 147
divider tool, using in report layout 23
division operator, use in calculated fields 

45
documentation, symbols and conventions 

3
DOW, calculated field function 49
Drawing Options window 30
drawn objects, properties, list 28
drop-down lists

defined 195
use in reports 29

duplicate records, associated key option 
106

Duplicates, key option 106

E
Edit Launch File window 138
Edit menu, described 10
elements of arrays, specifying 25
emailing template reports, unsuccessful 

187
EndTemplateDocumentFooterBookmark, 

described 166
equality operator, use in calculated fields 

45
Exchange Web Services

defined 195
mailing reports 115

EXISTS, report restriction function 37
Exit, menu item 10
Exporting Data, chapter 117-118
exporting data with reports 117
exporting package files 147
ExportOneLineBody, DEX.INI setting 117
expressions, defined 195

F
Field, field property 27
Field Definition window 99
Field Descriptions, menu item 10
field properties, list 27-28

FieldID, field property 27
fields

adding to report template documents 
164

adding to reports 23, 25, 88
adding to the calculated field 

expression 46
chapter 99
characteristics on reports 29
defined 195
described 69, 99
formatting 62
hiding on report layout 61
in graphics reports, applying 

drawing options 30
object properties 27
opening 99
opening data type 99
properties, list 27
removing from report template 

documents 165
removing from reports 88

FieldType, field property 27
files, sending reports to 117
FIRST, report restriction function 37
First Item In Group, report display type 65
First Occurrence Only, report display type 

65
Font

drawn object property 28
field property 28

FontBold
drawn object property 28
field property 28

FontColor
drawn object property 28
field property 28

FontItalic
drawn object property 28
field property 28

fonts
design issues 122
for graphics reports 31
for text reports 31
generic fonts for reports 31
specifying color for reports 31
specifying size for reports 31
substituting in reports 31

FontSize
drawn object property 28
field property 28

FontUnderline
drawn object property 28
field property 28

Footer Options window 56
footers

see also  additional footers
defined 195
for groups 128

FORALL, report restriction function 38
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form pattern, for report document 
templates 168

Format, field property 27
Format Definition window 95
format fields

defined 195
described 62
example 64
use 64

format strings
composite formats 97
defined 195
described 96
example 97
string formats 96
using to add static elements 96

FormatField, field property 27
FormatFieldSrc, field property 27
formats

aligning field information 95
applying to report fields 62
chapter 95-97
composite formats 96, 97
currency, format options 96
defined 195
described 95
format strings 96
naming 95
numeric, format options 96
opening 95
options 95
string formats 96

FREQUENCY, report restriction function 
38

functions, see restriction functions, 
system-defined functions, user-defined 
functions

G
Gathering Data, part 68-78
Generate Resource Reports, menu item 9
generic fonts, for reports 31
Getting Started with the Report Writer, 

chapter 7-8
global fields

chapter 99
opening 99
opening data type 99

Global Modifications, part 92-107
global variables

defined 195
using in calculated fields 47

graphics
design issues 122
in Word Template reports 167

graphics reports
aligning text items 31
applying drawing options 30
defined 195
tools specific to, described 23

greater than operator, use in calculated 
fields 45

greater than or equal to operator, use in 
calculated fields 45

groups
advanced groups 130
chapter 127-130
counting 129
counting items in 129
creating in reports using headers and 

footers 55
described 55, 127
footers 128
headers 128
sorting information for 127

H
Header Options window 56
headers

see also  additional headers
defined 195
for groups 128

Help menu, described 10
history tables, described 71
horizontal alignment, for preprinted 

reports 125
HTML

defined 195
saving reports to 117

I
Ignore Case, key segment option 107
images, in Word Template reports 167
Import Package File window 148
Import Reports window 151
importing

package files 148
reports from other dictionaries 151
validating results 152

Importing Reports, chapter 151-152
indexes, for tables 106
inequality operator, use in calculated 

fields 45
Insert button, how used in Report Writer 

12
INT_STR, calculated field function 49
invoices

overview 132
printing 132

K
key segments

defined 195
described 106
options 107

keyable length
defined 195
described 93

keys
creating indexes for 106
defined 195
described 70, 105

keys (continued)
example 106
key segments, described 106
multisegment keys, described 106
options 106

L
labels

adding columns 133
overview 132
printing 132

landscape pages, for reports 17
LAST, report restriction function 38
Last Occurrence, report display type 65
launch files

defined 195
described 137

layout
design issues 121
for preprinted forms 123
issues for report template documents 

185
modifying for reports 87

Layout menu, Colorize Report Sections 22
layout windows

defined 195
described 12
for reports 21

legends
adding to report template documents 

164
chapter 59-60
example 60
setting with VBA 59
using in calculated fields 46

less than operator, use in calculated fields 
46

less than or equal to operator, use in 
calculated fields 45

LFT_STR, calculated field function 49
light bulb symbol 3
line tool, using in report layout 24
LineColor, drawn object property 28
LineSize, drawn object property 28
list boxes

defined 195
use in reports 29

LNG_STR, calculated field function 49
logging, in Template Processing Engine 

187
logical AND operator, use in calculated 

fields 45
logical NOT operator, use in calculated 

fields 46
logical OR operator, use in calculated 

fields 45
logos

guidelines 102
in report template documents 167
sample 102

Lookup, menu item 10
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lookup buttons, described 12

M
Macro menu, described 10
mailing labels 132
mailing reports

chapter 115-116
procedure 115

mailing template reports, unsuccessful 
187

MainTable, report property 27
MainTableKey, report property 27
MainTableName, report property 27
MAPI

defined 195
mailing reports 115
using with reports 115

margin notes 3
master tables, described 71
matching patterns in report restrictions 40
MAXIMUM, report restriction function 39
Maximum, report display type 65
maximum records for a report 16
MaxRecords, report property 27
menus in Report Writer

Edit menu 10
File menu 9
Help menu 10
Macro menu 10
Resources menu 10
Windows menu 10

metafiles, as pictures 101
Microsoft Dynamics GP Add-in for 

Microsoft Word
accessing 159
described 159
installing 159

Microsoft Dynamics GP Report Writer, see 
Report Writer

Microsoft Word
add-in for editing report templates 

159
advanced options 160
bookmarks used 166
Design Mode 167
Developer tab 159
display options 160
settings for editing report template 

documents 160
setup for editing report templates 159

MINIMUM, report restriction function 40
Minimum, report display type 65
modified reports

accessing 142
creating 81
defined 196
described 7
distributing 147
fields missing in Word template 186
from Reports Library 89
printing 111

modified reports (continued)
removing 145
report template documents for 176
setting security access 84
storing 8
third-party reports 144
viewing 83, 142
Word Templates for 175

Modifying Fields, chapter 61-66
Modifying Reports, part 80-89
MONTH, calculated field function 49
MONTH_NAME, calculated field 

function 49
mouse symbol 3
multiplication operator, use in calculated 

fields 45
multisegment keys 106
multi-select list box

defined 196
use in reports 29

N
Name, report property 27
names

finding for reports 81
formats 95
tables 105

New button, how used in Report Writer 12
New Template window 172, 176
numeric expressions, defined 196
numeric formats, format options 96

O
object properties, for fields 27
offsets, for preprinted reports 125
OK button, how used in Report Writer 12
one-to-many relationship

defined 196
described 73

one-to-one relationship
defined 196
described 73

Open button, how used in Report Writer 
12

open tables, described 71
operands, defined 196
operators

defined 196
parentheses, use in calculated fields 

44
used in calculated fields 44-46

optimizing reports 122
options, for reports 17
order of precedence, defined 196
Orientation, report property 27
orientation, for report pages 17
original reports

defined 196
described 7

overflow, defined 196

Overview of Word Templates, chapter 
155-157

overwriting customizations with package 
files 149

P
package files

contents 147
defined 196
described 147
exporting 147
import/export issues 149
importing 148
overwriting customizations 149

Packaging Reports, chapter 147-149
page creep, described 124
Page Footer table

in report template document 162
layout of 162

page footers, use in reports 22
Page Header table

example 162
in report template document 161
layout of 162

page headers, use in reports 22
page number tool, using in report layout 

23
page orientation 17, changing for reports 

87
page size, for preprinted forms 123
parentheses, use in calculated fields 44
Paste, menu item 10
Pattern

drawn object property 28
field property 28

PatternColor
drawn object property 28
field property 28

patterns, for layout of report template 
documents 168

PDF
mailing reports as 115
saving reports to 117

physical names
described 71
for tables 105

Picture Definition window 101
picture library

adding pictures to 24, 101
defined 196
using pictures from 101-102

picture tool, using in report layout 24
pictures (resource)

adding to picture library 24, 101
adding to reports 24, 101
chapter 101-102
described 101
logos on reports 102

pixel, defined 196
point size, defined 196
portable documents, see PDF
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portrait pages, for reports 17
positioning, fields in reports 23
Position-Left

drawn object property 28
field property 28

Position-Top
drawn object property 28
field property 28

POWER_10, calculated field function 49
precedence, defined 196
preprinted forms

chapter 123-125
creep 124
described 123
for reports 18
page size 123
printing 124
report definition 123
report layout 123

Previous Occurrence, report display type 
65

Print Report Definition window 19
Print Setup, menu item 9
printing

chapter 111-113
custom reports 112
modified reports 111
overview 111
preprinted reports 124
reports with temporary tables 113

Printing and Mailing Reports, part 
110-118

procedures
Adding a company image to a report 

template document 167
Adding a picture to the picture 

library 101
Adding an item to a report template 

document 164-165
Creating a calculated field 44
Creating a modified report 81
Creating a modified report template 

document 176-178
Creating a new report template 

document 171-173
Creating additional footers 56-58
Creating additional headers 56-58
Defining a new report 15-19
Defining a table relationship 74-76
Defining report restrictions 35-36
Exporting a package file 147-148
Importing a package file 148-149
Importing from a reports dictionary 

151
Mailing a report 115-116
Modifying a string 103
Printing custom reports 112-113
Printing modified reports 111-112
Removing an item from a report 

template document 165
Starting the Report Writer 8

procedures (continued)
Updating the data source for a report 

template 179-180
Using a modified report template 

document 178
Using a picture from the picture 

library 101-102
Using legends 59
Validating reports 152
Viewing from the Report Writer 83
Viewing virtual table information 77

Process Monitor, menu item 9
processing issues, for report template 

documents 186
product support, for Report Writer 3
products, selecting product to modify 8
properties

for drawn objects 28
for fields 27
setting 26

Properties window, using 26

R
radio buttons, defined 196
radio groups

defined 196
use in reports 29

read-only, report template documents 169
records

defined 196
described 69
maximum number for a report 16
skipping blank records 17

rectangle tool, using in report layout 24
Remove button, how used in Report 

Writer 12
removing modified reports 145
report definition

chapter 15-19
creating 15
described 15
for Word Template reports 155
printing 19

Report Definition window 15
Report Design, part 120-133
Report Design Guidelines, chapter 

121-122
Report Destination window 156, 179
report document templates

column pattern 169
form pattern 168

Report Field Options window 61
report fields

defined 196
use in calculated fields 46
use in report sections 66

Report Footer table
in report template document 162
layout of 163

report footers, use in reports 22

Report Header table
example 163
in report template document 162
layout of 163

report headers, use in reports 22
Report Layout, chapter 21-31
Report Layout window 21
Report Restriction Definition window 35
Report Table Relationships window 16
Report Template Design, chapter 161-170
report template documents

adding items 164
assigning for modified reports 178
Body table 162
bookmarks for 166
common patterns 168
company images in 167
creating 171
creating based on existing templates 

172
creating for modified reports 176
creating layout with tables 162
creating new 171
defined 196
described 156
designing 161
displaying item properties 165
for modified reports 175
how processed 157
layout issues 185
Microsoft Word settings for editing 

160
Page Footer table 162
Page Header table 161
processing issues 186
purpose 156
read-only 169
removing items 165
Report Footer table 162
Report Header table 162
source for items in the layout 164
structure 161
tables used in 161
tips for working with 167
updating data source for 179
using for modified reports 178

Report Templates for Modified Reports, 
chapter 175-180

Report Writer
accessing 141
configurations 138
controlling access 141
described 2
exiting 9
getting started 7
interface 9
local reports dictionary 138
menus 9
network reports dictionary 138
packaging a project 147
printing from 113
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Report Writer (continued)
returning to the main application 9
security task 141
selecting a product 8
starting 8
storing reports 8
tasks 7
terminology 7
toolbar 9
types of modifications 7
viewing reports 83

ReportID, report property 27
reports

adding fields 23, 25
adding pictures to 24
adding tables to 16
additional footers 22
additional headers 22
aligning fields 24
arranging items in layout area, 

described 24-25
body, described 22
changing field types 64
common modifications 87
defining, procedure 15-19
empty fields, hiding 61
exporting to a file 117
field characteristics 29
finding report names 81
footer printing options 18
for exporting data 117
format options 17
formatting fields 62
generating as Microsoft Word 

documents 155
generic fonts 31
groups 127
header printing options 18
hiding fields in layout 61
importing from other dictionaries 151
layout window

described 21
illustration 21
sections 22

legends 59-60
limiting the records included 16
mailing 115
main table for report 15
modified reports 81
modifying report layout 87
optimizing 122
packaging 147
page footers, described 22
page headers, described 22
page orientation 17
positioning items in 25
printing

on preprinted forms 18
options 18
overview 111

printing report definition 19

reports (continued)
report footers, described 22
report headers, described 22
report sections, chart 22
restrictions

defining 35-36
described 35
restriction functions 36-41

secondary tables 75
series 15
sizing items in 25
sorting

using a sorting definition 33
using main table key 33

storing 8, 137
table relationships

defining 74-76
described 73
illustration 73

template-enabled 155
text report options 17
tile tools used in layout 24
totaling and subtotaling 130
using report footers 19
validating 152
viewing modified reports 83

reports dictionary
changing location 138
changing name 138
core resources 137
default location 138
default name 138
defined 196
described 137
launch file 137
modified reports 137
storing locally 138
storing on network 138

Reports Library
defined 196
described 89

Reports on the web, see Reports Library
Reports window 155, 171, 176
Resource Descriptions tool

accessing 10
defined 196

resource list windows
defined 196
described 11

resources, defined 196
Resources menu, described 10
restriction functions, described 36
restrictions

adding to reports 35
chapter 35-41

RGT_STR, calculated field function 49
rounded rectangle tool, using in report 

layout 24
Running Sum, report display type 65
running sums for reports 130, 157
runtime engine, defined 196

RW_Address, user-defined function 193
RW_CityStateZip, user-defined function 

194
RW_GetAccountNumber, user-defined 

function 194

S
scaling graphics and logos 102
Screen Output window 82
Search for Help On, menu item 10
Section

drawn object property 28
field property 27

sections
colorizing 22
in reports 22

security
accessing custom reports 143
accessing modified reports 142
accessing the Report Writer 141
accessing third-party reports 144
setting access to customized 

resources 149
Security Role Setup window 141
Security Task Setup window 143
segment options, for key segments 107
Select All, menu item 10
Selecting a Report to Modify, chapter 

81-82
Series, report property 27
series

defined 196
for reports 15
for tables 105

Setting Up Microsoft Word, chapter 
159-160

settings box
illustration 26
using 26

setup tables, described 71
Shape, drawn object property 28
size to default tool, using in report layout 

24
size to narrowest tool, using in report 

layout 24
size to shortest tool, using in report layout 

24
size to tallest tool, using in report layout 

24
size to widest tool, using in report layout 

24
Size-Height

drawn object property 28
field property 28

Size-Width
drawn object property 28
field property 28

sorting
chapter 33-34
for groups 127
key segment options 107
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sorting (continued)
reports 33

sorting definition
creating 33
sorting options 34

Sorting Definition window 33
starting the Report Writer 8
StartTemplateDocumentHeaderBookmark

, described 166
StartTemplateSectionRepeating 

bookmark, described 166
static text values

defined 196
described 94

Static Text Values window 94
static values

adding to report template documents 
164

described 94
static text values 94

storage types, defined 196
Storing and Accessing Reports, part 

136-152
Storing Reports, chapter 137-139
STR_CUR, calculated field function 50
STR_DAT, calculated field function 49
STR_LEN, calculated field function 50
STR_LNG, calculated field function 50
STR_VCUR, calculated field function 50
String Definition window 103
string expressions, defined 196
string formats

described 96
example 96
format options 96
using format fields 63

string resources, defined 196
strings

chapter 103
defined 196
described 103
example 103
formatting 96
modifying, procedure 103
using 103

STRIP, calculated field function 50
structure, for report template documents 

161
substituting fonts for reports 31
SUBSTRING

calculated field function 50
report restriction function 40

subtotaling data for reports 130
subtraction operator, use in calculated 

fields 45
Sum, report display type 65
SUMMATION, report restriction function 

41
summing data for reports 130
support, available for Report Writer 3

suppressing
additional footers 57
additional headers 57

symbols in documentation 3
system-defined functions

CUR_STR, described 48
DAY, described 48
DAY_NAME, described 48
DOW, described 49
INT_STR, described 49
LFT_STR, described 49
LNG_STR, described 49
MONTH, described 49
MONTH_NAME, described 49
nesting in calculated field 48
POWER_10, described 49
RGT_STR, described 49
STR_CUR, described 50
STR_DAT, described 49
STR_LEN, described 50
STR_LNG, described 50
STR_VCUR, described 50
STRIP, described 50
SUBSTRING, described 50
UCASE, described 51
using in calculated fields 48
WILDCARD, described 51
YEAR, described 52

T
tab-delimited files, saving reports to 117
Table, field property 27
Table Descriptions, menu item 10
table groups

described 71, 72
example 72
purpose 72

Table Relationship Definition window 75
Table Relationship window 74
table relationships

chapter 73-76
creating, procedure 74-76
defined 197
described 73
for virtual tables 78
illustration 73
one-to-many relationship, described 

73
one-to-one relationship, described 73
overview 73
predefined 73
secondary tables 75
types 73

TableName, field property 27
tables

chapter 105-107
database types, described 105
defined 196
described 70, 105
display names 105
example 70

tables (continued)
in Microsoft Dynamics GP 71
keys

described 70, 105
key options 106

names 71, 105
physical names 105
relationships between 73
structure, illustration 70
table relationships 73
table series 105
terminology 69
types of 71

task, security task for Report Writer 141
tasks, accomplished with the Report 

Writer 7
technical name, described 71
technical support, for Report Writer 3
Template Processing Engine

described 157
logging 187
restarting 186
troubleshooting 186

template-enabled reports
defined 197
described 155

TemplateGenerator.exe, location 181
temporary tables, described 113
terminology

for data storage 69
for Report Writer 7

text, aligning 95
text attachments, mailing reports as 115
text fields, use in reports 29
text files, saving reports to 117
text reports

defined 197
line spacing 18
options 17
text size 18, 31

text tool, using in report layout 23
The Report Writer Interface, chapter 9-12
third-party reports

accessing 144
using Word Template Generator 184

tile horizontally tool, using in report 
layout 25

tile vertically tool, using in report layout 
25

time tool, using in report layout 23
time values, use in reports 30
toolbar, described 9
Toolbox

defined 197
for reports 23
illustration 23

totaling data for reports 130
Troubleshooting Templates, chapter 

185-189
Type, report property 27
types of modifications 7
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U
UCASE, calculated field function 51
Undo, menu item 10
Unique, key option 106
user-defined functions

common functions 193
using for reports 52
using in calculated fields 48, 52

V
validating reports 152
VBA

defined 197
setting report legends 59
using to modify reports 88

vertical alignment, for preprinted reports 
125

Viewing a Modified Report, chapter 83-85
virtual tables

chapter 77-78
defined 197
described 77
elements 77
linking to 78
overview 77
using in reports 78
viewing information 77

Visibility, field property 28
visual switches, use in reports 30

W
warning symbol 3
WILDCARD

calculated field function 51
report restriction function 41

window controls
lookup button 12
standard buttons in Report Writer 12

Window Descriptions, menu item 10
Window Help, menu item 10
windows in Microsoft Dynamics GP

Alternate/Modified Forms and 
Reports 84, 142

Edit Launch File 138
New Template 172, 176
Report Destination 156, 179
Reports 155, 171, 176
Security Role Setup 141
Security Task Setup 143

windows in Report Writer
Calculated Field Definition 43
Data Type Definition 93
Drawing Options 30
Field Definition 99
Format Definition 95
Import Reports 151
Picture Definition 101
Print Report Definition 19
Properties 26
Report Definition 15
Report Field Options 61

windows in Report Writer (continued)
Report Restriction Definition 35
Report Table Relationships 16
Screen Output 82
Sorting Definition 33
Static Text Values 94
String Definition 103
Table Relationship 74
Table Relationship Definition 75

Windows menu, described 10
Word Template Generator

accessing 181
chapter 181-184
expectations 184
overview 181
using 181

Word Templates
add-in for Microsoft Word 159
adding items to a report template 164
capabilities of 157
common patterns for reports 168
how processed 156
layout using tables 162
limitations of 157
overview 155
part 154-189
read-only documents 169
report definition usage 155
report template document 156
setting up Microsoft Word 159
template design 161
Template Processing Engine 157
template-enabled reports 155
troubleshooting 185
using company image 167
Word Template Generator 181

work tables, described 71
WYSIWYG, defined 197

X
XML output, using for Word Template 

Generator 182

Y
YEAR calculated field function 52
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